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“Hair can have almost any shape, so 

when it comes to painting it, think of it as 

an ace up your sleeve.”

paco rico torres | page 27

  



If you’re new to digital art or just want a resource 

close to hand when you’re in need of some advice, 

then The Digital Artist’s Survival Guide will 

become your new best friend. It’s packed with 

informed and unique advice, and our team of 

artists from video games, comics, the film industry 

and book publishing have an answer for 

everything, almost. Want to learn how to paint 

feathers on a dragon? Done. Want to understand 

how to use perspective? It’s all in here. 

More so, we’ve looked at some of the most popular 

software used by digital artists and compiled our 

starter guides to using the apps. Whether you’re 

using Photoshop, Painter, ArtRage or even budget 

software like PaintTool Sai, there are bite-sized 

tutorials to walk you through the software’s tools. 

Inside you’ll learn to use layers, create custom 

brushes and navigate the apps. 

In total there are 117 chunks of easy-to-follow 

tutorials that will aid you in improving your digital 

art or help you get to grips with the core skills 

needed to enjoy this art form!

Ian Dean, Editor
ian.dean@futurenet.com

The Digital 

Artist’s Survival Guide is 

a special edition of ImagineFX, 

the only magazine dedicated to 

fantasy and sci-fi art. Our aim is 

to help artists to improve both 

their traditional and digital 

art skills.

Visit www.imaginefx.com to find out more!
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files & video 

Video lessons

Learn from our artists’ video tutorials…

• control the viewer’s gaze See 

Nick Harris use ArtRage to paint a  

scene that guides the viewer.

• Paint a snowy mountain Watch  

Tony Foti compose and paint a snow 

covered mountain. 

• Paint a cthulhu creature Manon 

draws inspiration from HP Lovecraft.

Final layered art

Some of the tutorials feature the final 

layered PSD files. Open and explore 

the layers to learn new skills. 

When you see this…

Click or copy and paste the links into a 

broswer to download the files to a 

desktop PC. Use links to stream video.

resource Files

Follow our artists’ workshops using 

their own sketches, thumbnails and 

many process photos. 
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Subscribe to today and save money off every issue!

A good way to…
depict a vertigo-inducing scene

Discover an easy way to…
adopt manga-style 

elements into portrait art

The best way to…
paint shiny,  
curly hair

Discover how to… 
paint a character in 

bright light

The best way to…
paint a snowy landscape 

that has form

turn to 
page 74

Discover how to…
create an interesting depiction of Cthulhu
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Celebrate the art of Magic: The Gathering and learn to paint 
stunning game card art with professional artists.

We’re available as interactive digital editions
iPad, iPhone, iPod touch: www.bit.ly/ifx-app  Android, PC/Mac: www.zinio.com/imaginefx

Barnes & Noble NOOK: www.bit.ly/ifxnook  Kindle: Search for us in the Kindle Fire app store!
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Software guide

photoshop
Explore the tools of the leading professional app, including using grids,  

clipping masks, texture brushes and much more.

Tom Garden
Tom is a freelance artist who, for 

the most part, creates concept 

art for the video games industry. 

Developing a game project of 

his own is his long-term goal.

www.tomgarden.co.uk

Turn over To sTarT usinG PhoToshoP

| Contents |
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Accessing your files 

Click or copy and paste the  

link above into a browser to 

download the files to a 

desktop PC or Mac. 
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S
etting up your Photoshop 

document correctly is very 

important – especially if your 

work is going to be printed. 

There are a few basic rules to 

remember that are fairly standard across 

the art world regarding file formats, size, 

colour and print specifications. You need to 

know how to deliver the final artwork 

properly, and how to make sure your image 

looks great when it’s printed. Hopefully 

these tips will help you out!

Using textures can make your digital art 

look fantastic and save you time. For 

production artwork employing the right 

texture is crucial because other artists  

will need to know what material or feel 

you’re trying to get across. 

Setting up a few basic textures means you 

won’t have to search for texture photos each 

time you need to paint a piece. Here, I’ll 

show you how to set up a texture, create a 

custom brush and then use it to apply 

texture to your artwork.

top set-up tips

F
ollow these guidelines to present your 

artwork in the correct format and make 

sure it looks its best when printed…

Upscaling/downscaling
It’s always good to paint on a larger file 

size than you need, so you will be able to 

downscale the original. It’s easier to 

paint on a larger canvas to enable you to 

work on the details more easily.

print and check
If possible, print your work out before 

sending it to print. You may see errors 

that aren’t obvious on a monitor, or you 

may need to tweak the saturation or 

levels to make the image richer.

File Formats
If you are sending to print, always check 

with the printer what format they would 

textUre eFFects
I recommend that you spend some time 

having a play with the different brush 

settings for various texturing effects. 

The dual brush and texture feature can 

make some great brushes.

tiling
If you need a texture to tile, click 

Filters>Other>Offset and then you can 

use the Healing Brush tool or the Clone  

Tool to cover the seams.

resoUrces
Use your own photos, rather than a stock 

library’s, to ensure your work is your own.

sharpening
Create a clearer brush texture by sharpening 

the texture first.

clashing edges
Use a previous texture brush to mask the 

edges of a new one. This breaks up the 

edges nicely.

resoUrce lighting
When you are photographing a texture try 

to ensure that the lighting is as flat as 

possible. This will avoid giving too much 

form to the texture.

Basic textUres
Above are some of my ideas for the type of texture brushes that you might want to set up in your 

palette. Metal, organic, paint, bricks, grating and stone are all good, all-purpose textures. 

require. A typical delivery format is a TIFF, 

which is a lossless file format that delivers 

great quality. JPGs are not normally a good 

format for print as the quality is not as high.

Bleed margin
Bleed is an area around your image that 

allows for some of the image being lost in 

cropping and trimming, without destroying 

your main image. Make sure important parts 

of your image don’t run over these lines.

gUides and rUlers 
shortcUts
To hide the guides you can use the shortcut 

Cmd/Ctrl+H. For hiding the rulers use  

Cmd/Ctrl+R.

docUmenT decISIonS

GeT To GrIPS wITH TexTUre brUSHeS

“Print your work out before sending 

it to print. You may see errors that 

aren’t obvious on a monitor”

texturing tips
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1 Resolution 
You can set your PPI in 

Image>Image Size>Resolution. PPI 

means Pixels Per Inch, and this tells your 

printer how many pixels to print within 

one square inch. The higher the PPI, the 

better the quality of the images. Of the 

common resolutions, 72ppi is good for 

web images around 500-1000px. 

300ppi is a standard for print and is 

good for anything around 2000 – 

4000px. 600ppi is rarely used.

1 Capture your texture
Either photograph a real-life 

reference or go to www.cgtextures.com 

for lots of free textures. Then desaturate 

the photo by going to Image>Mode> 

Greyscale. This only works with 

greyscale images for custom brushes. 

Increase the contrast of the values in 

Image>Adjustments>Brightness/

Contrast. For a texture stamp brush 

make sure it’s high resolution – at least 

2,000 pixels wide.

2 Create the brush
To create the brush, use the 

Lasso tool to select an area in the 

texture and copy it to a new layer, on a 

white background. The brush must  

have white surrounding it, as white  

will eventually end up becoming 

transparent. Try to make the edges of 

the brush coherent with the texture. 

Click Select>All and then press 

Edit>Define Brush Preset. You now have 

a custom brush! 

3 Apply some texture 
Now we can experiment with the 

brush. Click the texture brush on a new 

layer. This stamps the texture onto your 

piece. Different layer blending modes 

will achieve various effects; Overlay 

usually gives good results. You can 

stamp it like this or, by changing the 

brush settings such as Angle and 

Opacity Jitter, you can randomise your 

brush, enabling you to paint across the 

whole canvas for unique results.

2 Rulers and Guides 
These are vital for correctly 

setting up a document for print 

measurements where cropping and 

bleed might occur. Turn on the rulers 

with View>Rulers, then click and drag 

from inside the ruler area to create a 

guide. Now, drag the guides out to  

the bleed or the crop specifications. 

Right-click inside the ruler area to 

specify the measurement format. To 

remove a guide, just drag it back.

3 RGB and CMYK 
These are the two types of 

colour formats in Photoshop. RGB  

(Red, Green, Blue) is more suitable for 

the computer or television media 

presentation of your image. CMYK 

(Cyan, Magenta, Yellow, Key Black) is the 

standard for most printers. It’s advisable 

to do a test print on a CMYK printer for 

yourself before sending the work off to 

be printed; most home photo printers 

are now CMYK.

Step-by-step: How to set up your Photoshop document for the best printed results

Step-by-step: Capture a texture and create a custom brush

Photoshop | Document settings and texture brushes
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Grids and rulers come into their own when 

you start setting out compositional guides 

or preparing a showcase of your work for a 

client. Ignore them at your peril! The rulers 

run along the left side and top of your 

composition and show you the size in 

different units of measurement. The grid is 

a square overlay, which you can specify the 

size of, and comes in handy for reference 

work and proportions.

clipping masks are masks based on the 

transparent data from layers. They’re 

commonly used for graphic design tasks, 

for example adding a picture to text or 

vectors, but they can be very effective in 

artistic work too. 

clipping masks are one of the many 

ways to mask in Photoshop, and while they 

may not be the most straightforward to use, 

they have interesting benefits. Here, I’ll 

show you one method of using clipping 

masks to create character thumbnails.

tips for 

masking

U
nderstanding how Clipping 

Masks work is key to getting 

the most from them.

precision tips

the transparent data. To check what’s 

transparent in your image, simply hide the 

lowest layer in the stack. 

alternatives

You can use Adjustment Layers as Clipping 

Masks, but these will only affect the layer 

that they’re attached to. It’s also possible to 

use Clipping Masks as an alternative to the 

Quick Mask feature.

textUres

Try using a Clipping Mask above a vector, 

which enables you to get a great effect if 

you use a texture.

Be selective

By using a Clipping Mask, you only adjust 

the layer that it corresponds to, without 

affecting the rest of the piece.

non-destrUctive

While you could use the Lock Transparent 

Pixels feature, Clipping Masks enable you to 

work non-destructively. Your Clipping Mask 

will recognise regular masks that you’ve 

used on other layers.

transparency

Clipping Masks don’t work on black  

and white data like typical masks, but on  

UnderSTand clIPPInG maSkS

on THe STraIGHT and narrow

“Grids and rulers come into their own when you prepare 

your work for a client. Ignore them at your peril!”

laUnch the line tool

Use the Line tool to draw the grid on a 

new layer. You can also use the Line  

tool on guides.

overall measUrements 

When using the Ruler tool, its 

measurement values correspond to  

the types of unit measurement that  

your rulers have.

altering preFerences

Changing the grid preferences will affect 

all of your open files, so be aware of this. 

Back to the start

Double-click the top-left area inside the 

rulers to reset the origin point back to the 

edge of your picture.

switch measUrements

To quickly change the rulers’ unit 

measurements, right-click in the ruler area 

for other options.

see yoUr rUlers

Display rulers by clicking View>Rulers. You 

can pull down guides from the ruler area 

onto your piece with View>Snap.

10

  



1 Create a Clipping Mask
Make a new layer above the one 

you want to use the Clipping Mask on. 

Now go to Layer>Create Clipping Mask. 

Your new layer will work as a mask, 

based on the transparent and solid data 

of the layer below, so it’ll only affect that 

one. You can, however, have as many 

Clipping Masks applied to the main layer 

as you wish. 

1 Apply a grid 
To view the Grid Overlay go to 

View>Show>Grid. This displays the grid 

on your painting. Here, I’m setting up 

this grid to show the document in thirds. 

I click Photoshop/Edit>Preferences> 

Grids>Guides & Slices. In the Grid 

section I go to Gridline Every and set 

this to 33.3 per cent. I can also adjust the 

Subdivisions box to add or subtract 

subdivisions from the main grid boxes.

2 Precise placement
Rulers and Guides can also be 

used effectively with a grid. If I turn on 

View>Snap my guides will automatically 

snap to the grid. Clicking View>Lock 

Guides ensures that they won’t 

accidentally move while I’m editing an 

image. I can also change the origin point 

of the rulers by clicking the top-left 

corner of the rulers area and then 

dragging the cursor in the composition.

3 Accurate measurements
I use the Ruler tool, which can be 

found in the Tools Palette, to measure 

something within the composition. I 

click and hold the Eyedropper tool icon 

which enables me to see the Ruler Tool. 

Along the top menu bar, measurements 

will then appear. On my picture, if I  

click and drag the ruler to measure 

something within the image the values 

will change accordingly.

2 Character thumbnails
I’ve created some character 

silhouettes, which need detailing. But be 

careful: painting white on your silhouette 

to ‘erase’ it will actually count as solid 

data. If you do this, the Clipping Mask 

will read the areas of white paint as solid, 

which isn’t what we’re after. We want the 

Clipping Mask to let us paint within the 

boundaries of the silhouette.

3 Texture and colour
You can add more Clipping 

Masks to the silhouette layer, which will 

enable you to apply texture and colour 

washes. You can use some blending 

modes more effectively in this way too. 

Here, I’ve painted a ‘hard light’ layer, 

which normally wouldn’t stay within the 

prescribed boundaries. But now it will 

be restricted to my silhouette.

Step-by-step: Create Clipping Masks to use as character thumbnails 

Step-by-step: Setting up a grid and using the Rulers and Guides

Photoshop | Using Clipping Masks and grids and rulers
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art direction is a key process when 

providing feedback for art assets, but it’s 

also a crucial method of explaining your 

own artwork to a client. a lot of artists  

are now working as freelancers and are 

based off-site, so clarity is vital in the 

presentation of your work – and so too is 

understanding feedback when you are not 

sitting in a studio. 

It’s good to know what tools to use, so 

here are three methods for annotating and 

adjusting your artwork.

feedback tips

ImaGe modeS and coloUr cHannelS

acTInG on arT Feedback

colour channels and image modes 

determine how colour is combined in your 

artwork. Understanding these two features 

will enable you to achieve better printing 

results and make key colour adjustments. 

The Image modes are under 

Image>mode, and changing them enables 

you to display the colour information 

differently, using channels. The colour 

channels display the colour information of 

your piece as separate layers. 

channel help

see channels in coloUr

To view channels in their respective 

colour all you need to do is go to 

Photoshop/File> Preferences> Interface 

and tick ‘Show Channels In Colour’. A 

simple skill to learn.

Blending Using channels

Double-clicking a new layer displays the 

blending options. Here you can adjust 

the blending using the channels, which is 

useful when painting and creating solid 

colour, graphic art pieces.

printing greyscale art

Printing Greyscale artwork with a full 

colour range adds more subtlety to the 

final printed piece. It’s a useful technique 

to keep in mind when painting unique 

fantasy art.

going From rgB to cmyk 

If you paint an image in RGB that will  

be printed in CMYK, the values may change 

when you convert it, resulting in washed-

out colours. Correct this with a  

level adjustment.

cmyk File sizes

CMYK files will be a larger file size because 

more channels are used.

more channel adjUstments

Something to remember is Adjustment 

modes such as Levels and Curves also 

enable you to adjust channels. 

thinking ahead

Check with your client to find out how your 

image will be used and how it should be 

supplied as a final format.

Use coloUrs

Colour your layers to indicate a changed 

layer. To do this right-click/Ctrl+click the 

layer you want to colour and select Layer 

Properties. Then choose a colour.

make yoUr changes clear

If you’re overpainting a piece, use a new 

layer and use clear solid brushes and 

colours to make all the changes obvious.

organise yoUr layers

Make use of the layer palettes functions, 

such as using Groups, layer colouring 

and naming the layers.

write some 

notes

Notes are a great  

non-destructive  

way to tell a client 

exactly which 

elements you have changed. In the Tools 

Palette you’ll find the Notes Tool. Simply 

click your artwork where you need to add 

the note and then start writing.

get typing

The Text tool can be used to add notes to 

your artwork if you prefer. Click and drag to 

draw a box for your text.

make yoUrselF clear

When you’re annotating your work, be as 

clear as possible so that anyone can 

understand your intentions.

name Files logically

When saving artwork with changes made, 

you should update the filename by adding 

number/letter increments. Ensure it’ll be 

easy to look through the various iterations. 

make room For FeedBack

Enlarging the canvas (Mac: Cmd+Alt+C,  

PC: Alt+Ctrl+C) will give you more space to 

add feedback, references and paint-overs.

12

  



1 RGB and CMYK
RGB is the standard colour 

range for all computer and television 

displays, while CMYK is a standard 

format for printed artwork. It’s useful for 

digital artists to work in either RGB or 

CMYK because the artwork will usually 

end up being displayed using one of 

these formats. Be aware though that 

professional and home printers now 

tend to employ CMYK inks rather  

than RGB inks.

1 Taking your art  
feedback onboard

Before diving into completing the final 

painting you should be able to roughly 

mock up the final image based on the 

feedback that you have received. In this 

process you want to make the design 

changes as clearly and quickly as 

possible, as you don’t want to waste too 

much time at this stage. Always make 

sure that your intentions for the final 

image are obvious.

2 Transforming  
a character

I’ve enlarged the size of the character 

using Lasso and Free Transform and 

Warp. Warp is good for bending and 

twisting the shape of a part of your 

painting – I use it in collaboration with  

a Lasso or Quickmask. The Liquify Tool 

is also useful for shifting elements 

around, such as repositioning a hand 

slightly or enlarging/shrinking elements 

in the piece.

3 Making use of  
Smart Objects

If you need to quickly concentrate on 

one element in your image, paint a 

Quickmask, duplicate this into a new 

layer and then go to Layer>Smart 

Objects>Convert to Smart Object.  

By double-clicking this layer you can 

now work on it in isolation without 

affecting the rest of the piece. To update 

the main image save the Smart Object 

and your main piece will be updated.  

2 Channel Mixer
Click Image>Adjustments> 

Channel Mixer to adjust the amount  

of colour for each channel and the 

brightness or darkness. So if you take 

the Red Channel, which by default is at 

100 per cent, and decrease that to zero 

per cent you’re removing all the red 

colour information in the piece. You  

can adjust each channel by selecting 

the colour from the Output Channel 

drop-down menu.

3 Sharpening with 
Lab Color

View your image in Lab Color mode 

and you’ll see a Lightness channel, 

which represents the image’s 

luminosity. Apply an Unsharp Mask 

filter to this channel (Filters> 

Sharpen>UnSharp Mask): this gives 

you better results and enables you to 

increase sharpness without distorting 

the image’s colour. Other filters on 

the Lightness channel work, too.

Step-by-step: Understanding colours and using the Channel Mixer

Step-by-step: Annotating and adjusting artwork post feedback

Photoshop | Colour channels and acting on feedback
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artists
panel

Cynthia Sheppard
A freelance fantasy artist with 

a background in traditional 

painting, Cynthia likes to bring 

classical techniques to her 

digital art.

www.sheppard-arts.com

Nick Harris
Gloucestershire-based Nick 

went digital in 2000 after 18 

years working with traditional 

methods. He works mainly on 

children’s book illustrations.

www.nickillius.com

Tuna Bora
A freelance artist based in 

L.A. via Istanbul, Turkey, Tuna 

has clients in the animation, 

video game and commercial 

art industries.

www.tunabora.com

Remko Troost
Remko is a seasoned video 

game concept artist who has 

recently worked on Assassin’s 

Creed III and Far Cry 3 for 

Ubisoft in Canada.

www.remkotroost.com

Jonathan Standing
Jonathan Standing is a 

concept artist based in 

Toronto. He’s currently 

working on the TV series 

Defiance for SyFy.

www.jonathanstanding.com

Paco Rico Torres
Paco is a freelance illustrator 

living in Spain who’s produced 

art for several card games, 

magazines, books and 

roleplaying games.

www.pacorico.blogspot.com

Jace Wallace
Jace has freelanced for 

magazines, book publishers 

and has produced concept  

art for many video games, 

including The Sims 3.

www.wakkawa.cghub.com

Raymond Swanland
You’ll recognise Raymond’s 

work from the Oddworld 

video games. A leading 

concept artist, Raymond is 

always in demand.

www.raymondswanland.com

Sean A Murray
Sean works in the video 

games industry creating 

concept art for leading 

studios. He is currently senior 

concept artist at Harmonix. 

www.seanandrewmurray.com

Kev Crossley
Long standing comic artist 

Kev has worked for 2000AD 

amongst other comic titles, 

drawing Judge Dredd. He’s 

currently freelancing.  

www.kevcrossley.com

Mélanie Delon
French artist and illustrator 

Mélanie creates art for book 

covers and games. She’s 

currently working on her 

personal book artwork.

www.melaniedelon.com

Core skills

how to paint 
CharaCters
Master the simple techniques and skills needed to create and paint character 

art, including advice on painting clothes, anatomy and poses.
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Ninjas are 

merciless,  

cold-blooded 

assassins, so you 

should reflect that 

in your work. 

Paco Rico 

ToRRes

TuRN oveR To leARN NeW SiMPle ART SKillS

Contents | Characters
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Accessing your workshop files 

Click or copy and paste the above link into 

a browser to download the files to a 

desktop PC or Mac. Do the same to 

watch videos where seen. 
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www.bit.ly/ifz12-ch

  



Artist’s advice
Cynthia says

The snarling expression is made 

by exaggerating certain features 

of the face and adding wrinkles 

or creases where there’s usually 

smooth skin. The main feature affected by a 

snarl or sneer is the mouth, which opens 

wider and exposes the teeth, sometimes at 

an angle. The lips pull back to create big 

creases from the sides of the nose down 

toward the chin. The muscles around the 

eyes also contract, causing the eyes 

themselves to become narrower, depending 

on the intensity of the expression.

However, snarling doesn’t just stop at the 

changes in the mouth and the eyes. In an 

extreme snarl or scream, the muscular 

changes beneath the skin take shape in 

some of the following ways. Big creases 

form from the side of the nose, and travel 

down next to the mouth. Small creases 

emanate from the inside corner of the eye, 

curving upward past the brow and onto the 

bridge of the nose. Corrugation occurs in 

the forehead above the eyebrows. Small 

creases emanate from the outside corner of 

the eye (giving the appearance of crow’s feet, 

even in young characters). Bunching of the 

skin occurs on the chin below the mouth.

Every facial muscle affects other areas 

surrounding it. When a muscle tenses in 

the forehead, for example, you can see a 

change in the cheeks and eyebrows too. 

Take into account what happens to every 

part of the face to really sell the expression. 

Creases are formed at 

various points of muscle 

tension around the face. 

The arrows highlight the 

most affected areas, 

and the direction of the 

creases formed.

The best way to…
draw a snarling facial expression

Step-by-step:
Paint a 
contorted 
expression

1 Draw a face. Imagine the 

features are made of clay; 

you can push them around in 

any direction, but where they 

come closer together, make a 

line to indicate a crease. That’s 

what the muscles do when we 

make an expression.

2  In a light snarl or sneer, 

most of the wrinkling 

happens on one side of the face, 

with the exception of a slight 

parting of the mouth. Think 

about the places where the 

creases are strongest and draw 

them in as light lines.

3  Shade the face. Don’t 

make the creases too 

dark and remember they’re 

rounded folds of skin, not just 

lines. Save the darkest wrinkles 

for around the nose, and paint 

the ones by the eyes, lips and 

brows with a value slightly 

darker than the skin tone. 

This character 

demonstrates the 

wide mouth and 

narrowed eyes, as 

well as other features 

such as a pinched 

brow, common  

when snarling.
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Artist’s secret
Skin aS a reflector

As well as having brighter, smaller 

highlights, wet skin also picks up nearby 

colours more than dry skin does. In the 

main image, for example, you can see red 

from the cape reflected under the 

character’s chin and on the side of her face.

How you can…
paint someone half-
submerged in water

The best way to…
paint a character who looks  

soaking wet

The Smudge palette knife in ArtRage is great for ripple effects. Similar tools 

can be found in other art programs.

Artist’s advice
Nick says

A lot depends on the scenario you choose as to how 

the water will look. A choppy sea has a very different 

surface from a placid pond – I’m going with the 

latter here. For a start, I choose a dress on my figure 

of a colour that contrasts with the dark tones of the water. 

I block in a dark-to-light gradient roughly with the oil brush in 

ArtRage on a layer beneath the one I paint the figure on. 

Between the two, on another layer at the top of the 

composition, I block in a grassy bank. 

Refer to details added on this for mark making on the water 

layer, but don’t worry too much about strict accuracy. Why? 

Because next I use the Smudge palette knife to drag the layer 

pixels left and right to create a zig-zag ripple effect. You can do 

the same thing for reflections of the figure, but bear in mind that 

its reflectivity depends on the angle you regard water surface. 

Hint at shapes below the surface where the figure is submerged.  

Anatomy of a droplet. As light enters at one side, it 

creates a point of light on the other side. The colours 

inside the drip should come from the environment.

straighter. Like fabric, hair also becomes 

darker when wet, so your character’s blonde 

hair might appear brown, or brown might 

look closer to black.

Water droplets and environmental cues 

help finish off the look. Add streaks of water 

running down a character’s skin. Using a 

colour that’s just a bit lighter than the skin 

gives a great effect. If your character is 

drenched, he or she might have drops of 

water falling from her nose, chin or hair. 

Adding hatch marks of rain or using a soft 

Round brush, set to low opacity to suggest 

dense mist, increases the believability that 

your character is in a wet place.

Artist’s advice
Cynthia says

The easiest way to give your 

character a wet or shiny look 

is to use small, bright 

highlights. Normally, when 

we see a face in strong light, like my 

example here, we expect the light to be 

distributed fairly evenly over the side 

facing the light. Instead, you can see 

bright white highlights on the forehead, 

nose and above the lip.

My second suggestion would be to 

give your character stringy hair. Even if 

your character’s hair is normally curly, 

the water that’s soaked into it would give 

it extra weight, and make it hang 

A character in the rain. Bright highlights, 

stringy hair and water droplets give the 

feeling of wetness. Raindrops around 

the character also help sell the illusion.

Consider how clothes trap air 

when first entering the water and 

how fabric behaves when wet.

Core skills | Characters
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Artist’s secret
the beauty of 

relativity

I bear in mind the eye’s relationship to the rest 

of the image. Usually I keep the image a bit 

softer or less rendered in comparison. The 

highlight of the eye will be the sharpest, 

brightest point on the character.

Artist’s advice
Jonathan says

Remember that shadows 

aren’t physical objects, but 

shapes and colours created 

by the obstruction of light 

falling onto a surface. So, when thinking 

about shadows in your image, the most 

important factor is how is your scene lit? 

Consider the colour of the light, its 

intensity, diffusion, and distance from 

the light source to surface.

Unless you have a mono lighting 

scheme, most of your shadows won’t be 

black, so avoid the urge to use it! Light 

bounces around us all of the time and 

Artist’s advice
Remko says

Hands are complex objects. 

They’re not easy to draw and 

it takes a lot of observation 

to understand them. Draw 

sketches of your own hand in several 

positions and observe how the hand 

and fingers fold and move, and the way 

the hand is attached to the wrist.

Don’t worry about the quality of your 

drawings – just try to understand why 

the hand acts as it does. You’ll soon spot 

some unusual traits. Fingers aren’t lined 

up straight on the hand and this is why, 

while your primary light source may not be 

falling in an area of shadow, perhaps a 

secondary one, or ‘bounce light’, is. Try to 

retain transparency in your shadows. It’s 

easy to let the tonal value of a shadow 

become so dark that it ends up opaque. 

Then the image usually takes on a dull or 

leaden quality, unless it’s very graphic. 

Provided you’re careful with your use of 

very dark tones, or even black (I’d still try to 

avoid it if possible), why not add some 

occlusion shadows? These occur where two 

surfaces meet, effectively blocking light 

from falling on one or both surfaces.

if the four fingers fold inside to the hand’s 

palm, the little finger comes closer to your 

wrist than your index finger.

As an example, if you draw a hand 

holding a gun, a great exercise to see if your 

hand is correct is to also draw the part 

behind the gun (on a new layer). Draw the 

part you don’t see to check if it works.

Another cool exercise is drawing the 

hand holding a gun, without the gun. These 

kind of exercises, from several points of 

view, will slowly get you used to drawing 

hands and understanding their complexity.

Artist’s advice
Tuna says

I’d start with a reference. The eyes are the focus of 

the face in portraits, but we still have to render them 

suitably for the occasion. In most portraits, they are 

the sharpest, most rendered part. But in a painting 

about action or an object, they could be three fuzzy brush 

strokes. This is really the main trick, along with keeping to the 

simple painting rules of colour, temperature, form and value 

(for instance, understanding the white of the eye doesn’t have to 

be white). A great way to study this is to look at the work of 

different art masters.

Understanding the forms is helpful, too. I remind myself that 

the eye is a sphere that’s bigger than it seems. A contact lens-like 

shape extrudes out of this sphere right where we look. That’s 

why there’s a sharp highlight around the iris. The light usually 

filters down and hits a concave surface (that aligns with the 

highlight and the light source) in the iris.

I do a loose line sketch. I then make it warmer because I want 

to change this centred, white, flash light to a directional warm 

light. I give it some basic form and local tone/colour. Then it’s 

just a matter of following the rules I explained, reminding 

myself of the light source and being consistent with it. 

I keep any sharp edges to a minimum, and add some texture 

to the skin and iris. These help a lot in making things look real, 

although if you look closely, I did very little work there.

Learn how to…
draw convincing  
eyes for portraits

The best way to…
draw a hand  

holding an object

An easy way to…
paint an image with realistic-looking 

shadows and lighting

Here I’ve tried to 
demystify the 
process a bit. 
Holding off on the 
details and using 
them sparingly is 
what makes a 
believable image.

Painting an eye is just a matter of understanding form versus lighting 
and how it fits/renders in contrast to the rest of the image.

Draw the hidden part of the hand on a new 
layer to see if the hand really works out.

Drawing hands holding guns, without the gun, 
is a great anatomy lesson in itself.
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Step-by-step: Use a maquette as reference to paint a figure

1 I set up this maquette with a red 

Christmas light illuminating one side 

and a green-tinted fluorescent bulb on 

another. Even though this photo looks 

sloppy, there’s plenty that I can glean from 

it. You can see where one light source is 

illuminating the shadow cast by the other.

3 Using washes of colour and then an 

Overlay layer to punch up the red 

light, I enhance the contrast between light 

and dark. I alternate between painting light 

and shade. Light and dark are relative, so 

building them up simultaneously helps me 

to balance them.

2 I create a thumbnail, using the pose 

from the reference I’ve made, but 

not too much else. The danger of making a 

reference before a sketch is that you can 

become a slave to it. Always start with a 

thumbnail and tailor your reference to fit it, 

rather than the other way around!

Artist’s advice
Paco says

The first step in learning to 

properly draw or paint the 

human figure is to observe the 

human body itself. So you need 

The key is to really look at the same time 

as you practise. If you just do one drawing 

after another without thinking, you won’t 

progress. The point of learning about 

the human body is to get rid of all the 

preconceived ideas we have on representing 

it which make our work look naïve. Pay 

attention to the volume that’s generated 

by the lights and the shadows, and to 

proportion, perspective and expression. 

Besides anatomy study and life drawing, 

you can try an exercise that’s useful for 

learning proportion and expression, and is 

also a good warm-up exercise. It consists of 

doing lots of quick paintings (between 30 

minutes and an hour) of people, focusing 

on depicting the anatomy. They don’t need 

to be highly realistic, but at least correct 

(don’t hesitate to use references). The aim 

is to learn new drawing techniques, not to 

produce masterpieces, so don’t worry if they 

look rough. Just focus on learning about 

the figure, spotting your own mistakes and 

then trying to get rid of them. Try to do  

one a day and I guarantee that you’ll notice 

an improvement!

to study anatomy (muscles and bones), 

and to do a lot of life drawing practice. If 

you can’t draw from a model, photographic 

references can do the trick. 

If you need a little 

motivation to practise, 

how about introducing 

a theme to your 

doodles to make the 

process more 

entertaining?

If the colours give you 

trouble, you can create 

a document with 

various colours to use 

as a palette. It speeds 

the process up.

A good way to…
get better at drawing 

human figures 

Core skills | Characters
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Artist’s secret
eaSy wayS to 

Select a figure

If you’ve kept the edges of your character clean, the 

easiest way of selecting it is by Ctrl-clicking the icon 

of the layer that your character’s on. If the edges of 

the figure aren’t clean, you can clean them using a 

Selection Mask.

Step-by-step: Brighten up your character

Discover the best way to…
paint a character doused in a bright white light 

Artist’s advice
Paco says

Painting a character surrounded 

by light using Photoshop is 

relatively easy. It’s a tricky effect 

to recreate with traditional 

media, but it’s one of those things that 

digital painting has made a lot easier to do. 

The one thing that you must bear in 

mind is that applying these cool-looking, 

easy-to-achieve effects won’t make a poor 

painting any better. If you don’t put enough 

effort into creating your character in the 

first place, then the image won’t work, no 

matter what else you do to it. 

With that caveat out of the way, let’s 

begin the process. The elements you need 

are an image of your character backlit (that 

usually means, white or almost white 

background, and the character in shadows 

with light around the edges of his/her 

silhouette). This is important because if the 

background either isn’t bright enough or 

the character isn’t lit from behind, the final 

result won’t make much sense. 

Once these elements are in place, you 

just need to use Low Opacity Overlay and 

Screen Mode layers. In these layers, paint a 

white outline around the character and 

then blur it using the Gaussian Blur. You’ll 

achieve a decent backlighting effect without 

hiding the details on the figure.

If you have a solid 

painting then creating a 

backlighting glow 

effect using Screen and 

Overlay Mode Layers, 

and the Gaussian Blur 

filter is straightforward.

1 First, you need to finish 

the painting. Here, as 

you can see, I’ve painted all the 

light in the background and 

placed the character in 

shadows, lit from behind. I 

strongly recommend painting 

the background and the 

character on two separate 

layers, as well as keeping the 

edges of the character clean. 

Doing this will make the 

following steps much easier.

3  Next you need to copy 

that layer several times 

(or repeat Step 2 on different 

layers), decrease their opacity 

and set their mode to Overlay 

and/or Screen. The number, 

mode and opacity of the layers 

is up to you. For this image  

I use an Overlay layer with  

56 per cent Opacity, a Screen 

layer with 34 per cent Opacity 

and an Overlay layer set to  

15 per cent Opacity.

2  Then, in a new layer, 

paint a thick white line 

around the character. You’ll 

eventually blur this line and it’ll 

become the glow that’s 

surrounding the figure, so don’t 

paint it randomly. Note that 

you’ll need to paint in the areas 

where the light around the 

silhouette of the character will 

be stronger. Once you’ve done 

this, use the Gaussian Blur tool 

to blur it (around 100 pixels).

4  Now you just need to 

erase the white glow 

outside the edge of the 

character. If you’ve done things 

correctly and kept the 

silhouette of the character 

clean (so there’s nothing on the 

character’s layer) then it should 

be easy to select the character, 

invert the selection, and delete 

the unwanted glow. Finally, just 

fix whatever else needs to be 

fixed in the image.
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Artist’s secret
track down textureS

Without having any solid reference it becomes much harder to make a convincing 

character. I’ll shoot my own reference for the pose but my favourite site to get some 

great texture reference is www.cgtextures.com.

Three different texture elements come together 

to make a beautiful but deadly earth guardian.

Learn how to…
create a striking-looking 

character using texture elements

A good way to…
paint heavy, old, worn  

and used armour

An easy way to…
paint glowing, magical  
tattoos on characters

Artist’s advice
Jace says

Like most things art 

related, there’s no one 

single method for 

creating a particular look 

or theme. When it comes to using 

textures to make an engaging-

looking character, I pick a couple of 

textures that play off each other. 

Textures are a lot like colour schemes. 

You can choose textures that are just 

varying shades of each other (such as 

a monochromatic colour scheme), or 

you can pick complementary textures 

to show contrast.

In this example I decide to go  

with a complementary scheme which 

uses a few different textures that 

contrast each other. The rock texture 

I choose is based on jagged cliff  

edges whereas the skin texture is 

smooth and soft. 

I add a third textured object to 

complement the rock texture and 

break up the repetition. The spiky 

crystals are still part of the rock/earth 

theme while remaining different 

enough to stand out. Crystals have a 

transparent glow to them that gives 

the perfect balance between a 

smooth and rough surface. The 

jagged edges also make the silhouette 

more interesting.

Artist’s advice
Raymond says

The first thing to keep in 

mind when creating a 

suit of armour is the 

anatomy of the person 

wearing it. If the shoulder pads are 

huge and intimidating, don’t let 

them sit up high and defy gravity. 

Let them hang and sag on the 

character’s shoulders. 

Then consider the type of metal 

and how it corrodes: iron rusts 

while bronze turns a green patina. 

Break up any solid surfaces by 

creating visual noise that suggests 

the pitting of corrosion and dirt in 

the low areas. I do this with a simple 

‘dirt brush’ that I created. 

If you overlay a photographic 

texture of worn metal then I suggest 

doing it lightly and continuing to 

hand-paint cracks and scratches 

over it. The last stage is where the 

real storytelling happens, by 

painting in unique damage like the 

dent from a crossbow bolt or the 

scratches of dragon claws.

Artist’s advice
Paco says

A magical glowing 

tattoo is just light after 

all. It projects light over 

the surfaces and casts 

shadows, so you have to paint it just 

like any other light source. To 

achieve a glowing effect you can use 

Soft Light and Overlay mode layers. 

First paint the tattoo with a pale 

colour – do it in a separate layer, 

because you may have to make it 

darker later on. Now paint over it in 

a Soft Light layer with the colour 

you want for the light of the tattoo, 

then blur it. Create a new Overlay 

layer and paint with a light colour 

(not pure white) and blur it again 

while adjusting the opacity and the 

colours. If your tattoo is hidden by 

clothing, make it less bright and use 

a Color layer so that it’s affected by 

the colour of the clothes.

I’ve used a custom dirt brush to add 

textural noise and roughness to the 

clean metal which helps give it a 

‘realistic’ corroded look.

These spheres 

illustrate how the 

textures play off 

each other. On the 

top there is the skin 

material. On the 

bottom is a rock- like 

texture. The middle 

sphere shows how  

I could mix the  

two together.

Make sure that the skin of the character is 

affected by the light of the magical tattoos.

Core skills | Characters
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Artist’s secret
create a convincing pattern

Start by sketching a pattern on a new layer above the clothing. Then fill in 

the areas that need to be a solid colour on that same layer, changing it to a 

Multiply layer with 60 per cent Opacity. Adjust the colour of the pattern and 

then, in a new layer, render the highlights. Finally, use the Eraser on a low 

Opacity to fade out some areas of the solid pattern.

Artist’s advice
Jace says

Dynamic poses, while 

difficult to achieve, are the 

most fun to paint. Using 

reference is always a good 

idea, but unless that reference follows 

guidelines on what makes a smooth 

dynamic pose work well, the reference 

won’t be much help.

Remember not to have the figure’s 

pose flowing in too many directions.  

I try to focus the character’s movements 

as simply as possible. Furthermore, a 

dynamic pose needs to have a fully 

committed action. A pose that has 

followed through with its intended 

action reads much better than a pose 

that’s just started a movement.

For example, if the character is 

throwing a punch I don’t draw them 

starting the punch but finishing it with 

their limbs at the end points. Another 

example is a character jumping. I’ll 

show the character flying through the 

air rather than preparing them to start 

the jump action. This way there’s no 

confusion on what the intended pose is 

supposed to be portraying.

How to…
create a dynamic pose  

for a character

Artist’s advice
Sean says

There are three key steps to 

creating convincing-looking 

patterning. First, remember that 

the pattern must conform to  

the contours of the clothing itself. Second, 

make sure the pattern is affected by light 

and shadow in the same way the base 

clothing is. Third, remember that the 

patterns don’t have to be flat – they could 

be embroidered sections or patches sewn 

into the clothing.

I usually draw clothing patterns into my 

pieces at the pencil sketch phase. I try to 

find reference of interesting patterns to use 

as inspiration. You can find a lot on the 

internet, or in copyright-free Dover Books.

Practise with simple patterns first. 

Visualise how the surface of the clothing 

undulates and folds back on to itself.  

Now draw a simple horizontal line pattern 

across the surface. This should give you 

an idea of how to apply more complex 

patterns on a similar surface. Apply trim 

patterns to the edges – these are easy to 

do and can help you work up to more 

complex patterning.

Be sure that you apply lighting 

appropriately. If your main field is blue 

and your pattern shapes are red, then 

you wouldn’t want a blue highlight on 

the red parts of your pattern. You can 

use Overlay or Screen layers to achieve 

the right colours for your lighting.

Drawing from life is the most effective 

way to learn how to render clothing 

patterns. If you’re applying a pattern 

using photo sources, try using the Warp 

or Liquify tool to make your patterns 

appear as if they’re lying on the surface 

of the clothing.

I apply a pattern to 

this character’s 

clothing after he’s 

fully painted. Doing 

this in a convincing 

manner adds depth 

and interest to the 

character design.

Here I use a lot of trim patterns for the robes. It 

helps to show layering and is a good way to add 

detail without overwhelming the image.

The best way to…
apply convincing patterns  

to characters’ clothes

The character’s 

skeleton shows the 

movement lines that  

I base the pose on. I 

use every aspect of  

the character to make 

sure the pose reads  

natural and smooth. 

Her extremities need  

to work together to 

create a cohesive, 

believable look.
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Discover an easy way to…
achieve a clean, polished look quickly in digital art

Artist’s advice
Paco says

Usually a clean, polished look 

means clean edges and no 

obvious brush strokes – easily 

done by utilising the tools in 

Photoshop and SAI Painting Tool.

Clean edges are easily achieved when 

working inside a selected area. If you  

select a part of your image, you won’t be 

able to paint outside the selection. That 

means you can paint without worrying 

about running outside the edges of 

whatever you are doing. 

If you use Photoshop, the most useful 

tools for selections are the Polygonal Lasso, 

which creates straight-sided polygonal 

selections and the Magnetic Lasso. This 

creates selections automatically, clinging to 

the edges of the figures, so you can select 

the silhouette of something you have 

previously drawn without much effort. 

To get polished surfaces quickly, you can 

use Photoshop’s Gaussian Blur filter. With it 

you can blur all the brush strokes on a 

roughly painted layer. You won’t get a 

finished look with that trick, but it’s a fast 

way to get a smooth base to work with.

Away from Photoshop I like to use the 

budget software SAI Painting Tool for my 

line art. This software has a unique 

Stabilizer feature that tidies up the lines as 

you sketch. I’ll explain how it fits in with 

my workflow in the steps below…

Step-by-step: Paint a character cleanly

I use the Gaussian Blur to soften 

the brush strokes in a layer (inside 

a selection to keep the silhouette 

of the face) and add just a few 

details to get a finished look.

Artist’s 
secret
vary your 

bruSh uSage 

I use soft brushes to paint 

subtle changes in smooth 

surfaces and hard brushes to 

paint details and define 

shapes. If you use only one 

kind of brush you won’t be 

able to blend areas effectively.

1 First I start by doodling a sketch. 

Once I have something I like, I make 

a line drawing of it. This drawing doesn’t 

have to look good, it just needs to be as 

clean and accurate as 

possible, to act as a 

guide for my painting. If 

you have shaky hands 

like me then you may 

want to use SAI Painting 

Tool. The Stabilizer 

feature makes this step 

a lot easier.

2 Next, I use the Magnetic Lasso tool 

in Photoshop to create a selection 

of the whole figure. The Lasso follows the 

lines automatically, so the cleaner the 

drawing is, the better. If 

you make a mistake 

using the Lasso, you can 

delete it by pressing 

Backspace. Once the 

selection is made I 

create a new layer and 

fill that selected area 

with a plain base colour.

3 In further layers I begin to paint the 

flesh, first with rough brush strokes 

blurred using Gaussian Blur filter to create 

a base, and then just painting carefully into 

my blocked colour. I 

concentrate on one area 

of the figure at a time, 

repeating the same 

process with the rest of 

the parts of the figure as 

I go. Finally, I just make 

some tweaks to ensure 

all the parts fit together.

Core skills | Characters
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Artist’s secret
a noSe for Shading

Avoid pure black when painting nostrils. The nostril itself is an empty space with very 

little discernible shape of its own, so what’s actually painted is the shadow cast by the 

surrounding nose. Instead of black, choose a dark colour that resembles the other 

shadows in your painting.

Thinking of a nose as a series  

of geometric shapes can  

make it easier to visualise  

at various angles.

Taking care over positioning shadows and 

highlights when shading a nose will help you 

to achieve a higher degree of realism.

The best way to…
paint noses with different  

angles and shapes

Learn how to…
paint multiple light sources  

on either side of a face

An easy way to…
design quick decals to add  

to military armour

Artist’s advice
Cynthia says

Start by visualising the 

nose as a 3D object that 

casts shadows. As well as 

its anatomy, many of the 

shapes we think of when we imagine 

a nose are created by shadows that 

give form to the nose itself. 

In its simplest form, the nose is a 

triangular block that’s wide in the 

back and tapers towards the front. 

You can use a visual model to 

determine where the major cast 

shadows will fall, and see how its 

bridge would change shape from 

straight to angled as the head turns. 

Of course, noses don’t have sharp 

angles, so we have to imagine the tip 

of the nose as being more like a 

sphere and the bridge like a cylinder 

when shading.

When painting the nose, keep 

these things in mind. Start with a 

line drawing on a flat skin tone. 

Bearing in mind the geometric 

shapes we’ve already discussed, apply 

your brushstrokes following the 

contours. Some noses are shiny and 

so they often pick up colour from the 

surrounding environment. Reserve 

the lightest colour on the skin of the 

face for the highlight on the nose.

Artist’s advice
kev says

In 3D environments, 

light is continually 

bouncing around, 

reflected from object 

to object. This reflected light can 

illuminate objects that might 

ordinarily be in shadow. Reflected 

light thus behaves like a secondary 

light source, and in painting can 

help to create a greater depth of 

dramatic, 3D space within what 

will usually be a 2D image.

I’ve painted a portrait of a 

character from a television 

programme to illustrate how easily 

you can create depth by adding 

some reflected/secondary light. 

The first image is lit by a single 

light source, resulting in one side 

of the head being illuminated, 

with one side in shadow. 

I then paint a blue-ish hue into 

the shadowed side of the head. 

This could either be the ambient, 

reflected light of a darkening sky 

or light reflected from a nearby 

wall. As a result the light is soft and 

painted in a subtle range of tones 

to add depth and detail to the 

shadowed areas of the character.

For my design, I begin by 

making vector design elements in 

Illustrator. The wings, bulldog, 

handprint, banner and skull are 

among many separate graphic 

elements that I create. Then, 

referencing what I’d seen in a 

book, I combine these pieces to 

make the Flying Bulldogs insignia. 

I import the vector art into 

Photoshop and skew and warp it 

to conform to the curvature of the 

armour plate. To make it look less 

clean, I place an Overlay texture of 

stippled paint over the design and 

mirror the distress on the armour 

on the design. Integrating a vector 

graphic into a painted image can 

be tricky and it’s often best to run 

a filter on it or dirty it up a bit. 

Finally, I add a highlight over the 

metal and the paint, which helps 

blend the images together.

Artist’s advice
Jonathan says

First, find some 

references. Think what 

kind of military unit is 

it? Is it one with a rich 

history of pageantry, or one that’s 

primitive or tribal in nature? 

A secondary light source to the right 

illuminates the shaded parts of the head. 

Using gradients on the flat colours of the 

decal gives it volume. Without this, the 

armour’s decal would look flat and fake.
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Artist’s secret
creating cuStom bruSheS

You can take a photo of shiny sequins or materials and add it as a texture 

inside your brush in the Natural Media brushes section. Open your photo 

in Photoshop, select the whole image, then click Edit> Create Pattern. 

Inside the Natural Media brushes click Texture and you’ll find your photo 

inside the textures that you can use for your brush. Save it and paint!

Learn a good way to…
paint a crumpled, shiny material

Artist’s advice
Remko says

Retro-looking spacesuits are 

great fun to paint and good for 

creating these kinds of textures. 

I like to work using the Natural 

Media brushes and their endless 

possibilities in Photoshop.

I create most of my own brushes on a 

separate document that’s placed alongside 

my main image. This enables me to create a 

brush as I need it in the painting process, 

rather than setting up a custom brush and 

then trying to pick up where I left off. 

If you don’t want to make your own 

custom brush, you can find plenty on the 

internet. Try them out to see which ones fit 

your process best. If you take time to study 

them – how they were made and how they 

function – then you’ll better understand 

them once you create your own. I find that 

custom brushes are particularly helpful for 

quickly creating the kind of textures or 

patterns we need for crumpled material.

In this case I use brushes with basic 

shapes, such as hexagons or triangles, to 

create shiny patterns, and spackle brushes 

to imitate the shiny vintage sequin feeling 

of a retro spacesuit. I start by quickly doing 

a black and white sketch to nail down my 

values and lighting. Then it’s time to add 

the colour, texture and detail, using my 

custom brushes – see my steps below.

Step-by-step: Create a retro spacesuit using custom brushes

A sci-fi character 

wearing a shiny 

futuristic spacesuit. I 

created multiple light 

sources for the suit to 

make it look even 

shinier and sparkly.

1 I create a layer above my initial 

sketch of the female astronaut, set it 

to either Overlay, Multiply or Color, and 

start painting in my first colours. Then on a 

new layer that’s set to Multiply, and using a 

hexagonal brush 

with Spacing set to 

45 so that it repeats 

itself, I paint a 

pattern on the  

suit that closely 

follows the form of 

my character.

2 The next step is to make a mask of 

the solid hexagons by pressing 

Ctrl+Alt (Ctrl+Cmd on the Mac) and 

clicking the layer that contains them. Then 

I go to Edit>Stroke and on a new layer 

create thin, white 

hexagonal outlines 

on the space suit. 

Now, using a Soft 

Round eraser, I 

remove the  

outlines in the 

shaded areas.

3 I take a spackled custom brush and 

begin the final stage of the painting. 

I use this brush to add the final highlights 

to the image, to create the look of the  

gold sequins such as those on the rear of 

the character’s 

helmet and on her 

shoulders. I want to 

really boost the 

shiny, sparkly feel 

that such a retro-

looking spacesuit 

would possess.

Core skills | Characters
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Artist’s secret
Sharp bladeS

Using Selections to paint swords is the best 

way to achieve hard and clean edges. when 

using Photoshop you can use either the Lasso 

or the Pen tool. Press Cmd/Ctrl+H to hide 

the marching ants, which can prove 

distracting for some people.

Step-by-step: Compose a cold-blooded killer

Learn the basic ways to…
make a sexy female ninja look deadly

Artist’s advice
Paco says

If you’ve chosen to paint a 

female character – in this 

instance a ninja – and you want 

to make her look both deadly 

and sexy at the same time, then I think it’s 

important to maintain a balance between 

these two extreme characteristics.

Whenever you have to design a character, 

even if it’s someone who you’re going to 

paint just once, you have to come up with 

some background information that will,  

in turn, inform your art. What’s their 

personality, their social status, their chosen 

career? If you want to paint a sexy ninja 

then you have to consider that ninjas are 

merciless, cold-blooded assassins, so you 

should reflect that in your work. If you 

don’t then your ninja may end up looking 

like a stripper wielding a katana.

A good way to maintain a balance 

between these contrasting qualities is to 

paint her as a fearsome ninja who happens 

to be hotter than Hell. Her expression,  

her attitude and her gear are those of a 

shinobi mercenary, because those are 

characteristics derived from her lifestyle. 

And she has a sexy body just because she 

was born like that.

1  I spend some time 

doodling my character 

until I find something I like: a 

defiant pose with a sexy but 

practical outfit. Then I start to 

define that doodle with the  

aim of producing a solid base 

for the painting. I use 

Photoshop’s Hard Round Basic 

brush, focusing on clearly 

depicting the design of the 

ninja as well as the colour, light 

and proportions.

3 I switch to PaintTool SAI 

and start to polish the 

image using different blender 

tools. It’s not necessary to 

paint in a smooth and polished 

way to achieve a striking 

image, but it’s perhaps the 

easiest way. Remember that a 

depiction of a sexy woman 

doesn’t automatically become 

a sexy image. It’s the quality of 

your painting that determines 

the impact it has on the viewer.

2 I start to add more 

detail, this time using a 

Medium Opacity Hard brush. 

At this stage it looks quite 

rough, yet detailed. I try to 

define all the areas of the 

image before polishing it. If you 

want to paint a sexy-looking 

character then you have to pay 

attention to detail. Every line, 

every surface can mark the 

difference between what’s 

sexy and what isn’t.

4 Switching back to 

Photoshop, I paint the 

tattoos in a Multiply layer to 

preserve the lights and 

shadows of the leg. I also end 

up painting some final touches 

in a Normal layer. A good trick 

to use when applying tattoos is 

to first paint them on a 

different layer over the skin, 

and then make the layer 

slightly transparent to achieve 

a more natural look.
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I paint a base structure for the hair to avoid 

getting lost later on in the process, and then 

I paint the hair texture and reflections over it.

When hair is shiny, and especially when 

it’s dark, it reflects not just the light but 

also the colour of the surroundings – in 

this case, green.

The best way to…
paint a character with  

shiny, curly hair

How to…
paint a portrait with  
almost no shadows

Learn to…
give a female character 

realistic, sexy lips

Artist’s advice
Paco says

If you want to paint a 

curly-haired character in 

a simple way, a bunch of 

well-placed brush strokes 

can do the trick. The challenge comes 

however when you’re aiming to 

create a very elaborate piece. 

A good tip to start with is to try to 

paint the hair as an expressive 

element of your painting. If a 

character’s hair is an important 

element of the image, try to give it a 

shape that benefits the composition, 

or an expressive look that goes with 

the feeling of the image. Hair can 

have almost any shape, so when it 

comes to painting it, think of it as an 

ace up your sleeve. 

The actual process of painting hair 

– especially when we’re talking about 

complex, curly hair – is best started 

by painting it as a solid object. Hairs 

tend to group together with each 

other and form different shapes, so  

before starting to detail individual 

strands one by one, try to paint them 

in groups with all the lights and 

shadows. Imagine that the hair you’re 

painting is made of clay. This will 

make the rest of the process easier.

Artist’s advice
Mélanie says

Shadows define the 

volume and the shapes 

and also attract the eye 

to the most luminous 

part of a painting. Here, I’m doing 

the opposite, contrasting the part of 

the face I want the viewer drawn to, 

and leaving the rest in full light.  

Another trick is to overuse layers. 

I always paint my shadows on a 

different layer, and once it’s done I 

set the Opacity to 50 per cent – this 

way they stay light and diffuse. I 

also don’t use any kind of hard, 

round-edged brushes; I prefer to 

work on the shading with a soft-

edged one to avoid strong shadows.

The last point, of course, is to add 

light. I usually add it all over the 

painting on another layer, to blend 

the face with the background and 

attenuate the shadows. I add extra 

light on facial features such as the 

lips, the nose and the eyelids.

Artist’s advice
Paco says

First, study lips from 

real life using reference 

photos or a live model. 

This is important: you 

can’t paint anything realistically 

without understanding it, so if you 

aren’t confident about your ability 

to depict lips then perhaps some 

life-painting sessions are in order.

Try to be subtle when painting 

the wrinkles of the lips. Use soft 

brushes, and don’t forget where 

the light is coming from. If you use 

a Photoshop scatter brush to create 

a noise texture in a low opacity 

Multiply and Soft Light mode 

layer, then you can achieve a more 

natural look for the skin.

About making them look sexy… 

well, normally, big and moist lips 

are sexy. Furthermore, a slightly 

open mouth is sexier than a closed 

or a wide-open one. But the true 

key of painting sexy lips (or any 

other sexy thing for that matter) is 

to reflect in your painting what 

you like about them. Think about 

how they make you feel, and try to 

paint in that mood. If you manage 

to put a dash of your own passion 

into your painting then you’ll have 

won half the battle.�

Once the eyes are more evident, it’s 

important to have the same level of 

detail all over the face. I always add 

some sharp details to the features.

Lips can seem difficult to paint, but 

once you understand their basic 

structure, they’re no big deal. Just  

try to be subtle with the detail.

Core skills | Characters
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H
aving a well thought-out 

colour palette is a vital part  

of the painting process. 

Choosing your colours before 

you start helps ensure that 

your hues and tones stay true to your 

concept, and don’t become too varied. 

Painter provides two tools for this task: the 

Mixer Palette and the Color Set. The Mixer 

Palette is a digital version of the wooden 

artist’s palette, while the Color Set enables 

you to create a collection of individual 

colour blocks, called Swatches.

Painter provides a number of ways to 

customise your brush textures, and 

personalise your brush workspace and 

inventory. Sometimes these methods  

can be slightly obscure, but a bit of 

experimentation can pay dividends in 

terms of speed and function. 

In this guide I am going to show you  

how to define your own brush textures to 

give your work an individual feel. I will  

also explain how to give each brush its  

own individual custom icon, and then  

show you how to save multiple brush-

related settings all together under a single 

icon, using the Look feature.

mixer interface

select  

your 

Brushes

F
ind your way around Painter’s 

brush selector menus with our 

useful guide…

Manage your CoLour PaLeTTeS

CuSToMISe your bruSheS

“Choosing your colours before you 

start helps ensure that your hues and 

tones stay true to your concept”

a. Menu

Load and save, plus 

other options.

B. Brush 

sizes

As well as affecting 

Mixer brush size, 

this also specifies 

the Pick area when 

you’re using Sample 

Multiple Colors.

c. saMple 

Color

Use this to pick a 

single colour.

D. saMple 

Multiple 

Colors

as Acrylics or  

Artists Oils.

D. Brush 

Variant

Lists all brushes that 

are available in the 

current Category.

e. toolBox

This contains your 

basic toolset plus 

also enhanced 

brush functions 

such as Looks  

and Nozzles.

Variant from the 

drop-down lists.

B. Brush 

seleCtor 

Menu

Create brush 

Categories, Variants 

and Textures,  

and organise  

your brushes.

c. Brush 

Category

Lists your brush 

groupings, such  

a. Brush 

seleCtor

Use this to choose 

your brush 

Category and 

Use this to pick up 

several colours.

e. zooM

Click to zoom in, 

and right-click to 

zoom out.

f. searCh For 

Color

Search for nearest 

match, or by name.

G. add Color

Add a swatch to 

your Color Set.

h. reMoVe 

Color

Delete a swatch 

from your Color Set.

f. look 

seleCtor

For Look Selection 

List and Look 

Selector Menu.

G. look 

seleCtion 

list

Choose a Look.

h. look 

seleCtor 

Menu 

Create, save and 

manage your Looks.

hG

a
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f
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1 Mixer Palette
First, display the Mixer using 

Windows>Color Palettes>Mixer. Click 

the Apply Color icon. Choose colours 

from the colour wheel, or from a 

reference image, and then apply them  

in the Mixer. To select a single Mixer 

colour, click Sample Color. If you’re  

using an Oils or Real Bristle brush, try 

using Sample Multiple Colors. This 

option enables you to pick several 

colours at once.

1 Capture a brush texture
Paint a texture onto a white 

background. Use shades of grey for 

transparency and black for solid. Now 

select the texture. Choose a brush  

that you wish to modify (or copy an 

existing brush using Copy Variant) and 

from the Brush Selector menu choose 

Capture Dab. You can now paint 

immediately with your captured brush 

or you can go into the Brush Creator to 

edit the settings.

2 Create a brush icon
For a unique brush icon you 

need to create a new Category. 

Configure your brush and then load or 

create an image. Now select your  

image, click the Brush Selector menu 

arrow and choose Capture Brush 

Category. Give the Category a name 

and click OK. Drag the Brush Category 

from the Brush Selector onto the 

workspace or custom palette to create 

your custom icon.

3 Save a brush Look
A Look enables you to group 

several settings under a single choice. 

To demonstrate, select your captured 

brush and give it a Paper texture 

(Window> Library Palettes>Papers). 

Dab your brush on the canvas and 

select the area. On the Toolbox, click the 

Look Selector. From the menu choose 

Save Look and give it a name. You can 

drag the Look onto the workspace to 

give it its own icon.

2 Color Sets
If you go to Windows>Color 

Palettes, you can display the Color Sets. 

Click the Add Color icon to add the 

current colour. To remove a colour, 

select it and click the Delete Color icon. 

From the menu, which is accessed via 

the arrow in the top right corner, you 

can format and order your Swatches. 

Ordering them by LHS (level, hue, 

saturation) is often the most useful 

method to employ.

3 Color Set shortcuts
You don’t have to build your 

Color Set manually. Load a reference 

image and choose New Color Set From 

Image in the Color Set menu. This 

creates a 256-swatch Color Set based 

on your image. You can then format this 

as necessary, adding and removing 

colours as your work requires. There are 

options for creating Color Sets from a 

particular layer, from a selection or even 

from the Mixer.

Step-by-step: Explore the Mixer Palette and the Color Set

Step-by-step: Create your own brushes and save as a Look 
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Composition aids, when used sparingly, 

can pay dividends in terms of a solid 

framework for your image. beyond the 

standard grid and ruler tools, Painter  

offers additional functions to help with 

composition and to inspire creation. In this 

section I’ll be demonstrating the basics of 

three of these tools: 

the Layout grid, 

which is handy for 

implementing the 

rule of thirds; the 

Perspective grid, 

which is useful for 

cityscapes and large 

structured objects; and the Divine 

Proportion tool, which can add harmony  

to your composition.

People often ask me how to create brushes 

for a more painterly result. The secret lies in 

configuring your pen and understanding a 

few fundamental brush properties. once 

you’re confident with the basics, Painter 

offers an enormous range of fine-tuning 

options. here, I’ll reveal the most 

important settings for creating two 

painterly brush types – one for broader 

strokes and one for detail – which I use for 

almost all my colour work.

use these 

tools when 

paintinG…

SeT uP PaInTerLy bruSh STrokeS

uSe CoMPoSITIon anD LayouT aIDS

“Composition aids, when used 

sparingly, can pay dividends in  

terms of a solid framework for  

your image”

eDit your Brushes

a. Brush 

deFinition 

This identifies the 

characteristics of the  

brush that you’re using, 

such as whether it is Oils  

or Acrylics. 

B. opaCity

Determines how 

transparent your paint  

is. You can link Opacity 

with Pressure for 

enhanced control. 

c. grain

How the Canvas (Paper) 

pattern shows through  

the paint. 

D. resaturation

Set the amount of colour 

output in a stroke.  

e. Bleed

This determines how the 

paint interacts with 

existing paint. Linking with 

Inverse Pressure means 

less pressure and 

more blending. 

f. dryout

How fast the paint  

is used up. 

G. Brush 

loading

Pick up multiple 

colours with dab-

based brushes and 

Artists’ Oils. 

h. paint 

Controls

This enables you to 

set the amount, 

thickness and 

blending of paint. 

i. Brush 

Controls

Set the bristle 

visibility and 

clumpiness trail-off.

J. Wetness 

Use to set how wet 

or dry your paint is 

on the brush.

K. dirty Mode

Uncheck to have a 

fresh paint colour 

with every stroke.

diVine proportion tool

This feature makes use of the 

Divine Triangle, which breaks 

features into a proportion of 1:1.618, 

an aesthetically pleasing ratio.

layout grid

The Layout Grid is used to apply 

the rule of thirds, so that points of 

interest are placed on the lines and 

intersection points of the grid rather than in 

the centre of a composition. It can also be 

customised to other grid patterns.  

perspeCtiVe grid

You can easily achieve depth using 

this useful tool, which overlays 

perspective guidelines on your art.  

a

B

c

G

D

e

f

h

J

i

K
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1 Pen configuration
It’s important to make sure  

you configure accurate pen pressure 

sensitivity. To ensure the full range of 

pen pressure is recognised, choose 

Edit>Preferences>Brush Tracking and 

sketch a few lines as you would 

normally. Now click OK. Paint a little on 

your canvas and make sure the brush 

reacts to even the faintest pressure. 

Keep tweaking your Brush Tracking 

values until you’re completely happy.

1 The Layout Grid
In Painter X onwards, choose 

Window>Layout Grid to display the 

Layout Grid palette. Click Enable Layout 

Grid to toggle the grid on and off. Use 

the Type pulldown to select a preset 

layout – Rule of Thirds, for example. 

Move the sliders to control parameters, 

including number of divisions and 

colour. To move the grid, select the 

Layout Grid icon and drag your pointer 

over the image. 

2 The Perspective Grid
To open the Perspective Grid 

tool select Canvas>Perspective 

Grids>Show Grid. Then you can use the 

controls that appear to select a grid or 

create a new custom grid. Toggle the 

vertical and horizontal components  

and change their colour and spacing. 

Select the Perspective Grid icon from 

the Toolbox and then you can drag 

points to adjust the grid. You can even 

invert your viewpoint. 

3 The Divine  
Proportion tool 

Choose Window>Divine Proportion to 

display the Divine Proportion palette 

(Painter X onwards). Toggle the overlay 

with Enable Divine Proportion. Control 

the attributes with the Orientation, Size, 

Rotation, Colour, Opacity and Levels 

options. Toggle the Grid, Spiral or Axis 

components with the Display boxes. 

Select Divine Proportion from the 

Toolbox and drag to move the overlay.

2 Edit your Oils brush
Select a single-stroke Artists’  

Oils brush as your base. Use 

Window>Brush Controls to view the 

General and Artists’ Oils toolbars. Set 

the Opacity to 100 per cent and 

Expression to Pressure for pressure-

dependent transparency control. Set 

Amount to 100 per cent, Blend to  

27 per cent and Wetness to 100 per 

cent. This brush is great for painterly 

strokes at sizes of six pixels or more. 

3 A wet detail brush
Start with a basic circular  

single-stroke brush. In the General 

toolbar, set Subcategory to Grainy Flat 

Cover and Opacity Expression to 

Pressure. Under Well, set Resaturation 

to 100 per cent, Expression to Pressure. 

Set Bleed to 20 per cent, Expression  

to Pressure with the tick-box checked. 

Set Dryout to around four. Now, the less 

you press, the more your brush blends 

the existing paint.

Step-by-step: Create two painterly brush types

Step-by-step: How to use composition aids

Vertical 
plane

VanishinG 
point

horizon line

horizontal 
plane

horizontal 
anD Vertical 

plane 
intersection
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usinG

painter 12 

We’ve covered Corel 
Painter in general, 
now let’s take a 
look at Painter 
12’s unique 
features…

a. reCtangular seleCtion

Select a rectangular area. Press and  

hold the Shift key during dragging for a 

square selection. 

B. oVal seleCtion

Select an elliptical area. Press and  

hold the Shift key during dragging for a 

circular selection.

c. lasso seleCtion

Create an irregular outline, drawing as 

you would normally. Double-click to end.

D. polygonal seleCtion

Use this tool to create a straight-edged 

outline by clicking 

different points on 

an image and 

joining the dots.

e. neW 

seleCtion

Each new selection 

replaces the one 

before it.

f. add to 

seleCtion (+)

Existing selections 

stay active as you 

create new ones.

G. suBtraCt 

FroM 

seleCtion (-)

New selections 

subtract from 

existing selections. 

This is useful for 

complex outlines.

h. ConVert 

your 

seleCtion to 

a shape

Create a shape 

object from your 

current outline.

SeLeCTIon anD MaSkIng TooLS

navIgaTe The uSer InTerfaCe

everyone knows about the standard copy 

and paste functions available in most art 

packages, but beyond that Painter offers a 

number of tools to extend this 

functionality. These enable you to 

manipulate your painting, use masks to 

create shapes and gradients, and produce 

rapid, effective design elements. In this 

section I will cover the basics of selection 

definition and adjustment, how to tailor 

your paint area using Layer Masks, and I 

will also touch on more specialised features 

such as feathering.

“Painter enables you to manipulate 

your painting, use masks to create 

shapes and gradients, and produce 

rapid, effective design elements”

selection options

h

Ga

B

c

D

e

f

While painting and drawing features are 

fundamental to an art package, workflow 

and customisation are also important. 

Painter provides a unique but detailed  

user interface that gives you more scope  

to configure your workspace. 

familiar customisation options such as 

user-defined key-presses are still present 

(edit>Preferences>Customize keys), while 

extra features have been added, such as 

tabbed panels, palette-based commands 

and custom icons. other improvements 

give the ability to anchor horizontal 

palettes, such as the Property bar and brush 

Selector, at the top or bottom of the screen, 

and the option to have the Toolbox 

displayed in horizontal aspect rather than 

vertical (edit>Preferences>Interface). 

manaGe your 

palettes

a. palette

The palette acts as a 

holder for one or more 

panels. Within a palette, 

panels can be organised 

horizontally (such as  

Dab Profile and Brush 

Calibration in this 

example) and/or vertically. 

To reposition, simply drag 

the palette header bar to a 

new location. 

B. Close panel

This removes an individual 

panel. If the palette holds 

no more panels then it too 

will disappear.

c. VisiBle panel

The lighter shade of grey 

used to colour this panel 

indicates that this is an 

active panel. Note that 

only one side-by-side 

panel at a time is 

able to be viewed. 

D. MiniMised 

panel

If all panels side-by-

side are minimised 

then they appear  

as a line of tabs. 

Double-click an 

active panel tab to 

either minimise or 

expand it. 

e. non-aCtiVe 

panel

Click on a dark grey 

panel tab if you 

want to make that 

panel become 

visible. The other 

panels which are in 

the group will be 

repositioned 

automatically. 

f. single 

panel

In our example on 

the left, the Mixer is 

a single panel in a 

palette of its own. 

It’s snapped to  

align with the first 

palette, but isn’t 

part of it.

a

B c

D

e

f
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1 Basic Selection tools
Click the Selection icon on the 

Toolbox. Selection options and 

methods appear on the Property Bar. 

Click the Lasso icon and the + icon. 

Draw some shapes. Click the Selection 

Adjuster on the Toolbox. Move your 

selection around. Grab a corner to 

resize, hold down Ctrl/Cmd to rotate. 

Now paint your selection and move/

rotate again. Ctrl+D (Cmd+D) removes 

the selection.

1 Panels and palettes 
Panels can be grouped within 

palettes for convenience. Grab a  

panel’s tab and drag it towards a 

palette. A faint blue line will appear 

showing where your panel will be 

inserted. If the line is vertical then your 

panel will appear beside the existing 

panel(s). If you want to insert a panel 

above or below another one, simply 

drag your panel so that a horizontal line 

appears in the desired location.

2 Create custom palettes 
Hold Shift and drag a brush icon 

from the Brush Selector onto the 

workspace. A custom palette is created. 

Choose Window>Custom Palette>Add 

Command. Under Add to, select your 

new palette. Choose any menu 

command (for example, Edit>Flip 

Horizontal) then select OK. Your 

command appears on your palette. 

Right-click the command and choose 

View As Icon if you prefer.

3 Create custom icons 
Create a new canvas, optionally 

with Color RGB (199,200,202), and 

paint an icon design. Select your 

painting with Rectangular Selection 

(hold Shift and drag for a square 

selection). Right-click an icon on your 

custom palette and choose Capture 

Custom Icon. Or, choosing Set Custom 

Icon… selects an image from file. You 

can move icons within and between 

custom palettes by Shift-dragging.

2 Layer Masks
First ensure that Channels and 

Layers are ticked in the Windows  

menu. In Layers, create a new layer and 

click the Create Layer Mask icon. In 

Channels, click the Layer Mask. Now 

paint your mask. This will show as 

greyscale, with black being opaque. 

Click the left-most layer box in Layers 

and paint on and around your mask. 

When you are finished, choose 

Layers>Apply Layer Mask.

3 Special effects
Experiment with special effects, 

such as selecting with the Magic Wand 

from the Toolbox, or using Select>Auto 

Select. As an example, I’ll use the 

Feather tool. Draw one or more 

selections on your canvas as in Step 1. 

Choose Select> Feather, enter 12 and 

press OK. This will fuzz the edges of 

your selection. Now use the FX/Glow 

brush to paint your selection – great for 

that graffiti look!

Step-by-step: Using selection tools and Layer Masks

Step-by-step: Managing panels and palettes

layer 
contents

layer masK 
contents

create
layer masK

layer masK 
VisiBility 
toGGle
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Painter 12 features an advanced Multicore 

option, available as a tick-box at the bottom 

of the general panel and selectable per 

individual brush. Ticking this option 

instructs Painter to use all available CPu 

cores when painting with the current brush. 

however, it’s best not to turn on Multicore 

for every brush, because applying Multicore 

to simple brushes can cause an overhead 

which may result in higher CPu usage 

without any added performance benefit. So 

try Multicore first and see if it benefits your 

chosen brush. 

painter’s 

Brush 

caliBration

T
o get started, bring up the Brush 

Tracking window, using the Brush 

Tracking icon to the bottom right 

of the Brush Calibration panel.

geT More froM PaInTer’S bruSheS

“The Multicore option instructs 

Painter to use all available CPU 

cores when painting with the  

current brush”

geT To grIPS WITh reaL WeT oIL

Painter 12 offers real Watercolor and real 

Wet oil brush categories. both are based 

around similar configuration settings that 

deal with everything from the familiar 

options, such as paint quantity and 

wetness, to more advanced settings that 

include drying speed, paint settling and 

canvas interaction. In addition, diffusion 

and animation controls add authenticity  

to the painting process while allowing for 

the option of swifter stroke execution on 

slower machines. 

set your stroKes

a. Brush

Wetness controls the liquidity of 

the paint. Concentration sets the 

strength of pigment. 

B. liquid FloW

Increase Viscosity to simulate 

thicker paint. Decrease 

Evaporation Rate and the paint 

remains wet for longer. 

c. paint

Settling Rate works in a similar way 

to Opacity. Increase Blend Rate  

for more blending and increase 

Pickup for more interaction with 

existing paint. 

D. CanVas

Roughness is the coarseness of the 

canvas and Flow Resistance 

specifies how much it impedes 

paint flow. Increase Dry Rate for 

faster absorption and increase 

Granulation for the paint to settle 

more into the canvas. 

e. Wind

Angle is the direction of flow of  

the paint. Increase the Force 

setting to maximise the distance 

the liquid will travel.

f. diFFusion

Uncheck Accurate Diffusion if  

you want faster but less-accurate 

paint behaviour, and uncheck 

Delay Diffusion if you want to  

have the paint spread and dry in 

real time.

a. 

sCratChpad 

Sketch in this area 

with typical speed 

and pressure range. 

The values that are 

described below 

(Velocity Scale, 

Velocity Power, 

Pressure Scale and 

Pressure Power)  

will then be set 

automatically. If 

you’re not happy 

with these values 

you can alter them 

manually, either  

in the Brush 

Tracking window or 

through the Brush 

Calibration panel. 

Configure these 

settings first using 

the Scratchpad  

and then adjust 

them by hand. 

B. VeloCity 

sCale

Increase this value 

to spread the 

velocity response 

over a larger pen 

velocity range. You 

need at least one 

brush Expression 

set to Velocity to 

see this work. 

c. VeloCity 

poWer

Increase to heighten 

the velocity needed 

to achieve a certain 

effect. You need at 

least one brush 

Expression set to 

Velocity for this. 

D. pressure 

sCale

Increase this value 

to spread the 

pressure response 

over a larger pen 

pressure range. You 

need at least one 

brush Expression 

set to Pressure to 

see this work. 

e. pressure 

poWer

Increase this value 

to heighten the pen 

pressure that’s 

required to produce 

a certain effect on 

the canvas. You 

need at least one 

brush Expression 

set to Pressure to 

see this work.

a

B

c

D

e

f

a

B
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1 Diffusion controls
Select Window>Brush Control 

Panels>Real Wet Oil, then choose the 

Wet Oil variant from the Real Wet Oil 

category in the Brush Selector. If you 

have a powerful computer then at the 

bottom of the Real Wet Oil palette try 

unchecking Delay Diffusion and 

reducing Animation Step to 0. For extra 

speed, uncheck Accurate Diffusion, 

check Delay Diffusion and set the 

Animation Step slider to a higher setting.

1 Brush calibration 
Painter 12 enables you to  save 

unique calibration settings against each 

brush. On the Brush Calibration panel, 

tick Enable Brush Calibration and then 

click the brush icon in the lower right-

hand corner. On the Scratchpad that 

appears, draw a stroke using typical 

velocity and pressure range, then click 

OK. If the checkbox is left unticked the 

generic calibration preferences in Edit> 

Preferences>Brush Tracking are used. 

2 Dab Profile 
The Dab Profile functions have 

been expanded in Painter 12 and now 

include Dab and Stroke previews. In the 

Dab Profile panel, select a brush tip 

shape from the right-hand options 

(some are greyed out, depending on the 

brush type). Choose each of the three 

icons above the Preview Stroke to 

preview Size & Shape, Hard Media and 

Brush Dab, or click the Dab Preview 

pane to cycle through all three options. 

3 Stroke Attributes
Halfway down the General Panel 

is a tick-box entitled Use Stroke 

Attributes. Tick this to activate the 

Merge Mode pull-down and Stroke 

Opacity slider. From Merge Mode, 

choose an overlay method and alter the 

opacity of this method using Stroke 

Opacity. In previous versions of Painter 

this effect was only available using 

layers but now it’s saved as a config 

attribute against your current brush.

2 Paint with Wet Oils
With the Wet Oil brush, try 

lowering Wetness and increasing 

Concentration. This produces thicker 

strokes, ideal for detail work. With low 

Wetness, reduce the Settling Rate to 

achieve semi-transparent washes and 

fringes. For added texture, increase the 

Roughness and Granulation settings. To 

achieve very soft blends increase 

Wetness, decrease Flow Concentration 

and Dry Rate and decrease Opacity. 

3 Blend with Thinners
Real Wet Oils can also simulate 

the addition of pure turps by setting 

Concentration to 0 per cent and 

increasing Wetness and Pickup. Choose 

the Grainy Turps brush and dab it onto 

existing paint. You can control the 

direction and extent of the flow of paint 

with the Wind settings of Angle and 

Force. To simulate turps running down 

the canvas set Angle to 270 degrees 

and Force to 100 per cent.

Step-by-step: Using Real Wet Oil brush variants

Step-by-step: How to save calibration settings for a specific brush
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Painter 12 offers two main ways to add texture to your paintings 

above and beyond the paint ‘flow’ patterns that are inherent in 

some of the traditional media brushes on offer. 

The quickest way to generate texture is to apply a filter to a 

completed image. for example, the apply Surface Texture option, 

found in effects>Surface Control, enables 

you to generate a variety of textures to bake 

onto your canvas. you can also define 

multiple light sources and related attributes, 

such as reflection and exposure. 

however, there are several drawbacks to 

this method. a more flexible and 

convincing alternative is to apply texture  

on a brushstroke-by-brushstroke basis, 

using Papers.

the special effects options

View anD eDit your papers

Work WITh SPeCIaL effeCTS

aDD TexTureS uSIng PaPerS

“Smart Blur removes detail from  

an image while retaining the  

sharp outlines”

very similar, except that the Segment 

attribute is replaced by a Vertical/

Horizontal Plane option.

D. reset kaleidosCope  
Mode
This defaults the current settings. Click 

Toggle Kaleidoscope Mode and reselect 

your brush to continue. 

e. Mirror iCon
In the Kaleidoscope property bar. This 

switches to Mirror mode.

f. kaleidosCope iCon
In the Kaleidoscope property bar. This 

switches to Kaleidoscope mode.

G. toggle kaleidosCope 
Mode
This returns you to normal painting mode.

a. kaleidosCope/Mirror 
iCon in the toolBox
Click and hold to display both options. 

B. Mirror iCon in  
pullout VieW
Displayed by holding down the icon.

c. kaleidosCope iCon  
in pullout VieW
The property bar layout for the 

Kaleidoscope tool. The Mirror layout is 

liBrary
Import a 

.paperlibrary file 

and it appears in the 

Paper Libraries list.

f. export 
paper 
liBrary 
Choose the library 

to export from the 

menu and save it as 

a .paperlibrary file.

c. paper 
liBraries
Toggle the display 

of available libraries.

D. neW paper 
liBrary
By default this  

has your current 

paper choice.

e. iMport 
paper 

a. liBraries
Multiple libraries 

can be displayed, 

each with paper 

preview swatches.

B. paper 
liBrary VieW 
Allows for Small, 

Medium and Large 

Paper swatches, 

plus a List option 

with Paper names. 

G. restore 
deFault 
paper 
liBrary 
Return to a default.

h. Capture 
paper
Create Paper based 

on an image.

i. Make paper 
Create a Paper 

Painter 12 incorporates a number of 

functions that fall outside the range of core 

painting tools. In this section I’ll examine 

two of the main ones you’ll come across: 

Clone Source, which has been enhanced 

from Painter 11, and the new kaleidoscope/

Mirror mode.

another new function that’s worth 

mentioning is Smart blur, which removes 

detail from an image while retaining 

the sharp outlines. open a photograph, 

choose effects>Smart blur and alter the 

intensity using the slider. 

one possible use of Smart blur is as 

a way to produce an instant painting 

from your photographs. however, my 

preference is to apply it to reference photos 

so that when I look at them I’m not 

distracted by unnecessary detail.
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1 Discover the Clone 
Source tool

Clone Source helps you to duplicate 

an image with the paint effect of 

your choice. Load your source image 

and choose File>Clone to create a 

duplicate. Clear the duplicate image 

(Select>All, Edit>Clear, Select>None). 

Choose a brush, say Broad Water 

Brush from Digital Water Color, and 

paint onto the new canvas. Use the 

Toggle Tracing Paper icon and 

Opacity slider if you need to.

1 Applying Paper 
textures

Choose Real Wet Bristle brush from 

Real Watercolor. Set Grain in General 

to 50 per cent. Display the Paper 

panel using Window>Paper Panels> 

Papers. Choose a paper and use the 

sliders to modify Scale, Contrast and 

Brightness. The white areas show 

where the pigment will be most 

concentrated and a good contrast of 

white to black gives the best results.

2 Create your own Papers
Load your texture image and 

select an area using Rectangular 

Selection, or press Ctrl/Cmd+A to select 

everything. Ensure that your texture is 

on the canvas (not layered!) and that 

your Canvas is selected in the Layers 

panel. Click the menu icon top right of 

the Papers panel and choose Capture 

Paper. Name your paper and set the 

Crossfade value, higher equating to 

better tile blending. Save with OK.

3 Generate your  
own textures

You can either source your own texture 

images or use Painter 12 to generate a 

bespoke one. Display the Patterns panel 

using Window>Media Control 

Panels>Patterns. Click the menu top-

right and select Make Fractal Pattern. 

Adjust the settings to suit, monitor the 

results in the preview window and 

choose OK to generate. Repeat Step 2 

to use this texture as a paper.

2 Clone from 
multiple sources 

Click on the Open Source Image icon 

to the bottom left of the Clone Source 

panel and load one or more new 

images. By clicking on the image of your 

choice, you can clone from multiple 

images onto the same canvas. The 

tracing image changes to reflect the 

current source. To return to normal 

painting mode, simply click the Clone 

Color icon to the bottom right of the 

Color panel.

3 Kaleidoscope mode 
This mode is handy for 

everything from painting patterns to 

sketching architecture. Create a new 

canvas and click the Kaleidoscope icon 

in the Toolbox (alternatively, click and 

hold the Mirror icon if it’s not present). 

Adjust the Segment and Rotation 

sliders on the properties bar or drag a 

segment line for ad-hoc rotation.  

Drag the segment intersection to move 

the centre. You can even use it with 

Clone Source.

Step-by-step: Explore the special effect functions

Step-by-step: Apply paper textures and create your own papers and textures

h. segMent 

nuMBer

Type a value in the 

box or use the slider 

to set a value. 

i. rotation 

angle

Type a value in the 

box or use the slider 

to set a value. 

J. syMMetry 

plane Color

Set the colour of 

your guidelines. 

K. toggle 

planes

Make the guidelines 

visible or invisible.

based on the 

procedural 

parameters Pattern, 

Spacing and Angle.

J. shoW 

paper 

Controls

Show the panel for 

the current Paper.

K. delete 

paper

Removes a Paper 

from a library. Hide 

a Paper by right-

clicking>Hide Paper.
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Painter 12 organises its brushes into 

Libraries, Categories and variants. a Library 

can hold many Categories, such as Chalk 

and oils, and a Category can hold many 

variants (brush configurations). While 

Category and variant operations are mostly 

accessed through the workspace, creating a 

new Library requires a visit to your 

computer’s file system. 

get started by creating a new folder 

under brushes in the Painter 12 application 

area. This is your new Library folder. In this 

folder create another folder for your 

Category, plus an identically named 30x30 

JPg for your Category. Into your Category 

folder, copy one or more brush xML files 

from the Painter 12 brushes Category 

folders. Close and restart Painter.

navIgaTIon anD WorkfLoW hInTS

geTTIng To grIPS WITh bruSh baSICS

Whatever your artistic style, you’ll likely to 

make extensive use of Painter 12’s 

navigation and colour selection techniques. 

of course, functions such as panning, 

zooming and colour choice are common 

across all painting packages, but when 

you’re using them hundreds of times per 

session it’s their implementation and ease 

of use that makes all the difference. 

In this section I’ll look at how the new 

navigator panel consolidates several 

workflow functions into one intuitive 

interface, and how the Temporal Colors 

palette can be used as a speedy alternative 

to the Color Wheel. Don’t forget that 

Painter also offers customisable keys: press 

options for these functions, configured 

through edit>Preferences>Customize keys.

“When you’re using panning, 

zooming and colour choice hundreds 

of times per session their ease of use 

makes all the difference”

“Category and Variant operations 

are accessed through the workspace, 

but creating a new Library requires a 

visit to your computer’s file system”

View your artworK

a. Brush seleCtor

Click the arrowhead to expand.

B. reCent Brushes

a. preVieW 

iMage

Change size by 

dragging the 

edges/corner of the 

Navigator panel.

B. naVigator 

FraMe

The portion of the 

image in view.

c. naVigator 

options

Drawing modes, 

colour management 

and grid toggle.

D. reset 

zooM

Set to 100 per cent.

D. Variants

Brush Variant list 

and/or icons.

e. daB and 

stroke 

preVieW

Hover for a preview.

f. Brush 

seleCtor 

Menu

G. display 

toggles

h. display 

options

Choose either List 

or Icon format.

i. Capture 

tools

Capture Dab 

redefines the Brush 

c. Categories

Displays the Brush 

Category list and/ 

or icons.

e. zooM 

Controls

Type a value into 

the Zoom Canvas 

box or click the 

drop-down and 

drag. Use Zoom In 

and Zoom Out to 

zoom in stages.

f. reset 

rotation

Sets canvas rotation 

to 0 degrees.

G. rotate 

CanVas

Type in a rotation 

value or click  

and drag the  

drop-down menu.

shape. Capture Brush 

Category creates a 

new Brush Category.

J. Brush 

liBrary Menu

K. Variant 

options

Includes Save Variant, 

Set Default Variant 

and Delete.

l. Copy 

Variant

Copies the current 

Variant to a  

new Category.

m. restore 

options

Restores default 

Variant settings. 

Alternatively, right-

click a Variant icon.

manaGinG Brushes
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1 Navigating the 
Painter canvas

Display the Navigator panel using 

Window>Navigator and load a large 

image. The red rectangle highlights 

the area being displayed. Drag the 

rectangle or click outside it to shift 

focus. Resize the preview image by 

dragging the edges or bottom right-

hand corner of the panel. Experiment 

with the zoom and rotate controls 

below the preview image.

1 Creating Variants and 
Categories

There’s no New Brush function in 

Painter so instead select Save Variant 

from the Brush Selector menu. This 

saves your current Brush configuration 

to a new Variant, which you can now 

name and configure. To create a new 

Category, paint something and select it 

using the Rectangular Selection tool 

(Shift+drag to constrain). Then choose 

Capture Brush Category from the Brush 

Selector menu.

2 Remembering your 
brushes

At the top of the Brush Selector menu 

you’ll find Recent Brushes and Dab  

and Stroke Preview. Recent Brushes 

keeps a record of the brushes you’ve 

already used, in reverse chronological 

order, across the top of the Brush 

Selector. You can also access them 

using Window>Recent Brushes. Dab 

and Stroke Preview displays brushstroke 

previews as you hover over each  

Brush Variant.

3 Using Dynamic  
Brush Attributes

Press and hold Ctrl+Alt (Cmd+Opt on 

the Mac) and drag the cursor to alter the 

Size of your brush. Maintain pen 

pressure but release the keys. Now 

press Ctrl (Cmd) and drag the cursor to 

alter Opacity. Press Ctrl (Cmd) again to 

control Squeeze and press a fourth  

time to control Angle, all the while 

maintaining pen pressure and dragging 

as necessary. Release pen pressure to 

start painting.  

2 Zoom quality and 
performance

Click the Magnifier tool on the Toolbar. 

To the right of the Property bar appear 

two new icons. Click Area Averaging 

(right) to speed up drawing when 

zoomed out. Click High Quality Display 

(left) to soften pixels when zoomed in, 

which gives an indication of how your 

image might look when printed. Neither 

of these affect your actual image, only 

how you view it.

3 Temporal Colors 
palette

Display the Temporal Colors palette 

using Ctrl+Alt+1 (Cmd+Opt+1 on the 

Mac). Resize the palette by dragging 

on the very edge of the circle and 

move it by dragging the inner 

transparent area. Select Saturation 

and Value from the inner triangle and 

Hue from the outer ring. Press the 

same key(s) to make the palette 

disappear, or just resume painting.

Step-by-step: Using the Navigator panel and Temporal Colors palette

Step-by-step: How to create Variants and Categories

h. CanVas 

inFo

Displays image 

width and height in 

pixels, plus PPI 

(Pixels Per Inch)  

for printing.

i. Cursor and 

seleCtion 

inFo

The top section 

displays the cursor 

position when in a 

selection mode, and 

the lower section 

displays the size of 

selected area.

J. naVigator 

Menu

Use to toggle the 

visibility of the 

Navigator Frame.
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artists
panel

Brynn Metheney
Raised in the High Desert of 

California, Brynn has a passion 

for creature and world design. 

Her clients include Dark Horse 

and Wizards of the Coast.

www.brynnart.com

Kinman Chan
Kinman studied at Gnomon 

School of Visual Effects, and 

has worked for Disney and 

Lucasfilm. He also owns 

Kincept Co.

www.sparetimer.blogspot.com

Jace Wallace
Jace has freelanced for 

magazines, book publishers 

and has produced concept  

art for many video games, 

including The Sims 3.

www.wakkawa.cghub.com

Raymond Swanland
You’ll recognise Raymond’s 

work from the Oddworld 

video games. A leading 

concept artist, Raymond is 

always in demand.

www.raymondswanland.com

Jon Hodgson
An experienced artist who has 

over 50 book covers to his 

name, Jon has an enviable CV.  

He is currently the art director 

on the Dr Who card game.

www.jonhodgson.com

Paco Rico Torres
Paco is a freelance illustrator 

living in Spain who’s produced 

art for several card games, 

magazines, books and 

roleplaying games.

www.pacorico.blogspot.com

Francesco Lorenzetti
A freelance video game 

concept artist living in the 

North of England, Francesco 

loves painting creatures and 

emotive environments.

francescolorenzetti.blogspot.com

Kev Crossley
Long standing comic artist 

Kev has worked for 2000AD 

amongst other titles, drawing 

Judge Dredd. He’s currently 

freelancing.  

www.kevcrossley.com

Elizabeth Torque
An illustrator and concept 

artist residing in Spain, 

Elizabeth has worked for 

many American publishers 

such as DC, Image and IDW.

elizabethtorqueart.blogspot.com

Cynthia Sheppard
A freelance fantasy artist with 

a background in traditional 

painting, Cynthia likes to bring 

classical techniques to her 

digital art.

www.sheppard-arts.com

Jonathan Standing
Jonathan Standing is a 

concept artist based in 

Toronto. He’s currently 

working on the TV series 

Defiance for SyFy.

www.jonathanstanding.com

Manon Delacroix
Manon is a busy freelance 

illustrator who specialises in 

high fantasy, horror and 

portraiture. Werewolves are 

her personal favourite.

www.artbymanon.com

Mark Molnar
Mark is a concept and visual 

development artist. He’s busy 

doing freelance work for 

international film, game and 

animation companies.

www.markmolnar.com

Nick Harris
Gloucestershire-based Nick 

went digital in 2000 after 18 

years working with traditional 

methods. He works mainly on 

children’s book illustrations.

www.nickillius.com

Silhouette is the  

most characteristic  

visual element in every  

person or animal. 

Mark Molnar
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Core skills

easy ways  
to create 
creatures
Learn the core skills to paint better monsters, including rendering a  
dragon’s fiery breath and planning a creature’s twisting neck. 

TuRN ovER To STaRT PaiNTiNg MoNSTERS

Contents | Creatures
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download

your fileS

Accessing your workshop files 

Click or copy and paste the above link into a 

browser to download the files to a 

desktop PC or Mac. Do the same to 

watch videos where seen. 

link  
www.bit.ly/ifz12-creat

  



Artist’s advice
Brynn says

Painting the gruesome scene of 

a hunter consuming its prey can 

seem tricky. Depending on 

what you’re going for, the key is 

to keep it looking natural – as if this is the 

way the predators have always eaten. 

Naturally, any reference you can gather will 

help you in creating the scene. Another 

important aspect of this piece relates to the 

tooth structure of the carnivore. This will 

always affect how the creature uses its 

mouth to process its food. 

In my painting, you can see two ways of 

processing the flesh. Depending on what 

type of predator you’re painting, the way 

the creature handles its meal will differ 

between mouth shapes and teeth. When 

beginning this painting, I sketched in a 

pencil layer to figure out how the flesh of 

the carcass would move around. As you can 

see, the two pieces of flesh act differently 

depending on how they’re being eaten. 

Once I figure out the acting of the 

carnivores and the composition of the 

piece, I’m then able to start laying in colour. 

I lay in the flesh tone and skin layer of the 

carcass. It’s important to remember that 

flesh and muscle aren’t always completely 

blood-soaked, either. I lay in a base, then I 

rough in darks and lights. I keep any blood 

on a separate layer, so I can edit it easily if 

I need to. Once I have the flesh and blood 

figured out, I can begin to lay in highlights 

to give it the feeling of being wet. 

Comparing the flesh to 

putty or clay can help 

you determine how it 

will react to being 

pulled and sheared 

away from a carcass. 

The best way to…
paint a scene of a carnivorous creature  

tearing the flesh from its prey

Step-by-step:
Paint a predator 
devouring  
its catch

1  As you can see, I begin 

by laying in simple colour, 

gradually building up the 

volumes as I go along. Using 

this technique will help me to 

see which direction the flesh is 

moving in and where I need to 

add highlights and shadows 

later on in the process. Once I’m 

happy with that, I do the same 

with the predators.

2  As I build up the flesh, I’m 

careful to keep the idea 

of motion in mind. The flesh 

that’s being pulled and 

stretched by the predator 

should be painted with brush 

strokes that enhance that 

movement. I also begin to add 

blood at this point, keeping it 

on a different layer so that it’s 

easy for me to alter at a later 

stage if necessary.

3   When you’re painting 

the flesh in your scene, 

it’s important to keep in mind 

the layers of fat that are found 

between the creature’s skin and 

muscle. I’ve now laid in 

highlights and shadows to give 

the flesh and the predators 

more volume. The highlights 

also help to make the flesh and 

blood look wet.
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Artist’s secret
Using directional 

marks 

When using a program such as ArtRage that 

offers heavy impasto, or rake brushes in Painter 

or Photoshop, maximise their form-describing 

qualities by making marks that look as if they 

follow the shape of what they describe.

This troll’s anatomy is wildly 

unrealistic, but retains believability 

through stretching the rules of 

anatomy rather than breaking them.

How you can…
draw a muscular, 

oversized troll

Use this easy way to…
give a bat’s ears  

a translucent look 

Artist’s advice
Jon says

The challenge when drawing a big muscular 

monster is marrying the fantastical elements with a 

level of believability. It’s no good just inflating the 

arms of a human, nor wildly inventing anatomy 

with no reference to the human body. So you have to think 

holistically about the task.

We want the creature to have a threatening presence, so huge 

arms is a must: bulging shoulders, biceps, meaty forearms, great 

big hands all signify the creature’s ability to do damage. For 

these to be convincing the rest of the creature needs to be 

similarly bulky. We can get creative and merge various muscle 

groups into huge slabs of muscle across the shoulders and chest, 

bulking up the upper body hugely, and adding to the idea this 

dude spends a lot of time crushing things. And all that weight of 

muscle brings our creature forward into a stoop, unlike a lithe 

human who looks light on their feet, ready to spring in any 

direction. A tilt of the trolls shoulders and hips gives the feeling 

of plodding, thundering steps.

A small head brings character too, as do tiny eyes. It’s not just 

a matter of making muscles larger – reducing the size of other 

characteristics really helps, too.
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I begin by laying in basic 

colour before blending the 

hues together to give the 

image a smoother look. 

The lighter areas will 

appear more translucent.

keep the middle of the ear the lightest 

shade. The thinnest part of it will be the 

most translucent, while the thicker parts, 

such as the folds, will be darker. Keeping 

the middle of the ear light pink and fading 

it to orange gives it a translucent look. For 

the finishing touch, I add some almost-

white light pink to really push the feeling  

of it being thin skin. 

The next step is to work on a separate 

layer and add some red veins, because they 

would show up when the ear is illuminated. 

Finally, some white highlights around  

the edges hint that light is coming from 

behind the ears.

Artist’s advice
Brynn says

Reference will be your friend 

in this case. Looking at 

different animal ears with 

backlighting will inform 

your work better than anything. 

You could start by modelling a small 

ear out of Sculpey clay and then lighting 

it from behind. It’s important to 

remember that the bat ear is thin, but it’s 

also filled with blood. When light 

shines through flesh it tends to glow 

with orange and red hues. 

I start my painting with a pencil 

drawing to grasp the anatomy of the ear. 

Next, I move into colour, making sure to 

  



Artist’s advice
Francesco says

For a three-point perspective 

you need two points on the 

horizon and one on the vertical 

axis. Convert straight lines from 

any intersecting point and our grid is ready. 

With a creature this size we tend to keep 

it simple. As a trick for huge objects with 

spatial dimensions, I like to imagine being 

a bee exploring a forest or building and 

imagine how huge these structures seem. 

To paint this huge creature I used a tuber as 

reference (a bulb in the centre of a main 

root and a bud that grows upwards). I then 

make her more fleshy and scary.

Artist’s advice
Paco says

Designing a futuristic pet is 

like concepting any other 

kind of character. First, 

consider the world that 

surrounds it. If we’re talking about a 

cold, industrialised future where 

animals and plants are almost extinct, 

then perhaps pets are cheap-looking 

robots. If in the future mankind has 

pushed the boundaries of scientific 

achievement then pets could be 

Artist’s advice
Brynn says

The task of drawing imaginary creatures can be 

much simpler if you break them down into basic 

shapes. Thinking about complex structures in a 

planar view can help you to see them simply and 

keep you from feeling overwhelmed. 

Of course, when tackling the details, such as an imagined 

canine-type jaw, it’s always a good idea to study the canine 

skull itself and use references. Books, photos, the zoo and 

actual bones can give you a feel of what a jaw would look like 

at different angles. Taking my example and looking at canines, 

watching them yawn, snarl and pant will help with expression. 

For my two creatures pictured here, I sketch out their heads 

using box shapes. This helps with the perspective of the jaws, as 

well as the positioning of the eyes and teeth. After I’ve sketched 

in the boxes, I add in definition such as fur, eyes, teeth and ears. 

I always sketch things in lightly (on separate layers) so I can 

easily move things around to make sure the proportions are 

right. It’s always a good idea to keep your shape sketch handy to 

refer back to while you’re working.

Even if it is imaginary, your animal should still have believable anatomy. If you find you are getting lost, 

then try copying different animal parts, and then mix them to create one creature. 

How to…
easily draw your own 
imaginary creatures

Learn an easy way to…
paint a pet character  

from the future

An easy way to…
paint an organic creature using  

three-point perspective 

genetically engineered creatures. Perhaps 

people own animals from other planets,  

or maybe they simply have dogs and  

cats… who knows! 

The key is to spend some time on the 

backstory before you start painting. Think 

of a design that makes sense in the world 

that you’ve imagined for it, which makes 

sense from an anatomical point of view  

and with features that could match those  

of their owner’s.
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Here you can see a rough box 

sketched over the creature’s 

jaws. This will keep me on track 

with shape, perspective and 

placement of other features. 

  



Artist’s secret
set layer to mUltiply

Colour added to a Multiply layer above a line 

drawing is useful as it enables the drawing to 

show through. The layer can then be duplicated 

and amended easily if colour variations or  

styles are required, while preserving the line art.

Step-by-step: Using three-point perspective

1  I start to insert a picture of the 

environment as a background, so  

I have a good starting point as regards 

colours and composition. Then I compose 

the three-point perspective grid and a  

new layer on top to draw the creature 

laying on the grid.

3  I continue to paint over the scene by 

changing the tail of the creature. I 

add a bit of atmosphere, modify the land 

and give our beast a more meaty tone to 

define the anatomy better. Remember, 

things that are in the distance tend to be 

desaturated colour and have a lighter tone.

2 I begin to paint over the line drawing, 

trying to have a good balance with 

values to create convincing depth. Clouds 

are always a good way to make the sky 

more of an interesting space. Remember 

this is an early stage so don’t worry about 

changing shapes, colours and design.

Artist’s advice
Kev says

When I’m preparing concept 

sketches for a video game, 

movie or comic, the resulting 

thumbnails are small, 

numerous and can be quite sketchy and 

rough. The best approach is to attack them 

quickly, without too much emphasis on 

adding any polish. Thumbnails must 

communicate ideas efficiently; polished 

presentation is a secondary consideration!

I scan a pencil thumbnail of a monster 

head into Photoshop, then create a layer 

above it with the mode set to Multiply. Into 

this layer I quickly paint a base colour of 

mid-brown using a soft brush with 70 per 

cent Opacity. A darker, reddish shade is 

used to add depth to the shadowed areas. 

This stage takes a few minutes and results in 

Discover the best way to…
paint over existing

thumbnails

a tonal base painting. Next, onto the same 

layer I paint an unhealthy green over the 

head, describing the skin tone but retaining 

the darker areas. The colour is applied 

quickly with a medium-sized, medium-

opacity soft brush, without too much 

thought for keeping inside the lines. Speed 

and spontaneity are important here! 

A touch of scarlet is painted into and 

around the mouth and teeth, but I allow 

the brush to trail scratchy veins over the 

skin, adding freeform spatters and spots 

as I go. A little pink is added to bolster the 

red and add depth to the green of the skin, 

before a pale, greyish yellow is used to pick 

out the teeth and the lighter areas of skin. 

Finally, little spots of near-white pick out 

the highlights.
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The loose and lively 

nature of the thumbnail 

is preserved and 

complemented by 

the application of colour 

tones and highlights 

using quick, expressive 

brush strokes.

  



Artist’s advice
Elizabeth says

Before launching into a sketch 

of my character, whether 

human or animal, I try to 

collect and study a huge 

amount of reference material first – both 

photographs and video. This is necessary to 

understand the forms and movements of 

the character I’ll draw. Eventually the forms 

can become exaggerated, and not resemble 

the reference material at all, but it’s good to 

start from a realistic image.

When we talk about dragons or unicorns, 

we don’t really need to think about the 

fantasy element of what we’re drawing. It’s 

right there staring back at you. But when 

depicting a more common animal tinged 

with fantasy – a bear in this case – then it’s 

useful to weigh up the specific fantasy 

elements that you’re going to add to the 

illustration first.

If I have the time, I like to read books on 

mythology and folklore, or get inspiration 

from the Greek gods, Celtic songs, or 

legends about Indian shamans and their 

totem shields. Delving into the past, I find 

that for many Native American tribes the 

bear is a sign of courage, wisdom, intuition 

and special powers. That’s a great element 

to incorporate into our fantasy bear.

I like working with Photoshop because it 

enables me to quickly capture many ideas 

and change my sketches as much as I want 

– much the same as with inking and colour. 

So here we go!

Visual references 

combined with 

mythology and 

folklore sources  

will help you paint  

a real-life beast in  

a fantasy setting.

The best way to…
paint a fantasy bear, yet keep  

its realistic look

1   I draw a quick outline 

shape to understand the 

perspective, the body shape, 

lights and shadows. This is a 

skeleton made with simple 

lines. Importantly, the cross is 

in the centre of the head and in 

the chest. Exaggerating the 

peculiarities of the bear make it 

a more appealing creature: I 

give it a huge round head, a 

large hump and rounded, very 

strong-looking arms.

2   Now I can comfortably 

draw on the skeleton of 

the bear. I define the details 

and I think about giving the 

beast a companion. A small, 

thin human makes the bear 

look even more stunning and 

overwhelming. It also tells us 

that the beast is smarter than 

the average bear, it’s loyal to 

the human character and 

serves as a guardian, or 

perhaps a fellow soldier.

3  Now I start to colour the 

bear. For the fur I add a 

line of dark colour, then some 

lighter colour on top (1). I 

apply reflections of sunlight  

on the head and shoulders, 

before then adding green 

reflections from the water and 

surrounding vegetation (2). 

Finally, I paint in a flash of light 

green in the eyes to create a 

magic link between the 

Shaman and the bear (3). 

4  Now it’s time to detail 

the scene. In the palm of 

the Shaman’s hand we see a 

magic glow, like the bear’s eyes 

(1). This also connects with the 

bear head on top of the 

Shaman’s staff (2). She wears 

clothes that mimic the bear’s 

fur, on her arms, legs, neck and 

shoulders (3). To finish,  

I draw splashes of water to 

suggest the bear’s forward 

progress with heavy steps (4).

3

2 1

Step-by-step: The bear necessities

3

4

2

1
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An easy way to…
use Photoshop to depict blood  

in the ocean depths

Learn to… 
set up a light source and judge 

how it’ll turn out

Artist’s advice
Cynthia says

Unlike putting a single 

droplet of red blood into 

a shallow glass, blood on 

a large scale deep 

underwater behaves more like a 

black cumulus cloud. 

Our perception of colour 

drastically changes as we dive down 

into the ocean. Light waves become 

absorbed by water, and so hues lose 

their intensity the deeper you go, 

starting with the longest waves in 

the visible spectrum, which are the 

reds. In contrast, blues and greens 

transmit much better through water 

because they have shorter 

wavelengths. In simpler terms, what 

this means is that red blood may 

look black or grey, while the water 

itself and the creatures in it are still 

highly saturated blue.

Blood is also more viscous than 

water, and so once it’s pumped out of 

a wound, it tends to hover around 

the source in a sort of cloud 

formation. Think of the mass of the 

blood as looking like a puffy cloud 

in the sky, but with a spout where 

the liquid is gushing out. The trick is 

to keep the edges sharper near the 

wound, then gradually soften the 

cloud as the blood is dispersed.

Artist’s advice
Jonathan says

The simple answer is to 

make, or find some 

reference material. Even 

if you’re not necessarily 

making something realistic and  

are trying for a more stylised effect, 

you can always choose to omit 

information that you get from 

reference, but generally, it makes 

your work stronger. 

In this case, there’s no way for me 

to get a forest spirit (they’re 

fictional) to stand over some fire on 

a gloomy day (it’s hazardous). So 

instead I try to approximate the 

lighting I need for my image. As 

sci-fi or fantasy artists, it’s often 

hard to find material that looks 

exactly like what you wish to create, 

so finding or making similar 

imagery can be helpful.

I already have a good idea of what 

the overall lighting scheme will 

look like. Overcast sunlight is 

relatively easy to render; it gives you 

nicely diffused shadows and little 

deviation in terms of an object’s 

local colour. What I need to find out 

is how to integrate fire into the 

scene. With a dressed maquette and 

an ash bucket containing burning 

newspaper, I’m able to get some 

particularly useful information.

I’ve added details that 

weren’t in my reference, 

but the key elements 

are here; cool colours 

contrasting with warm.

1  Set up your scene on a 

blue ground, to provide 

an accurate underwater 

backdrop. Position the sea 

monster and its attacker where 

there’s enough room for the 

blood to seep out without 

engulfing your hero. Add a 

dark hole or gash where the 

hero has wounded the monster.

2   I’ve chosen a very dark 

blue-violet for the main 

mass of the cloud of blood. The 

temptation is to use a dark red, 

but even when it’s very dark, 

red hues still look unnatural. 

Blue-violet, on the other hand, 

adds just enough warmth 

without being too far outside 

the visible spectrum.

3  Finally, add some details. I’ve gently applied some grey 

tendrils leading to the weapon; even though grey is neutral 

on its own, it appears warm against blue. I’ve also added some 

dim highlights to the top of the blood mass, and a cast shadow 

on the sea monster’s tentacle.

Step-by-step: A wounded sea beast

Artist’s secret

making edUcated 

gUesses

The foundation I established with 

the forest spirit and flame carried 

over into the siege tower and 

burning arrows. Once you have the 

big colours and tones knocked in, it 

becomes progressively easier to judge 

how other materials would react to 

your light source.
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Remember where your 

light source is coming 

from – you can draw 

arrows on a different 

layer to help remind you. 

This comes in handy  

if there’s more than  

one light source.

Artist’s advice
Manon says

Part of what makes a shadow dynamic is that it 

enables you to be selective about what you conceal 

and what you reveal to the viewer. The imagination 

will fill in the gaps if some things aren’t crystal 

clear. Even if you’re only planning to show parts of your  

subject in the light, you must paint all of it in the sketch stage. 

You can still decide at a later date what to keep and what you 

want to lose – in the shadow.

Think about what you want to show or emphasise and how 

you want the viewer to feel when they look at your image.  

Do you want it to be creepy or do you want them to be 

enchanted? Always try to set up your own photo reference, 

especially for playing around with shadow. Ask your friends  

to help you out!

I decide to have my werewolf looming out of the dark. He’s 

very proud of what he’s found. He’s probably wagging his tail…

How you can…
create dynamic and 
interesting shadows 

Artist’s advice
Brynn says

 Starting out with a wire frame 

or skeleton of your animal 

will help you to get things in 

place without worrying about 

the details. Here, you should simply look 

to get the proportions and simple shapes 

of your animal in balance, drawing over 

the rear of the animal to make the 

foreshortening aspect easier.

Next, I usually rough in some very 

basic musculature. It doesn’t have to be 

correct at this point – I just want to get in 

my large shapes to see where everything 

should be, including the animal’s bulk. 

Don’t go too crazy here, and ensure that 

you follow the rules as dictated by your 

chosen skeletal structure.

The last stage is where I hit the anatomy 

books to check that my anatomy is in 

line. For fictional creatures, I just want to 

make sure that it looks convincing and 

informed. Understanding how real 

animals are made and move, however,  

is the best education that you can get  

for ensuring your imagined creature  

looks real.

The best way to…
show an animal  
running head-on

Artist’s secret
take a sideways look

Sometimes drawing the animal in the same 

position from a side view can help with 

visualising it at a frontal aspect. By using some simple drawing techniques, we 

can lay the foundations for an animal walking 

head-on towards the viewer. 
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What you reveal will 

determine how the 

viewer feels when  

they look at your art. 

  



Artist’s advice
Paco says

To paint a creature coming out 

from the shadows, the only 

thing you need – and this may 

sound contradictory – is a 

source of light. If there’s no light then the 

creature can’t come out of the darkness! 

You need to illuminate the scene in such a 

way that you end up having a clearly 

defined area of light surrounded by 

shadow. Or you can do the opposite and 

paint an area of shadow surrounded by 

light, such as a dark alley that’s next to a  

well-illuminated street.

In either case, the aim is to create a  

scene where the creature can exit from  

the shadows. Think of shadows as a wall 

made of dark water: you have to determine 

how much of the creature’s body is going to 

be outside of that wall and how much will 

stay within. The parts within should be 

black, but the parts outside should be 

affected by light, just like anything else  

in the scene. To create a scary atmosphere 

try painting a hard illumination with 

projected shadows.

An easy way to…
paint a creature emerging from the  

dark without it being blurry

Step-by-step:
Depict horror  
in the shadows

1  First, I imagine the image 

I want to paint. Once I 

have a draft of the painting, I 

determine how much of the 

creature will be in the light area. 

I create an imaginary wall of 

darkness, which works as a 

barrier between light and 

shadow. Everything behind that 

wall won’t be particularly 

visible, so don’t worry about it.

2  I imagine a light source 

for the parts outside the 

darkness. I want a hard light 

coming from above, such as 

moonlight coming from a 

window in the ceiling, so the 

brow, nose and fingers are 

illuminated. Projected shadows 

should hide the mouth and eyes, 

at least partially. References can 

be useful for shadows.

3  Once you have the 

shadows sorted out, you 

can start painting. For artwork 

that features a complex lighting 

scheme, planning becomes 

very important. You’ll save a lot 

of time and produce a better 

piece of art. Don’t be afraid to 

use references: a camera, 

mirror and desk lamp can be 

your best friends.

Artist’s secret
the reflected light

Even a creature of the shadows reflects some light. To achieve a more 

natural atmosphere don’t paint the background next to an illuminated 

area totally black. Add a light colour to represent the light reflected by  

the creature (using blurred low Opacity layers in soft light, Overlay and/

or Screen modes).

Core skills | Creatures
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 I block in the whole silhouette with a simple 
default Round brush. I try to focus on the 
dynamism of the creature. I want it to resemble a 
humanoid shape from afar, but also give the feel 
of constant movement through its tentacles.

I wanted to give the 
fleet commander of a 
war-like alien race 
some military armour, 
but instead of a bulky 
protective suit I wanted 
something more sleek, 
to show his rank. 

Artist’s advice
Mark says

It’s tricky to paint eye-catching, futuristic armour 

that also looks believable in its own universe. I’ve 

found that it helps to think through the story of an 

armour and add different surface qualities to various 

parts, rather than use a shiny, just-came-out-from-the-factory 

chrome material for every surface.

Even really precious objects have some minor scratches, 

stains or fingerprints on them. We have to handle futuristic 

things in the same way. Boba Fett’s armour from the Star Wars 

films may be the best example: it looks futuristic, but we can 

instantly see that it’s been through plenty of battles. The best 

approach is to first focus on the general form and language of 

the armour, and then add wear and tear to the surfaces.

In this case I had already worked on this universe for quite 

some time, so I had to follow the established visual aesthetic, 

but also create something unique and new. That’s why I chose  

to depict armour that was more ceremonial than practical. After 

all, why would a fleet commander need a huge suit of armour?  

I imagine that he has to wear this every day, so I add stains, dust 

and scratches to the edges and other parts to suggest that the suit 

is made from a hi-tech material and has been in use for years. 

The best way to…
avoid sci-fi clichés when 
painting alien armour

Artist’s advice
Mark says

In my professional work I use 

both techniques to develop a 

successful design. For example, 

to produce line work sketches 

it’s really useful for industrial design-related 

tasks, such as vehicles, spaceships, mechs 

and so on. The two approaches work well 

for either fine detailing or figuring out the 

proper anatomy of a final character design 

for production purposes – for example, 

when creating a reference for 3D modellers.

I start with silhouettes if I have to create 

an iconic and recognisable creature or 

character without having to worry too 

much about the technical limitations of a 

production. This usually happens when I’m 

working on a pitch package.

Silhouette is the most characteristic 

visual element in every person or animal, 

because our eyes see that first before 

moving on to the face, hands and finally to 

the smaller details. The most successful 

animation or film characters have iconic 

silhouettes – that’s how we can instantly 

differentiate them from others, even in a 

badly lit scene. Think about Mickey Mouse, 

Batman or even Stewie Griffin.

I start this creature design as a demo  

for my students, in which we have to 

develop a fictional pitch package for a 

horror film. I’m keen to create a scary, 

unique-looking monster, but I don’t 

want to give it a straightforward 

humanoid shape. Instead, I imagine a 

mass of old root-like tentacles that are 

constantly in motion. 

I’m aware that in horror films or 

games there can be a lot of under-lit 

environments in which my creature 

would have to stand out. I want it to be 

recognisable, even if we see only parts 

of it in a shot. That’s why I start by 

developing a dynamic silhouette and 

then build all the details on top. I retain 

the original silhouette and simply 

refine it during the detailing process.

The initial humanoid 
silhouette is enhanced 
by the tentacle details.

How you should…
start from a silhouette, as  

opposed to greyscale/sketches
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Using various materials in your illustration 
not only helps to give more details to a 
piece, but could also make it more 
believable and realistic in its own universe.
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To create the slime I apply 

some dark colour to the 

edges, keep the middle 

transparent (or extend the 

colour of the reflection) 

and add a white spot.

Master an easy way to…
paint slimy skin on your creature design

Artist’s advice
Paco says

Painting shiny and slimy skin for an octopus, or any 

other kind of slimy creature, isn’t a difficult task – if 

you spend some time gathering references, that is.  

A polished and smooth surface causes something 

called specular reflection. This means that light is reflected and 

bounces off in the same direction, casting reflections on the 

surface, just like a mirror.

The skin of a slimy creature isn’t exactly like a mirror, but it has 

a considerable level of specular reflection, so the brightest sources 

of light, the nearest objects and the surrounding colours should be 

at least partially reflected. Properly depicting the reflections is the 

key to success here. 

It’s not too complex a topic, but if you’re not used to it then it 

can be tricky to pull off with a degree of success. That’s why 

gathering some visual references, such as photos of octopuses, 

shiny latex and polished statues, can be a great help. Not only to 

paint a particular image but to increase your painting skills by 

studying real-life examples.

Other than that, you have to figure out how something is 

reflected on an irregular shaped surface. Try to imagine the source 

of light, and place the reflections following some logic. So for 

example, if the light source is a light bulb on the left of the 

octopus, don’t paint a window-shaped reflection on the right. 

Paint them to accommodate the curves and shapes of the creature, 

and paint them with the right amount of luminous intensity. 

Step-by-step: Paint a shiny, reflecting surface

Painting a slimy, shiny skin is 

easy if you paint in a clean and 

organised way, and you gather 

information and references 

before you start working.

different skins, 
different reflections

If you’re painting a creature with a smooth 

skin, its reflections should also be smooth. If 

you want to paint a creature with harsh skin, 

don’t forget to modify the reflections according 

to the kind of skin that you’re painting.

1  First of all, I paint the slimy creature 

dry and matte. I simply focus on 

depicting its shape, colours, texture, 

illumination and so forth. Then I start to 

work on the reflections. I imagine an 

intense light source 

on the upper left 

(like the sun coming 

through a hole in the 

ceiling), so the 

reflections should be 

bright and more 

intense on the left.

2  Once I have an idea of what I’m 

looking for, I start to paint the 

reflections. I paint them in a separate layer, 

with a Hard and Opaque brush, because 

the reflections should have clean and 

sharp edges. I bend 

them following the 

curvatures of the 

head, the tentacles, 

all the while trying to 

create fluid and 

coherent shapes on 

the canvas. 

3  Then I select all those reflections, 

lower their Opacity, and in further 

layers add more nuances (all inside the 

selection, to preserve the hard edges). I  

try to work using layers in Screen mode, 

because then I won’t 

hide all the previous 

work – the skin of the 

creature – and can 

correct elements 

using dark colours, 

which is easier than 

applying the Eraser.

Artist’s secret

Core skills | Creatures
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Artist’s advice
Jace says

The fantastic thing about 

painting a feathered dragon 

is that feathers are very 

similar in structure to 

scales. Feathers and scales are both 

typically round-diamond shapes that 

overlap each other in an offset manner. 

One problem with painting scales is 

that they can become a bit repetitive 

and so create a lot of visual noise.

As dragons are traditionally flying 

reptiles, the first thing I do is find 

reference pictures of alligators and large 

birds. Alligators are great as reference 

Artist’s advice
Kinman says

It’s important to consider all 

the different elements that 

are involved. We’ll need a 

non-light (A) to represent 

anything that’s not coming from the 

light source itself, or being affected  

by any surrounding lights. Then there’s 

the light source itself (B). Notice how 

the brightness affects the textures 

immediately around it, such as the  

glass in this case. We’ll also require a 

translucent material (C) to represent a 

membrane or skin that the source may 

be shining through. When we place 

subjects because they have many different 

types of textures that make up their skin. 

The face of an alligator is generally smooth, 

while their backs become rougher with 

larger, spiky scales. This is similar to the 

feathers of large birds as well: they have 

small feathers in the face with large 

crowning feathers on the back of the head. 

Now all I have to do is visualise how the 

feathers and scales will transition. A 

simple solution is to have the feathers 

emerge from underneath the scales, 

starting small and growing in size the 

denser the feathers become.

this type of material in front of the source, 

it’ll tend to diffuse and blur any details.

Denser material, such as a bone, may be 

blocking the light (D). Since it’s fairly close 

to the light source, the bloom from the light 

may refract through the object, and the 

denser and/or larger the object is, the less 

this will happen. In CG terms this is known 

as ‘subsurface scattering’. 

Finally, we need to consider any objects 

that may be in proximity to the light source, 

but not as close as the other elements (E).  

I might treat these as I would lighting any 

simple cylinder, box or sphere.

Painting each 

material as a separate 

exercise will help the 

problem solving 

process, and 

ultimately result in 

understanding the 

whole picture.

Once the materials 

are fully understood, 

the design of the 

character, proper 

perspective drawing, 

and painting can be 

applied to combine 

the elements.

How you can…
paint a humorous vampire 
scene that’s not a cartoon 

An easy way to…
paint an object that’s  

bursting with bright light

The best way to…
draw a dragon with scales and 

feathers, without it looking messy
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Artist’s advice
Nick says

The range of interpretation for vampires and their 

tales is broader today than ever – from hypnotic 

Dracula, through ravaging beasts, to tortured souls 

fighting their own kind. Humour and horror go 

hand in hand in many modern takes on the tale. There’s no 

need to drift into cartoon representation here. The genre is ripe 

for humorous twists.

 Sense of humour is a personal thing, but if you can find the 

right combination of situation, character and pose/facial 

expression to suit your brand of humour, you can usually make 

an image work for laughs. First decide what elements are 

essential ingredients to explain what’s going on.

Although I sketch the vampires realistically, I exaggerate their 

postures to better explain what’s going on. The classic elements 

of coffin, crypt and subdued lighting should help set the scene. 

That provides the springboard for you to concentrate on 

delivering your message – in this case attempted humour.

The female vampire’s pose is key to showing what’s going on 

so I work on that first, plotting out the main folds of material as 

well. I can have fun dropping the mice in later. I don’t think of 

the mouse on male Vampy’s head until much later – yet I think 

that fits in really well with his Tommy Cooper-like pose. 

My spin on the classic 

vampire monster, 

plagued by mice and an 

unhappy wife forced to 

live in a tatty coffin.

I’m inspired by classic vampire actors like Christopher Lee, but look for the 

humorous side of being a vamp… these sketches help decide my character.
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www.bit.ly/ifz12-cth

Artist’s secret
Up the weirdness

Use asymmetry to help make something 

strange. In addition, throwing in a human 

mouth can work well, contrasted against the 

big wobbly tentacle head.

Step-by-step: Give a dragon some feathers

1  
The Shoebill is a prehistoric-looking 

bird so I use it as my start point. I 

begin with a dynamic silhouette. After 

sketching that out, I place down basic 

colours. Following my alligator references,  

I paint the upper body parts in cool colours 

and the chest with a warmer, paler colour.

3  
The Lasso tool is what I use most 

when defining feathers. After I have 

an area Lassoed, I paint the edges with a 

large Round Soft brush. Once I get down 

all the highlights, I go back with a darker 

colour and paint the cast shadows under 

each feather to gain a sense of the depth.

2  
I use three different types of scales 

for the skin texture: the white ones 

are smaller and the most feather-like. I use 

these scales to transition into the feathers. 

In areas where the feathers start emerging, 

I make the scales more chaotic, as if 

they’re bursting out from under the scales.

Artist’s advice
Manon says

Cthulhu has a big octopus-like 

head and tentacles – so where 

better to start than with lots of 

tentacles? I want my Cthulhu 

leering out of the dark, about to bring forth 

your impending doom!

You could try all kinds of versions of 

Cthulhu, but it’s important that you take 

advantage of the gross-out factor of 

tentacles. You’ll need to find some 

inspiration. I do a search online for 

octopus and squid photographs and collect 

a few together to refer to when painting.  

I also find some good bumpy textures I 

could add to my creature. Take note of how 

tentacles behave, how light falls on them 

and then start drawing. 

Try some thumbnails first, to see what 

could work in the space of your canvas – 

this is always massively helpful. When I 

start drawing him, Cthulhu looks cute and 

kind of jolly, but I want him to be 

frightening so I produce a few more 

drawings to get the feel I want. Don’t be 

afraid to make mistakes, this is often 

where the magic happens.

Once my drawing is done I take a nice 

rough texture and put it over the whole 

image using a Multiply layer and fade the 

Opacity so I have a ‘dirty’ canvas to work 

on rather than pure white. Start with 

shadows and highlights and you’ll find he 

comes to life much more quickly because 

of the mid-tone background.

I keep the head 

receding into shadow 

and his tentacles are 

more in the light to give 

the idea he’s appearing 

out of the dark.

The best way to…
create a really interesting and unique  

depiction of the classic Cthulhu

Core skills | Creatures
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Artist’s advice
Raymond says

My approach to creating 

convincing and dynamic 

blasts of dragon fire is to 

focus on all the elements of 

the fire that emphasise its intensity. The 

brightness, heat, directional speed and 

scale all add up to make a monstrous 

blast from a classic fantasy monster. The 

inherent challenge of depicting 

movement and luminosity in a still 

image calls for a slight exaggeration in 

some visual elements, to draw attention 

to the laws of physics – and sometimes 

magic, of course – at work. 

Artist’s advice
Brynn says

Defining muscle structure 

can give your monster a 

powerful and intimidating 

look. While you want it to 

look muscular, never forget that fat, skin 

and sometimes fur, feathers or scales 

might lie on top. Studying animal and 

even human muscle structure and 

anatomy will help you achieve that  

‘in-between’ look. 

Adding a light source will help define 

muscle shape and volume. Thinking 

about the muscles as elongated spheres 

that fold in and out of each other will 

help in visualising how they might be 

lit. Using light, shadow and reflective 

light, you can create a defined look.

The power of a painting – and not 

necessarily one that depicts a fantastical 

scene – is that it doesn’t need to adhere 

precisely to reality the way a photograph 

does. In this case, I believe that it’s more 

effective to sculpt the form of the dragon’s 

fiery breath with some stylisation that 

describes its motion. The visual motifs of 

my stylisation draw from other natural 

forces, such as extreme weather or volcanic 

activity, to add believable and archetypal 

power to the fire. Finding the balance 

between realistic rendering and the 

suggestion of movement is the key.

I sketch out the muscles looking at bears, 

cats and dogs for reference. While painting 

my image, I refer back to this study to make 

sure the anatomy’s correct as I move 

forward. If you want to get a good visual, 

try sculpting a small model out of clay and 

lighting it yourself. 

Artist’s advice
Brynn says

A dragon’s curly neck can certainly be tricky to get 

right. It should look flexible, but not to the point of 

appearing too flimsy. One way to approach this 

would be to study snakes, because they offer a 

realistic example of what a long neck might be capable of. 

Start by roughing in a quick gesture sketch, where the spine 

of the dragon would lie in the image: a simple, curled line will 

do. Imagine the neck as a hose or long cylinder. Laying down 

your brush strokes in this direction will help and will also 

introduce volume in the image. 

Another thing to consider is overlapping. Putting part of your 

dragon’s neck in front of, or behind, the rest will give the image 

some depth and aid in making the neck look flexible. 

Atmospheric perspective helps push back any part of the neck 

that’s behind the rest of the dragon in my image. 

Using real-world references to paint fantasy creatures is 

essential to ensuring your design feels like it’s a living, breathing 

animal. Have fun!

A good way to…
paint a dragon’s  

curly neck

How to…
define a monster’s 
powerful muscles

The best way to…
give blasts of fiery dragon breath 

mass and momentum
While you’re painting your dragon, it helps to 

sketch out a planar view over your painting. 

This will remind you that the neck is a cylinder.

Painting the 

muscles simply 

can help you 

visualise them. 

Always keep the 

sphere in mind: 

light, shadow and 

reflective light. 
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Artist’s secret
save selection

It’s a good idea to save your selection after 

you’ve deleted the negative space around your 

pencil sketch. Click Select>Inverse, then Save 

Selection. You can always use it to lay down a 

quick colour fill under your pencil sketch later.

Step-by-step: Paint fiery dragon’s breath

1  I paint the gradient of colour from 

the hotspot in the throat to the hot 

reds at the blast’s edges. The fire’s luminous 

quality is shown by reflecting the light off 

the dragon’s face and neck. I emphasise  

the brightness by having the light bleeding 

through the skin around the mouth.

3  I add the sparks and embers that are 

caught up in the turbulent air flowing 

around the blast. This brings out the depth 

from the background, all the way to the 

extreme foreground. Even the occasional 

scale breaking off can emphasise the raw 

energy of the dragon’s fiery breath.  

2  Billowing trails of smoke show the 

direction and the three-dimensional 

quality of the blast. The smoke that wraps 

around the column of fire is reminiscent of 

a tornado. It’s important to remember that 

the size of the round pillows of smoke 

gives the fire and the dragon their scale.

Artist’s advice
Brynn says

There are a few quick tricks you 

can employ to prepare your 

pencil drawing for colour. Here 

I’ve scanned in a pencil sketch 

I’d like to colour; I often desaturate the 

drawing to get rid of any weird colour 

reflections from the scanner. I make the 

pencil drawing its own layer and then add a 

layer underneath and fill it with white.

Next, I select the area around the sketch. 

I usually use the Magic Wand tool set to a 

tolerance of about 35. I clean up the edges 

using the Lasso tool and make sure my 

pencil art is selected the way I want it to be. 

After I’ve selected around my pencil 

drawing I then Refine Edges to obtain a 

softer look on the edges of my pencil 

drawing. I now delete the negative space 

around the drawing to get rid of the paper 

texture and anything else that the scanner 

might have picked up. Adjusting the pencil 

drawing with the Levels channel will also 

help in cleaning up the pencil lines. 

After that you can set your pencil layer to 

Multiply and apply colour underneath. I 

also employ the Ghost filter for my pencil 

work – you can find it by searching online 

for Flaming Pear Ghost Filter. 

Knowing how to clean 

up your pencil sketches 

before colouring is a 

great skill to have.

An easy way to… 
separate scanned line art from its 

background to add colour

Here you can see my 

layer order, the Refined 

Edge tool and how 

I’ve selected the  

pencil sketch. 

Core skills | Creatures
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Visit www.bit.ly/ifx-app 
and download the new 

ImagineFX app to  
sign up for a FREE 

subscription.

how  
To BUY

  The latest issue is 
available instantly.

  Receive a further 13 
issues in your first year.

  All issues download to 
your iPad automatically.

  Read it on your iPhone 
for no additional cost.

  Watch exclusive videos 
from our workshop 
artists, and download 
brushes, WIPs and 
finished artwork.

Save up to 36%* with an annual subscription  
to ImagineFX on Apple Newsstand

*The saving is based on purchasing 14 single issues a year of the Apple Newsstand Edition.
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Software guide

artrage
Master using the core functions of this excellent app, including its  

unique canvases, drawing tools and natural media.

Simon Dominic
Simon is a self-taught freelance 

illustrator who specialises in 

fantasy, sci-fi and horror. He 

works primarily on game art, 

book covers and magazines.

www.painterly.co.uk

turn over to DiScover artrage’S toolS

| Contents |
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download 

your files

Accessing your files 

Click or copy and paste the  

link above into a browser to 

download the files to a 

desktop PC.
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A
rtRage is able to simulate 

the qualities of a real 

canvas, enabling you to 

define dimensions, colours 

and textures. If you intend 

to print your image then it’s essential to 

understand PPI (sometimes called DPI). 

PPI stands for pixels per inch, and is the 

number of pixels that span a printed inch of 

image. Printed dimensions (inches) equal 

image dimensions (pixels) divided by PPI. 

So an image of 900x600 pixels at 300PPI 

will print at 3x2 inches. ArtRage helps you 

out here, as we’ll see.

ArtRage’s main strength lies in its easy-to-

use natural media simulation. To get the 

most out of its painting and manipulation 

tools, ArtRage uses its own special .PTG file 

format, which can store extra information 

about your painting. For example, it holds 

paint thickness data for every point on your 

canvas, which makes for convincing 

blending and mixing effects. ArtRage also 

keeps the canvas separate to the paint, 

meaning that it acts like a real, textured 

canvas and not just another colour.

edit oils and watercolours

PRePARInG An ARTRAGe cAnvAS

APPly nATuRAl MeDIA To youR ART

“ArtRage is able to simulate the 

qualities of a real canvas, enabling  

you to define dimensions, colours 

and textures”

customise the canvas

a. Screen 

Size

Press this to switch 

to pixel dimensions 

entry. Choose 

Screen Size if you 

are not intending  

to print.

B. Print Size

Choose to enter 

your physical print 

sizes here.

c. canvaS 

dimenSionS 

This displays 

dimensions either in 

pixels or physical 

units, depending on 

whether the Screen 

a. PreSSure

Pressure simulates pressing 

the brush harder against  

the canvas.

B. thinnerS

This simulates the addition of 

turps or linseed oil, which 

dilutes the paint.

c. Loading

This is the amount of paint  

on your brush at the start of  

a stroke.

d. inSta-dry

With Insta-Dry on, the paint 

dries immediately.

e. auto cLean

With this off, your brush picks 

up paint from the canvas. It 

can be washed in the virtual 

glass that appears.

F. Square head

With this off, your brush 

tapers to a point as you 

reduce pressure.

WatercoLourS

The settings are the same as for Oils with 

the exception of the following:

G. thinnerS

Simulates the addition of water, which 

dilutes the paint.

h. coLor BLeed

How much one colour will mix with another.

i. PaPer Wet

With this off, paint soaks into the canvas to 

produce a darker edge.

Size or the Print Size 

is chosen.

d. canvaS 

PreSetS 

menu

You can either 

select or create new 

size presets here.

e. canvaS 

ProPortionS

Select Tick to 

maintain width-to-

height ratio, or 

Cross to enter them 

individually.

F. chooSe PPi 

vaLue

Enter your PPI here. 

a B

c

d

e

F

h

G
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1 Setting dimensions
It’s important to specify your 

dimensions, and you have two 

methods for selecting canvas size. 

With Screen Size selected, enter the 

pixel dimensions and PPI, and the 

printed size will pop up below. 

Alternatively, select Print Size and 

enter the physical print size and PPI; 

pixel dimensions are then displayed. 

The menu on the top right enables 

you to select and save your presets.

1 Set your oil paints 
Make sure Tools>Color Options> 

Real Color Blending is ticked. Select the 

Oil Brush tool from the Tool Picker 

menu, bottom left. In the Tool Settings 

panel, reduce Loading to produce short, 

dry dabs. Set the Loading to 100 per 

cent and Thinners to 0 per cent for 

thick, textured paint. Ticking Insta-Dry 

stops paint mixing, giving a pop art 

effect. Increase Thinners for a light wash.

2 Edit the Palette Knife
Manipulate paint already on the 

canvas by selecting the Palette Knife 

tool from the Tool Picker. The thicker the 

paint on the canvas, the further it’ll 

spread. Select a Type from the five 

options in Tool Settings: Flat, Edge, Soft, 

Blur or Wet. Flat produces a convincing 

palette knife effect while Wet mixes 

thinners with the paint for some great 

textured blends.

3 Tweak watercolours
Select the Watercolor Brush 

from the Tool Picker. Set the Config dials 

in Tool Settings to 50 per cent for strong 

colours with moderate bleed. Reduce 

Thinners and Color Bleed for more 

compartmentalised colours. With Insta-

Dry on experiment with a Photoshop-

like wash. Setting Thinners to 100 per 

cent and Bleed to 0 per cent simulates 

brushing water onto the canvas.

2 Choosing your canvas 
Click the Canvas Preview 

window to reveal the canvas options. 

Now set Opacity, Metallic Effect, 

Roughness and Grain Size (1). Click the 

Colour swatch (2) to choose a hue and 

the Grain swatch (3) to select a texture. 

You can view the presets in the panel  

to the right (4). They are bundled 

according to the groups in the centre. 

Add Group (5) creates a new group. 

Select OK to apply.

3 Resizing your canvas 
You may want to alter your 

canvas attributes after starting work. 

Choose Edit>Resize the Painting to 

resample the entire image. Use the 

Screen and Print options as in Step 1.  

If you want to reduce or extend the 

canvas without resizing the image, use 

Edit>Crop> Expand the Canvas. Enter 

the new size and either drag your image 

to the desired place or use the 

positioning presets.

Step-by-step: How to prepare your canvas

Step-by-step: Explore the Oil and Watercolor tools

This box shifts 

position when 

option B (Print Size) 

is chosen.

G. 

PoSitioning 

PreSetS

This enables rapid 

placement of your 

image onto the  

new canvas.

h. 

PoSitioning 

WindoW

Using this, you can 

drag your image 

within the window 

to put it roughly in 

its new frame.

3

2

1

4

5

0% thinners 
hiGh loadinG

low thinners 
low color 

Bleed

low loadinG all 
settinG 

50%

insta-dry on
insta-dry on

hiGh 
thinners  
& loadinG

100%thinners
0% color Bleed

ArtRage | Prepare a canvas and apply natural media
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layers are transparent canvases that can be 

worked on without affecting the rest of your 

image. layers can be merged together, or 

with the canvas, at any time. If you’re not 

happy with a layer delete it. This enables 

you to try out effects and compositions 

before committing yourself. using Blend 

modes combined with opacity settings, 

you can alter the colour and appearance of 

an existing image, or add subtle textures. 

I find layers useful in planning 

composition. I sketch each character on a 

separate layer, then move them around and 

resize them until I’m happy. like most 

ArtRage features, layers are easy to get the 

hang of and the more you explore them the 

more cool features you’ll find.

To get started with ArtRage’s hard media it’s 

a case of simply selecting the Pencil tool 

and then away you go! Straight from the 

get-go you’ll find you’re able to produce a 

convincing graphite simulation that’s 

straightforward to use. 

yet as is often the case, ArtRage provides 

some powerful extras that encourage you to 

get the best from the basic functions. Two 

such extras are Stencils and Rulers, which 

allow for anything from precision work, to 

textures and enhanced line smoothness.

You can adjust the Pencil 
tool’s pressure and softness 
depending on whether 
you want subtle shading 
or bolder lines 

Grasp artraGe’s 

stencil system

layers panel

SkeTchInG AnD DRAwInG ToolS

GeT MoRe FRoM ARTRAGe’S lAyeRS

“I find layers useful in composition. 

I sketch each character on a separate 

layer, then move them around and 

resize them until I’m happy”

a. ShoW StenciLS 
Use this to display a list of 

Stencil Groups.  

B. add StenciLS 
Bring in your own Group. 

c. imPort a StenciL 
Import a Stencil from a 

greyscale image on disk.  

d. quick vieW  
of StenciLS 
Shows thumbnails of Stencils  

in a Group. 

e. manage StenciLS 
The stencil loading and 

organisation menu. 

F. configure 
StenciLS 
Right-click a Ruler or Stencil to 

get the options menu. 

G. StenciL, ruLer  
or guide?
Choose these here. 

h. move StenciL 
Move Stencil on the Canvas. 

i. invert the StenciL 
Opaque becomes transparent 

and vice-versa.

J. reSet orientation 
The Stencil rotates around the 

Pin Position.

K. hide/remove 
StenciL 
Hide the Stencil or remove it 

completely from the canvas.

l. Save StenciL 
Save into a folder as an image.
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a. create 
Layer 
Make a new layer. 

B. the 
canvaS 
The canvas can’t be 

deleted, but it can 

be cleared or 

duplicated to a  

new layer. 

c. grouPed 
LayerS 
A collapsible 

grouping option  

for organising  

your layers. 

d. grouP menu 
Grouped layers options include Alter Blend 

Mode and Opacity. 

e. Layer name 
You can name your layers if you wish. 

F. Layer menu 
Options in the Layers Menu include 

Transform, Duplicate, Clear Contents and 

Set Blend Modes.

g. normaL Layer 
A non-grouped layer, the default option. 

h. Lock tranSParency 
This prevents you from painting onto the 

layer’s blank areas.

a

B

c

d

e
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1 The Pencil tool
Select Pencil from the Tool 

Picker. In the Settings panel, configure 

Pressure, Graphite Softness and 

Angular Tilt, which simulates drawing 

with the edge of the pencil (0 per cent 

equals point, 100 per cent equals full-on 

edge). Tick Precise and you’ll see Tilt is 

replaced by Smoothing. Try setting 

Smoothing to 100 per cent – ideal for 

character construction lines. Try out the 

Crayon and Chalk tools, too.

1 Get started
Choose View>Layer Panel. 

Select New to create a layer, and 

paint something. Move the cursor 

over the Layer icon, click Opacity 

and enter a value for transparency. 

Click Lock Transparency to allow 

painting only in areas you’ve already 

painted. Click the Visibility eye to 

make your Layer disappear and 

reappear. If you have multiple Layers, 

you can drag them up or down. 

2 Move and  
transform layers

From the layer’s Panel menu, choose 

Transform Layer Contents. Drag within 

the layer boundary to move the layer or 

drag the round tabs to resize. To rotate 

the layer, place your cursor on the 

boundary and, when it changes to a 

curved arrow, drag it. Try right-clicking 

within the boundary and Flip Horizontal 

or Flip Vertical. Transform all layers at 

once using Edit>Transform All Layers.

3 Group and 
duplicate layers

To merge a layer with the one below, 

use Merge Layer Down, and to create a 

copy, choose Duplicate Layer. You can 

group layers together by selecting 

Create Layer Group and dragging layers 

into that group, and transform all layers 

in a group with Transform Group 

Contents in the Group menu. Finally, try 

some special effects with Edit>Blur 

Layer and Edit>Adjust Layer Colors.

2 Using Stencils 
First, choose View>Stencil 

Collection. Now click the Textures  

group and select Turbulent. With the 

Chalk tool, draw over this Stencil. Notice 

how the Stencil’s varying opacities 

generate texture. Hold Space and drag 

(or Right-Click+drag) if you want to 

move the Stencil, use Option/Alt+drag 

to zoom, and use Cmd/Ctrl+drag to 

rotate. Try holding Shift when rotating 

and zooming.

3 Using Rulers
Rulers are a type of Stencil and, 

like their real-world counterparts, enable 

you to trace round their edges. In 

Stencils, choose the Ruler from the 

Rulers group. Place the cursor slightly 

over the Ruler and draw. Your line will 

appear along the nearest edge. Rotate 

and elongate the Ruler using the end 

grips. Right-click the Ruler for more 

options. Any Stencil can be used as a 

Ruler and vice-versa.

Step-by-step: Using the Pencil tool and Stencils

Step-by-step: Getting started with layers

i. Layer menu 

The same as B, 

except you don’t 

need to select the 

layer first.

J. BLend 

mode 

Use to change a 

Blend Mode. 

K. oPacity 

Enter value or click, 

hold and drag. 

l. viSiBiLity 

Toggles your layer 

visible or invisible.

ArtRage | Sketching tools and using layers
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when using ArtRage’s colour tools we often 

come across the letters h, S and l. So what 

do these actually mean? well, ‘h’ stands for 

hue and represents a pure colour from the 

colour spectrum. ‘S’ stands for saturation 

and defines the colour’s intensity. Finally, ‘l’ 

is for luminance and this is a measure of 

how light or dark your colour is. 

luminance is sometimes referred to as 

value, and therefore a value study is a 

greyscale image that concentrates on lights 

and darks. As we’ll see below, ArtRage 

makes it relatively straightforward to 

combine the three attributes hue, saturation 

and luminance, producing any colour that 

we require for our digital canvas.

the color samples panel

SelecTIonS AnD TRAnSFoRMATIonS

oRGAnISe AnD MAnAGe colouRS

At first glance, ArtRage’s image 

manipulation offerings appear to be rather 

basic, comprising little more than a 

Selection tool and a Transform tool. 

however, behind those icons lurk some 

impressive features: varied Selection Modes 

enable complex shape definition, while 

Type-specific settings, such as Feather, 

enable subtle bleeds and special effects. 

Most tools have their own specific 

settings and mixing and matching Types 

with Modes makes for a wide range of 

results. Best of all, the selection and 

transformation processes are very intuitive. 

not only do you always knows what’s going 

on, you’ll also be tempted to explore by 

experimentation rather than retreating to 

the ArtRage manual in frustration.

“Behind the Selection tool and 

Transform tool icons lurk some 

impressive features”

the selection settinGs panel

areas based on  

the colour. 

F. Paint area

Paint area excluded 

from your selection. 

To include only the 

mask, use Edit> 

Invert Selection.

G. controLS

Type-dependant 

controls, such as 

Opacity for Paint 

Area and Spread for 

Magic Wand.

h. rePLace

When you draw a 

selection all other 

selections vanish.  

a. rectangLe

Basic rectangle or a 

square with Shift.   

B. eLLiPSe

Elliptical, or circular 

if used with Shift.

c. PoLygon

Click to join the 

dots, then double-

click to close shape.

d. freehand

Freehand shape 

that closes when 

you lift your pen. 

e. magic 

Wand

Selects nearby 

h

h

m

J

J

li

i

K

G

a B c d e F

and display them as a grid. To 

assign a name right-click and 

select Set Sample Name.

 

h. Sort SamPLeS

You can sort your Samples by H, 

S, L and R, G, B or Name.

 i. add

The ‘+’ icon adds a new Sample.

 

J. SWatcheS

The main Samples display 

shows swatches for all your 

available colours.

d. gLoBaL coLor SamPLeS

Load, Save and Append Global Samples.

 

e. LocaL coLor SamPLeS

Load, Save and Append Local Samples.

 

F. cLear SamPLeS

Clear all samples from Global or Local areas.

 

G. nameS

You can choose to give each Sample a name 

and display them in a list, or omit the names 

a. coLor SamPLeS

Colour Samples panel menu.

 

B. add gLoBaL coLor

Add your current colour to the Global 

Samples. Global Samples are available 

for any image. 

c. add LocaL coLor

Add your current colour to the Local 

Samples. Local Samples are stored with 

the current image only. 

a

B

c

d

e

F

G
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1 Basic transformation 
You can select the entire 

contents of a layer directly. On a 

multi-layer image choose the 

Transform tool. In the Settings panel, 

tick Select Layer. Now when you click 

your cursor over painted areas of 

your image it will select the correct 

layer and enable you to move or 

transform its contents. If you untick 

Select Layer then only the content of 

the current layer will be transformed.

1 The Color Picker
 ArtRages’s main colour choice 

tool is the Color Picker. Choose 

Tools>Color Options or you can click 

the inner band of colour in the Picker.  

A menu of modes is then displayed. 

Choose HS/L. The inner quadrant now 

holds ‘H’ue and ‘S’aturation information, 

while the outer band displays 

‘L’uminance. All HSL and RGB (Red, 

Green, Blue) options follow the format 

of ‘two inner/one outer’. Tint/Tone is a 

variation on LS/H. 

2 The Color  
Samples panel

Choose View>Color Samples and select 

Import New Local Color Sample Set. Go 

to the Colors folder under Resources in 

the ArtRage installation folder structure 

and select the file Oil Spectrum.COL. 

Remove any colours you don’t need by 

right-clicking them. You can add new 

ones using Add Local Sample. Working 

with limited colour palettes helps you to 

maintain colour consistency throughout 

your image. 

3 The pop-up  
Color Picker

Press Ctrl/Cmd+Alt and hold your pen 

against your tablet. This brings up the 

Popup Color Picker, which is in LS/H 

format (so the inner circle is L and S and 

the outer band is H). Drag the cursor 

over the Popup to select your colour 

and release pressure to choose.  

Another handy feature is Tools>Color 

Options>Real Color Blending, which 

causes the colours to mix like real  

paint pigment.  

2 Advanced selection 
Choose the Selection tool. From 

Settings, click Type: Ellipse, Mode: Add. 

Set Feather: 15 per cent. Create several 

selections and then choose Oil Brush. 

Paint over your selections and see how 

the feathering enables the paint to 

bleed into the rest of your image. Press 

Ctrl/Cmd+D to clear the selections. 

Note: after creating any selection you 

can choose Mode: Replace and drag 

the selection to reposition it.

3 Magic Wand 
You can select areas based 

on colour. Go to Settings and choose 

Type: Magic Wand and Mode: Add. 

Set Feather to 10 per cent and 

Spread to 25 per cent. Click a couple 

of different colours. Notice how only 

similar colours are selected. Now 

copy and paste your selection. You 

can use the Edit>Invert Selection 

command to lasso everything but 

your selection at any time.

Step-by-step: Discover ways of defining and manipulating selections

Step-by-step: Choose colours and customise your palette

i. add

You can draw  

multiple selections.

J. SuBtract

Subsequent  

selections will  

remove areas from 

your first selection 

when overlapped.

K. difference

Only the selection 

areas that don’t 

overlap preserved.  

l. interSection

Only the selection 

areas that overlap  

are preserved.

m. toggLeS

Find type-specific 

toggles here.

ArtRage | Selection settings and organising colours
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Core skills

quick ways  
to design 
vehicles
Using simple, easy-to-follow tips and techniques our artists show you how to 
create unique and authentic spaceships, tanks and mechs. 

artists
panel

Charles Guan
A video game concept artist 

working in Canada, Charles 

has created characters for the 

most recent SSX game on 

PS3 and Xbox 360.

fantasticfunmachine.blogspot.com

Francesco Lorenzetti
A freelance video game 

concept artist living in the 

North of England, Francesco 

loves painting creatures and 

emotive environments.

francescolorenzetti.blogspot.com

Jonathan Standing
Jonathan Standing is a 

concept artist based in 

Toronto. He’s currently 

working on the TV series 

Defiance for SyFy.

www.jonathanstanding.com

Nick Harris
Gloucestershire-based Nick 

went digital in 2000 after 18 

years working with traditional 

methods. He works mainly on 

children’s book illustrations.

www.nickillius.com

Sam Brown
Sam is a concept artist who 

loves drawning and designing 

mechs. As well as working in 

games, he has work in the 

book Nuthin’ But Mech.

www.sambrown36.blogspot.co.uk

Mark Molnar
Mark is a concept and visual 

development artist. He’s busy 

doing freelance work for 

international film, game and 

animation companies.

www.markmolnar.com

Mélanie Delon
French artist and illustrator 

Mélanie creates art for book 

covers and games. She’s 

currently working on her 

personal book art work.

www.melaniedelon.com

Bill Corbett
Bill works as a freelance artist 

producing illustrations for 

media groups, public relations 

companies, small businesses 

bands and private clients.

www.billcorbett.co.uk
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We see robots as 
machines – but 
giving them a 

human shape is 
the key to making 

them attractive 
Mélanie delon

turN over to Start DeSiGNiNG veHiCLeS

Contents | Vehicles
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your files

Accessing your workshop files 

Click or copy and paste the above link into a 

browser to download the files to a 

desktop PC or Mac. 

link  
www.bit.ly/ifz12-ve

  



Discover a good way to…
add personality to vehicle designs

Artist’s advice
Charles says

An easy way to add personality 

to any object is to paint unique 

details that tell stories, such as 

decals on a military vehicle. 

However, it’s important that such details 

are in keeping with the vehicle’s purpose. 

I start with thumbnail sketches to 

generate ideas, before taking my favourite 

thumbnail into Photoshop to flesh out 

ideas, forms and the mechanics of the 

mech, all the while keeping the art 

relatively loose yet structurally sound. 

Using the rough mech concept sketch with 

no decals, I make a sheet with some 

duplicate layers of the sketch to try out 

different decal ideas. Coming up with 

scenarios and a narrative for the mech 

drives the decal design process; I consider 

military, futuristic and sporting situations. 

I then apply the decals with broad 

brushstrokes to test possible concepts. The 

broad stroke decals are mainly shapes to 

either completely cover up or break up the 

shapes on the outer panel surfaces. Shape 

design is the focus, complementing the 

decal shapes and their arrangements with 

the shapes that are already established in 

the mech concept sketch. 

When I’m happy with the shapes and 

arrangements of the decals, I add smaller 

decals for accents, scale, functionality and 

believability. When a design is ready to take 

to a final presentation, I revert back to my 

previous sketch to finalise and focus on 

fleshing out the mech design fully, before 

adding in the final decals at the very end.

Step-by-step: Design a mech with details and decals in mind

Decals can help to describe a narrative for a design. 

It’s always fun to play with different themes by using 

shapes, colours and patterns.

Artist’s secret
Play around with the 

base colour oPtions

A good way to start exploring a variety of 

decals is by changing the base colour of the 

mech. This inspires me to explore different 

colour schemes more often then not, and at 

times it can also trigger ideas for themes.

1  First, I sketch a final mech design. 

I’m only focusing on the forms and 

mechanics at this stage, prior to any decal 

applications. It’s much easier to handle the 

industrial design of the mech without 

having to paint and 

repaint decals. From 

trying out some 

decal ideas in the 

roughs, I already 

know the theme and 

colour scheme I’m 

going for.

2  I create a layer mask for separating 

the mech from the background, to 

help retain my edges. The layer blend 

mode I’m using is Overlay, although 

Softlight, Color and Color Dodge can get 

some cool results. I 

play with broad 

decal placements 

and shapes on the 

panel surfaces, 

following the 

contours to help the 

forms read and pop.

3  Finally, I apply smaller decals and 

accents. I try to balance their 

location and scale so they work as a whole, 

especially when using accent colours. I like 

researching, creating and using small 

informational decals 

to scatter around 

appropriate areas of 

the mech for 

functionality, 

believability and 

strengthening  

the narrative.

For the final mech 

design, I simplified the 

forms, refined the 

mechanics, and went 

with a futuristic police 

theme for the decals.
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Artist’s secret
using negative sPace

Good mech designs feature negative space, 

especially close to and in joints. If your 

design is humanoid, punch some holes 

through the shape so it will look less like a 

person in a suit and more like a mech.

How to…
speed paint a  

crashing spaceship

The best way to…
use reference to design  

functional-looking mechs 

After the line sketch 

I paint basic black 

and white values  

to help finalise  

the composition 

and make the  

light source  

more readable.

Artist’s advice
Francesco says

Before painting the doomed ship, I must consider the 

manner in which the craft is going to crash. For 

example, it could be slap-bang into the ground, it 

could scrape the side of a building or perhaps it could 

be a collision with another ship. Once I’ve made a decision about 

what is going to happen, I start to gather references, which 

includes the materials that will be seen in the image, such as 

shattered rocks or burning trees, as well as elements stemming 

from the ship itself. These will include crumpled metal, 

explosions and plumes of smoke. 

Once I have all the reference images, I begin to sketch some 

quick ideas, playing with the composition and grey values so 

that I can understand the size of the ship in relation to the 

ground, and the depth and light.

In this speed painting I want to capture the very first  

moment of impact of a huge cargo ship crashing in a mountain 

environment. When I create an image like this I try to visualise 

the painting as though it’s a still frame from an action-packed 

sci-fi movie. You can see how I directly use reference images as a 

photo collage to help streamline up the painting process. 

Notice that I’ve included pieces of rock flying away from the 

impact area. I create them using the Lasso tool, before adding the 

smoke and sparks, indicating that the metal ship is scraping 

along the rocky surface.

I generated these thumbnails in Alchemy. At this 

stage the aim is to come up with a variety of loose 

designs, rather than produce a few detailed mechs.

design of what the mech will be. As simple 

as these drawings are, I’m implying what 

kind of joints I’ll be using later on. Whether 

your design is based on something 

mechanical or organic, your shape will 

dictate how it needs to be articulated.

I studied fine art at university and so have 

no engineering or industrial design 

education. Like most people, I have to crib 

ideas about how things work or move from 

the real world. What’s really interesting is 

the variety of places you can get ideas for 

mechanical movement, whether you look 

for things on the internet or simply look at 

what’s in your environment around you.

Artist’s advice
Jonathan says

I love designing mechs. It’s 

not a subject that I’ve done 

much of professionally, but 

there’s something about it 

that brings out the kid in any designer.

Before even thinking about 

funtionality or joints, I begin designing 

using shapes. The thumbnails pictured 

below are made in Alchemy, which is a 

wonderful free program. You can 

download it from www.al.chemy.org. Its 

toolset is very fast and simple, and stops 

you from noodling too many details too 

soon. By keeping the designs simple, I 

deal with big shapes and the overall 

I draw a fast line 

sketch directly in 

Photoshop. I use 

quick movements 

with my pencil and 

try to stay away 

from any detail at 

this stage.

Core skills | Vehicles
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How you can…
make vehicles  

look solid 

Artist’s advice
Nick says

Can you bring steampunk and 

high fantasy design together? 

Why not? The rules controlling 

each fantasy universe can be 

quite rigid, but that doesn’t preclude 

occasional pilfering from other genres.  

The Victorian era that colours the 

steampunk universe was itself subject to a 

neogothic revival in its architecture. You 

could argue that a medieval influence like 

that is already in tune with high fantasy 

and go with that. However that is more 

often represented by flamboyant flourishes 

and exaggerated decoration borrowed  

from many sources. 

There is something inherently pleasing 

about the idea of a mechanical walker.  

Artist’s advice
Sam says

This comes down to communicating form in a real 

manner. It’s easier when you break it down into 

primitive shapes. For example, when you’re 

rendering cubes, the three visible surfaces are 

each going to have different values. 

My example here is lit from above, so the top surface has the 

lightest gradient. The surface numbered 02 is darker, and 03 even 

more so. The numbers on each surface are all the same value of 

grey – they just look different relative to the value of the surface. 

When you think of this in terms of vehicle design, for example, 

just keep each side of the vehicle within the proper gradient 

according to the light source.

Having an understanding of a sphere can help if you’re adding 

curves to a vehicle design. When you’re rendering metallic 

spheres, you have to take into account the location that the 

sphere is in. I render my sphere here as if it’s in a simple room. 

The upper portion reflects the walls and ceiling of the room, 

while the lower section reflects the table it’s sitting on. Knowing 

this – and practising, of course – can aid your designs no end.

My preferences lean towards two-legged 

efforts reminiscent of a T-Rex. For my 

design’s Victorian basis I looked at 

hansom cabs. They were the period 

equivalent of London’s iconic black cabs 

(or New York’s yellow ones), with a 

distinctive look. 

I stick a pair of sturdy iron/brass legs 

beneath, with hints of a suitable power 

unit, including a chimney behind.  

Once I have my basic unit I can think 

about adding design and decorative 

features drawn from more medieval 

sources. By keeping to the traditional 

steampunk materials for construction, 

successful genre blending should be 

eminently possible.

If you balance the original base with 

exaggerated flourishes and decorative 

touches, you should be able to straddle the 

two worlds of steampunk and high fantasy.

How to…
give a steampunk walker a  

high fantasy look

Basing the passenger housing  

on an old hansom cab or some other 

period vehicle immediately strikes a 

note about the world’s technology.

I find it best to pick medium or darker values and then build up 

directional light with a pressure-sensitive brush. I usually use a 

simple airbrush and work with restraint.
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Artist’s secret
using radial blur

You can add extra depth and dynamism to 

your images with the Motion Blur filter in 

Photoshop. I use the filter here to blur out the 

objects more as we move further away from our 

focal point, which is closest to the ship. 

Core skills | Vehicles
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A combination of 

sketching, 3D tools and 

Photoshop helps me 

create this menacing-

looking spaceship.

Step-by-step: Design an invasion fleet

Learn the best way to…
concept an alien-looking spaceship

Artist’s advice
Mark says

To answer this question I want 

to produce a futuristic yet 

believable design. I imagine 

an invasion against an Earth-

like planet by an alien race, which is 

coming from a water or fluid planet. The 

bone structure of the cuttlefish and other 

deep-sea animals spring to mind, and I 

try to mix this with the design of today’s 

After I sculpt the main ship, I add some 

basic panelling and other more mechanical 

parts on the underside to suggest the ship 

was manufactured. The right balance of 

plain panels and busier mechanical areas 

helps to enhance the realism of the design.

For the paint job of the ship I go back to 

my original references and try to mix them 

– the satin black of the stealth aeroplanes 

and brownish yellows of the cuttlefish 

living around coral reefs. I want to make it 

slightly animal-looking, but still menacing 

as a military jet. Finally, I make simple 

renders from various angles and bring 

them into Photoshop. I paint an aerial 

background and repaint the jets to achieve 

a film key frame, just like a cinematic shot.

1  After several small 

silhouette thumbnails I 

produce a quick line sketch of 

the spaceship and establish the 

general direction of my design. 

I try to keep the lines of the 

vessel simple and dynamic, 

similar to a deep-sea fish. 

Originally I wanted to go with a 

white-orange colour scheme, 

but I decide to change to a 

black-orange one.

3  For my paint scheme I 

try to mix my original 

references: the menacing satin 

black of today’s stealth planes 

and the brownish yellows of 

cuttlefish that live near coral 

reefs. I add the saturated 

bright-yellow areas, because 

the black-yellow palette 

reminds me of the colour of the 

spotted salamander and I 

imagine the alien pilots having 

a similar appearance.

2   I try to stay as close as 

possible to my original 

idea. I keep the simplicity of 

the silhouette, but add a range 

of small details, such as the 

panelling and mechanical  

parts on the underside of the 

ship, to make the design more 

believable. The freedom of the 

3D sculpting software helps me 

to achieve a more dynamic-

looking spaceship.

4  Because I want to show 

the ship from all sides, I 

render out various angles with 

the same simple lighting 

scheme. I place them against a 

quickly painted sky 

background and vary the sizes 

to make them look like a fleet 

of jets. After this step I start 

the painting process and add 

the necessary details to all the 

planes and the background to 

create a cinematic-style image.

drone aircraft. I produce lots of thumbnail 

sketches of the overall silhouette, then 

pick one and do a rough line drawing to 

establish the direction of my design.

I use 3D sculpting techniques to create 

the main design. Sculpting software is 

useful as I can achieve the creative work in 

full symmetry. Also it enables me to design 

the top and bottom of the ship in parallel. 

  



The stance and shape 

of a vehicle can make it 

feel aggressive, leaving 

you free to experiment 

with its chassis.
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Step-by-step: Design an aggressive-looking vehicle

Understand how to…
make vehicle designs stand out from the crowd

Artist’s advice
Sam says

Vehicles’ designs are made of 

basic shapes, each of which 

can affect the impression and 

purpose of your design. When 

designing armoured vehicles, for example, 

an aggressive and powerful look can be 

achieved in various ways. You can have 

a vehicle with either angular surfaces or 

organic shapes and both can have a strong 

forward momentum. With the front end 

of the vehicle, I try to integrate the cab, 

body and grill plate in a way that ties things 

together. The front end is pretty much the 

face of the vehicle, and another area that 

can help push its overall aggressiveness. 

With these things in mind, you can play 

with different proportions to design various 

kinds of armoured vehicles.

1 Here’s the base model in 

SketchUp, a program 

that enables you to build a 

solid structure to work from. I 

start with a side-view sketch 

and extrude the silhouette. I 

add detail and shape the body, 

drawing lines, and pushing and 

pulling shapes. Once you have 

your base body shape, add 

details. Then use Photoshop to 

paint design variations.

3 Here’s where things start 

to come back together 

in the paintover portion of the 

process. I go back to some of 

the original things I had on  

the base model, such as the 

door placement. If you have 

other vehicle models, you  

can set them up in the same 

perspective and lighting as 

your other model, so you can 

easily copy and paste portions 

to use in your painting process.

2  This is one of the early 

variations I made to 

paint on top of my model. It’s a 

little bit all over the place, but it 

shows that you shouldn’t be 

too worried about deviating 

from your base. I try to keep 

things pretty loose at this 

point. Because the base is a 3D 

model, it’s easy to see how the 

lighting works, and your 

perspective is all here.

4  I try some new stuff on 

the front end. If this were 

for a client, I’d present these as 

front-end variations for one of 

my concepts. I choose the new 

option and add more details 

for the final image. When 

finishing, look at photos and 

pay attention to proportions 

and user interaction. It’s always 

good to have function in mind 

when designing things that 

people are going to use.

look. A lot of that comes from the stance 

and overall balance of the shapes. 

I want the stance of this vehicle to have a 

strong rear end so I keep a lot of horizontal 

lines back there. Assigning it four wheels at 

the back also gives it a strong foundation. 

To contrast this, I draw interesting shapes 

on the front end to push the vehicle 

forward. This attracts the eye and gives 

  



Artist’s secret
box model

One of the simplest tricks to drawing 

complicated objects in perspective is to draw 

them within a box, then subdivide the box 

into smaller boxes to form the components 

of the object. Any object can be simplified 

this way for perspective drawing.

Learn to…
make a machine  

look sexy

Master an easy way to…
make an object look like it’s heading 

straight towards the viewer

At this stage the character lacks a bit 

of sexiness: the hips and the breasts 

aren’t pronounced enough. I need to 

enhance the features to make them 

more attractive.

Artist’s advice
Mélanie says

A machine or robot can be as sexy as any human 

being. The trick is to not think of it as a machine, but 

as a person. This is the most difficult part – we all 

tend to see robots as machines – but giving them 

soul and human shape is the key to making them attractive.

The easiest way to achieve a sexy render is to start the base like 

a normal human body – the only difference at this stage will be 

the colour scheme. We want it to look like a machine so the 

colours should be more metallic than skin tones.

Then I slowly add machine details, such as wires instead of 

veins. It’s almost like clothing. I have a lot of freedom here, as 

long as I leave some parts of the body neutral. I also prominently 

display the most attractive areas of the character, such as the  

face and the breasts. I paint these almost the same way as I would 

do on a human body. These are the features that will determine 

the sexy side of the robot.
With more foreshortening it’s possible to make the 

effect look far more dynamic and direct.

shape into a spacecraft, which gives me 

control over the lines and enables me to go 

back and change them. Then I convert it to a 

Raster layer and save as an Overlay layer. 

Now I can paint the ship without 

worrying about the missiles. When I’m done 

I add borders to the image and use the same 

perspective grid to draw and paint the 

missiles coming out between the picture 

plane and the new border. It now appears 

that they’ve missed the spaceship altogether 

and are on their way past the boundaries 

and out of the picture. Simple! 

Artist’s advice
Bill says

There are a few ways of 

giving the impression that 

an object is coming out of 

the page, but the most 

dynamic method is to take an object out 

of the boundaries of its frame and into 

the page itself, which I will do here. 

In Paint Shop Pro I start out by 

creating a wide perspective grid, then 

grab a small portion of the grid for my 

image. I can now enlarge and refine this 

part of the grid for the drawing stage. I 

use the Vector tool to build a basic box 

 I usually don’t hesitate to use nudity, 

and with machines it’s not a problem 

because there will be no real skin  

parts, only metal or plastic.

Core skills | Vehicles
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Software guide

paint tool sai
Follow our instructions to better understand how to use this very popular budget 

software used by comic and manga artists.

Paco Rico Torres
Paco is a freelance illustrator 

living in Spain who’s produced 

art for several card games, 

magazines, books and role-

playing games.

www.pacorico.blogspot.com

TuRn oveR To leaRn sai’s unique feaTuRes
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download 

your files

Accessing your files 

Click or copy and paste the  

link above into a browser to 

download the files to a 

desktop PC or Mac.  

 

link  
www.bit.ly/ifz12-sai

  



P
aintTool SAI is a relatively light 

program. It doesn’t have too 

many options, but you can 

achieve a lot with what it does 

offer. You can download a  

30-day trial from www.systemax.jp/en/sai, 

and it costs around $40 for a full working 

version of the program.

If you’re used to working with Photoshop 

and open PaintTool SAI for the first time, it 

may look confusing. In fact, using SAI is 

easy and this basic guide will enable you to 

start working with the software. 

SAI isn’t a photo-manipulation program. 

It’s designed specifically for painting and 

drawing, so many options available in 

programs such as Photoshop aren’t in SAI. 

That makes the program less versatile, but 

more efficient.

PaintTool SAI has a bunch of basic tools, 

and some of them can be widely modified 

using the brush parameters. Each default 

brush has its own purpose, but it’s possible 

to modify them so that you can use them in 

a totally different way. 

The brush parameters are the most 

complex aspect of the program, so I’ll take a 

look at some of the basic tools before going 

further. I’m going to explain just half of the 

most basic tools and I will focus on the 

most complex ones in the next section.

Most SAI tools try to emulate real-world 

paint media, so using them may require 

you to change your way of working, 

particularly if you’re used to Photoshop. 

However, with a little practice you can 

achieve really interesting effects.

Manage paint effects in sai

tool round-up

U
se our round-up to familiarise yourself 

with some of the basic tools available 

and where to find them.

Select and move

The Selection, Lasso and Magic Wand enable 

you to make selections. Below them are the 

Move, Zoom, Rotate, Hand and the Color Picker.

making markS

These are the main painting tools. The tools above, 

except maybe the Marker, are more ‘technical’ than 

the ones below. The Pencil is good for precise line 

work and the Legacy Pen is good for pixel art. The 

brushes are less precise and more ‘arty’ in nature.

BruSh 

parameterS 

These enable you to 

choose the size, the 

hardness and many 

other options in 

order to modify the 

main tools.

a. maintain opacity

If this is on a layer, then whatever you paint 

on that layer will have the same opacity of 

the surface over which you’re painting.

B. apply clipping

If the Clipping group is on a layer, whatever 

you paint on that layer will have the same 

opacity of the layer below.

c. activate Selection 

 If a layer has the Selection Source on, the 

Color Bucket and the Magic Wand will work 

according to whatever is on that layer, no 

matter in which layer you’re using them.

d. layer optionS

Create a new layer, delete, clear, merge, 

transfer down or group with other layers.

e. create a maSk

STArT uSIng A nEw ArT ProgrAM

gET THE MoST froM Your ToolS

“PaintTool SAI doesn’t have too 

many options, but you can achieve a 

lot with what it does offer”

a

B

c

d

e
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1 The Color panel
This comprises six elements, 

which you can show or hide by clicking 

the small icons on top of the panel. With 

these six elements you can select 

colours to paint with using the colour 

wheel, change their RGB or HSV (which 

stands for hue, saturation, luminosity) 

levels, mix two colours to produce a 

middle point, save your favourite 

colours, or mix them like traditional paint 

before applying them to the canvas. 

1 Markers, Pencils 
and Pens

The Marker tool in PaintTool SAI is  

only a rough recreation of a real-life 

marker pen. The pressure of the pen 

controls the opacity and the size, and it 

is possible to blend colours with a bit of 

skill and practice (the more you press 

down with the tool, the less it blends). 

The Pencil tool produces simple, solid 

lines, while the Legacy Pen (or Binary 

Pen) uses just 1-bit colour, and this is 

why it looks pixelated.

2 The Selection 
Pen and Eraser

When you use the Selection Pen you’ll 

see that whatever you paint has a pale 

blue colour. Once you choose any other 

tool, that blue turns into a selection, 

ready to be transformed or altered. 

Furthermore, if there’s any active 

selection on the canvas then picking the 

Selection pen will turn it into that same 

blue colour. The Selection Eraser works 

in much the same way, but it erases 

your marks.

3 The Bucket tool
Use the Bucket tool to fill a 

chosen area with colour, just like its 

Photoshop equivalent. However,  

there’s actually more to it than simple 

block filling. You can set it to detect 

transparency, so that the tool will fill a 

pixel and all the surrounding pixels with 

the same transparency, no matter which 

colour they have. You can choose to 

detect pixels in the current layer, in a 

selected layer or in all layers present  

in the image. 

2 The Layer panel
From this panel you can add 

texture to a layer, apply a watercolour-

like fringe to the edges of all the 

brushstrokes in the layer (which is an 

effect), change the colour mode of the 

layer, alter the opacity of the layer, create 

or delete layers, and introduce Layer 

Masks – although note that this last one 

only works with the Pencil tool. All in all 

it’s pretty intuitive, especially if you’ve 

used layers in other painting programs.

3 The Quick bar
The Quick bar, found below the 

menu bar, has some useful shortcuts, 

such as Undo and Redo (1), Deselect, 

Inverse Selection, and Hide Selection 

which hides the dot line around a 

selected area (2). From here you can 

also Zoom (3), Rotate the canvas (4) 

and flip the canvas horizontally to check 

for composition errors (5). Finally, the 

Stabilizer (6) is great if you have shaky 

hands like me. Check it out!

Step-by-step: Explore the Color panel, the Layer panel and the Quick bar

Step-by-step: Starting to use some of the basic tools

1

5

2

3

4

6

PaintTool SAI | Discover the basic panels and tools
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PaintTool SAI’s brushes can look confusing 

initially, but they’re pretty easy to use once 

you know what they do. The first thing 

you’ll notice is that not all the tools have 

the same kind, or the same amount, of 

parameters. That’s because not all the tools 

are intended to perform the same task. 

There are some brush 

parameters that are 

pretty intuitive,  

such as Brush size, 

but others are  

more difficult to 

understand. I’m 

going to focus on the 

three most complex parameters: Blending, 

Dilution and Persistence.

Previously I’ve discussed how brushes 

blend and/or dilute colours. So let’s talk 

about how to choose the right amount of 

Blending and Dilution. The parameters 

work best if combined, so spend some time 

experimenting with them.

TIPS for uSIng SAI’S BruSHES

SET SAI’S BruSH PArAMETErS

“Not all the tools have the same 

kind, or the same amount, of 

parameters as not all the tools are 

intended to perform the same task”

now it’s time to talk about the AirBrush, 

Brush and the watercolor tools. using the 

Brush and watercolor tools can be 

frustrating if you’ve never used blending 

brushes before. They’re tricky to control if 

you don’t know exactly what they do, and 

how their use differs from Photoshop’s 

brushes. Their main abilities are to blend 

and to dilute the colour. You can modify 

the way in which they do that using the 

Brush parameters, and I cover this in the 

section below. But for now, let’s focus on 

how to use the Brush itself. 

The first thing to note is that the Brush 

and watercolor tools can create really artsy 

effects, but they aren’t very precise. It’s hard 

to do perfectly clean or highly detailed stuff 

with them, so be patient and spend some 

time familiarising yourself with the 

controls before attempting to paint. 

furthermore, try to use the right tool for 

the right task. The Brush and watercolor 

tools can quickly create traditional-looking 

paintings through colour blending and 

brush stroke effects.

different Brush 

MoveMents and 

their outcoMes

preSSure pointS

Using the Watercolor tool, 

starting over the green 

spot, with a left-to-right, 

red brush stroke. The first 

one is made by pressing the pen just a 

little; the second one pressing a lot.

Zig and Zag

With the Watercolor 

tool over a green 

spot, make zig-zag 

brush strokes with 

the same green colour, pressing just a 

little. On the right, it’s the same but using 

red colour over the green spot. First with 

low pressure, then with high pressure.

pure Blend

With the Brush 

tool, start over  

the green spot  

and make a  

left-to-right, red brush stoke, with low, 

medium and high pressure.

all mixed up

With the Brush tool, 

over a green spot next 

to a red spot, make 

several red zig-zag 

brush strokes in different directions with 

different degrees of pressure to mix them. If 

you paint from the red to the green, you’ll 

extend the red paint, and vice versa.

Brush paraMeters

a. edge Shape

With this you can choose between a Soft, 

a Hard and two Medium brushes.

B. denSity and SiZe

Enables you to control the opacity of the 

brush, and maximum and minimum sizes.

c. BruSh variaBleS 

Use this to select shapes and textures. 

The sliders on the right change intensity 

of shape and texture.

d. Smoothing preSSure

Lets you set a minimum pressure value. 

Press with pen below value and it’ll blend.

e. denSity, SiZe and 

Blending SettingS

Alter density, size and blending of a  

brush by pressing harder or softer with 

your pen.

a

B

c

d

e
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1 Brush tool
The Brush tool in SAI works a lot 

like oils. If you paint on a clear layer, it’ll 

be like an ordinary brush. But if you 

paint over a painted surface, the colour 

you’re painting with and the colour on 

the layer below will blend together, not 

only on the canvas that you’re using, but 

also on the brush itself. Depending on 

how you move and use the brush, you’ll 

produce different results. This is a good 

tool to use if you want to experiment 

with your art.

1 Blending
The Blending parameter controls 

how much a brush will blend on the 

digital canvas. Blending in PaintTool SAI 

is similar to blending with oils or acrylics. 

If you start with a yellow surface on a 

layer and you then paint with blue, you 

can easily mix it until you produce green. 

A brush which has the Blending set to 0 

will just paint. In contrast, with the 

Blending set to 100 it will blend the 

colours on the canvas.

2 Dilution
The Dilution setting is similar to 

adding Dutch varnish to oils. It makes 

the paint more transparent, and at the 

same time blends the already painted 

colours on the canvas. So a brush with 

Blending and Dilution set to 50 paints 

with a semi-transparent blue colour and 

blends, while a brush with Blending and 

Dilution set to 100 will work like water-

painting: it blends the colours until 

they’re transparent (similar to a stump).

3 Persistence
This setting determines how 

much the colour you’re using is affected 

by the Blending parameter. If you have a 

high persistence value, the colour you’re 

using can be blended with the colour on 

the canvas, but the colour in the brush 

predominates over the one on the 

canvas. It’s only useful when combined 

with the Blending parameter. With these 

three parameters you can create the 

perfect brush for every situation.

2 Watercolor tool
The Watercolor tool works in a 

very similar way to the Brush tool, but 

with the added functionality of being 

able to dilute the colour on the layer. In 

other words, this enables you to blend 

your colour in until it’s transparent – this 

is just like adding water to a wet 

watercolour painting. The more you 

press, the less you dilute. Remember 

that with these tools, like in traditional 

painting, how you move the brush is 

very important.

3 AirBrush tool
The AirBrush is the easiest of all 

the tools in Paint Tool SAI to use. 

Although it doesn’t blend or dilute, it’s a 

great soft brush that works pretty much 

just like an actual airbrush. The more 

you press, the more opacity you 

produce. This can be especially useful if 

you want to add some subtle colour 

hues over a detailed painting. And since 

Paint Tool SAI doesn’t have blur filters, 

this is a pretty important brush to be 

familiar with.

Step-by-step: Using the Brush, Watercolor and AirBrush tools

Step-by-step: Learn how to use three parameters

PaintTool SAI | Brush tools and using brush parameters

79

  



Sometimes you need to create clean and 

precise shapes. Perhaps you need to paint a 

perfectly curved katana, or ink with precise, 

clean strokes. In these situations, vector 

graphics are helpful. If you draw a vector 

line, you can modify it until it has exactly 

the shape you want. You can also resize it 

without losing quality. That’s why they are 

so interesting when it comes to creating 

perfectly clean shapes.

In Paint Tool SAI, vector tools are called 

linework tools and can only be used on 

linework layers (created by pressing the 

button with a little pen on it next to the 

new layer button). Vector tools aren’t 

difficult to use once you spend a bit of time 

with them. However, working with them 

can be slow, so you need patience.

linework tools
a. pen tool

The tool you use to draw. It 

works pretty much as the 

ordinary SAI tools.

B. eraSer

Removes control points.

c. Weight 

Weight changes the size of 

the line proportionally. So  

if there are thicker or 

thinner parts on the line, 

you won’t lose them, it will 

just change the scale. 

d. color 

Changes colour of the line.

e. edit 

Edit is used to modify the 

line. It has many functions 

that can be selected on  

the Tool tray.

f. preSSure 

Pressure makes parts of the 

line (control points) either 

thicker or thinner.

g. Selection pen 

Selection Pen can be used 

to draw something, and 

when you choose any  

other tool, that drawing  

will automatically become  

a selection.

h. Selection 

eraSer 

Selection Eraser can be 

used to erase what you 

draw with the Selection Pen.

i. curve 

Curve creates curved lines. 

Click, then drag, then click 

again, and it will create a 

curve automatically 

between points.

J. line 

Line works in the same  

way as the Curve tool,  

but it creates straight 

angular lines.

cuSToMISE AnD crEATE BruSHES

STArT uSIng VEcTor ToolS

Paint Tool SAI is a pretty basic program and 

it doesn’t feature too many tools. But as 

we’ve already seen, with the few tools it 

does have you can still achieve a lot. 

You can create a new tool by right-

clicking one of the empty squares on the 

Tool tray, setting the parameters to your 

liking and saving it as a new tool. for 

example, you can create a new Pen tool: set 

it to emulate a charcoal using the brush 

parameters, change its name to ‘charcoal’, 

and that’s it – your own custom charcoal 

tool ready to use. 

But sometimes you need more than that: 

more textures perhaps, or more brush tips. 

In this case, you’ll need to create them from 

scratch. So here’s how you do it…

“You can create a new tool by right-

clicking one of the empty squares on 

the Tool tray, setting the parameters 

to your liking and saving it”

custoM Brushes

a. duplicate fileS

First I duplicate one of the files in the 

‘elemap’ folder, delete the black dots using 

Photoshop (preserving the blue crosshair) 

and paint new ones according to my liking. 

Then I rename it as ‘custombrush’. I do the 

same with one of the files on the blotmap 

folder and I rename it as ‘custombrush2’.

B. BruSh ShapeS

I want to create new brush shapes, so I open 

‘BRUSHFORM.COMF’ using the notepad, 

because it’s the .COMF file used for brush 

shapes, and here I add the following lines:

2,elemap\custombrush.bmp

1,blotmap\custombrush2.bmp

And then I save it and close it.

c. ready for uSe 

Finally, if I have done everything right, the 

next time I open SAI, my new custom brush 

shapes should be there, ready to use.

a

B

c
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1 Getting to know  
your folders

Take a look in your SAI folder and there 

you’ll see some more folders, with 

names such as ‘elemap’, ‘blotmap’, 

‘brushtext’, ‘papertext’ and so on. Inside 

these folders there are some files and 

these are the brushes and textures that 

you can use in SAI: ‘elemap’ and 

‘blotmap’ are for brush shapes, while 

‘brushtext’ and ‘papertext’ are for 

textures (brushes and layers).

1 Learning to make the 
first strokes

Imagine that you have a rough pencil 

drawing, like this one of mine here, and 

you want to ink it in a very clean way. 

Simply create a new Linework layer in 

SAI, then choose the Pen tool and 

create some straight lines over the top 

of your sketch. Then press Ctrl or 

choose the Modify tool. As a result, 

you’ll see a lot of small dots (these are 

control points) inside the line.

2 Modifying the  
control strokes

Next up, choose the Modify tool and 

you’ll see a lot of options on the Tool 

tray – and you should find all of them to 

be pretty much self-explanatory. 

Choose the second option and then 

click and drag on one of the control 

points on your drawing. You can then 

modify the line to your taste – you can 

bend it to perfectly match the pencil 

lines of your sketch if you so wish. 

3 Experiment stroke 
by stroke 

The process is basically the same for all 

the lines. As you become more 

experienced with the program you’ll 

start using some of the other Linework 

tools, such as the Eraser, which erases 

control points, and the Pressure tool, 

which modifies the pressure of the line 

– making each point thicker or thinner. 

Spend time experimenting with these to 

see the different results you can have.  

2 How to create some 
custom files

Now you have to create some new files 

and place them in the right folders. You 

need to create a very specific file for 

each thing. For example, all the files in 

the elemap folder need to be 63x63 

RGB. When they’re saved as a BMP file, 

you’ll see a blue crosshair in the middle. 

So the best thing to do is to copy the 

default files and use them as templates 

for your custom ones.

3 Find and name 
the .COMF files

Now you have to look for the .COMF 

files in the SAI root folder. There 

should be three in there: ‘brushform’, 

‘brushtext’ and ‘papertext’ (for 

shapes, texture and layer texture, 

respectively). You have to open the 

appropriate one using the notepad 

and write ‘2’ if it’s an elemap, or ‘1’ if 

it’s anything else, and then the name 

of the folder and the name of the file.

Step-by-step: How to create custom files

Step-by-step: Starting to use the Linework tools

PaintTool SAI | Custom brushes and Linework tools
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Core skills

Master 
drawing 
coMics
Explore the different styles that make up comic and manga art, from line art 
tips and digital inking to traditional manga painting.

artists
panel

Lindsay Cibos
Lindsay is the creator of the 

manga series Peach Fuzz and 

the webcomic Last of the 

Polar Bears. She’s also written 

several art instructional books.

www.lastpolarbears.com

Christy Lijewski
Christy is an American comic 

who’s best known for RE:Play 

from TokyoPop. She’s busy 

working on her new series, 

Dire Hearts.

www.heavy-gauge.net

Rob Duenas
Rob’s a graphic artist at Mad 

Engine for licensed men’s 

apparel, and he produces 

freelance comic book covers 

at weekends.

www.sketchcraft.com

Kai
Kai is a ‘mangaka’, illustrator, 

guitarist and model for V-kei 

fashion. His art combines dark 

and visual kei aesthetics with 

mythical, longing themes.

www.khaoskai.com

Serge Birault
Serge has worked for the 

music industry, video games, 

publishing and advertising. His 

art book, Corpus Delicti, is 

available now.

www.sergebirault.fr

Chris Ng
Chris has been working 

professionally in Imaginary 

Friends studio for the past five 

years. He’s currently building 

his freelance portfolio.

www.chrisnfy85.cghub.com

Saskia Gutekunst
Saskia has a degree in graphic 

design, but she likes to work 

within multiple fields such as 

comics, illustration, animation 

and games.

www.saskiagutekunst.com
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Think plushy: big head,  

compact body and simple 

rounded features. 

Lindsay Cibos

tuRN oveR foR tipS to maKe maNGa aRt

Contents | Comics
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Accessing your workshop files 

Click or copy and paste the above link into a 

browser to download the files to a 

desktop PC or Mac. 
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Artist’s advice
Lindsay says

There are some simple 

guidelines to help you start to 

draw cute creatures. First, it 

helps to have a general idea or 

theme to work with, so think about the 

qualities you want your creature to embody 

before you start sketching. 

Play with proportions and head-to-body 

ratio. Think plushy: big head, compact body 

and simple rounded features. Don’t be 

afraid to exaggerate size, such as extra large 

ears or a long swishy tail. Small works, too: 

teeny tiny paws, a chocolate chip-sized 

nose or button eyes. Then add to the 

creature’s appeal by adorning them with a 

prop, article of clothing, gem or symbol. 

Just be sure that it ties in with the theme so 

the overall design has a sense of unity.

For the pose, depict your creature in 

action, doing something that demonstrates 

its personality: kicking, leaping or playing, 

for example. Finally, consider using vivid or 

unnatural colours to enhance a character’s 

visual appeal.

The best way to…
draw cute manga creatures

Step-by-step:
Design a cuddly 
manga critter

1 I do endless sketches of 

creature candidates 

(magical horses, floppy-eared 

critters and bipedal cats), but 

it’s not until I ask myself what 

I’m trying to create that 

everything clicks. I envision a 

chibi wolf god leaping through 

the sky, bashing lightning from 

the clouds with a large mallet.

2 Now I focus on the 

proportions, pose, details 

and expression, with the goal of 

pushing the cute factor. Don’t 

go overboard with details here. 

Realistic fur, for example, can 

detract from the cuteness, so 

keep things simple and round. 

3 Use layers to tackle the 

background, character, 

and effects separately. Paint the 

background to set the mood 

and colour scheme. Then build 

up the shading on your critter. 

Keep the character’s colours 

simple and vibrant. Save the 

special effects for last.

Mixing large and small 

features enables me 

to create an incredibly 

cute character.

84

  



Discover how to…
take a traditional manga creature and 

make it your own creation

I reference the realistic anatomy of a real lion cub, 

then try to make the face look more human.

vision of what I’ll create – and I may even be 

able to improve my idea during this stage. 

I want to combine real white lion cubs 

with the traditional manga Kimba, which 

was designed with a more human, child-like 

face. I decide to keep the human eyes in my 

version, but give it a more realistic lion cub 

anatomy. I add a sense of power by 

positioning him on a cliff, looking intently 

at something off-canvas, and I incorporate a 

flowing mane which suggests a blowing 

wind in the scene.

Artist’s advice
Chris says

It’s always fun to create your 

own version of an established 

creature or character design. For 

this piece I decide to do a pin-

up of Kimba the White Lion, a character 

from the popular 50s and 60s manga and 

anime TV series. 

Before drawing the creature, I think about 

the way to execute the overall image. It’s 

critical that you have a clear direction before 

you start to work on your drawing, because 

it makes the process a lot easier later on. Try 

to make this a habit and you’ll have a more 

efficient workflow. After I’ve got a rough 

idea, I use Google Images to get a better 

I use dramatic lighting 

and glow to suggest 

that Kimba is majestic 

and extraordinary. 

Some dust implies 

that there’s 

something going on 

under the cliff. Adding 

details makes the 

image more lively.

Core skills | Comics
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Artist’s advice
Christy says

It’s important to be able to 

guide the viewer through 

the image, so their eye will 

linger on each character 

before moving on to the next. Using a 

composition that has strong lines – be 

they diagonals, horizontals, or verticals 

connecting the characters in some way 

– is the easiest way to make sure no one 

gets overlooked. 

Using colour to keep your characters 

from blending into the background is 

also very important. Don’t use similar 

colour schemes in the foreground and 

Artist’s advice
Kai says

Watercolours have a texture 

that helps create a living 

atmosphere. This illustration 

is a scene from a fairy tale 

I’m writing. It’s a dark and sad story 

about a prince who’s imprisoned in a 

pond. The colours I’ve chosen support 

the mood of this story: they’re defining 

the impressions of time, flow and 

silence. The greens aren’t saturated and 

range from olive to violet. The balance 

of warm and cold colours is important. I 

the background – for example, avoid lots of 

cool colours, or a monochromatic palette. 

Changing up the painting style on the 

figures and the background is also an 

effective tool. If you can use it, spot lighting 

focused on the figures is an effective trick.

use crimson red and ochre tones both for 

his skin and as hints in the background.

Don’t use too many colours in your art 

because the image will end up unbalanced. 

A realistic painting is about giving a life-like 

impression. To maintain the manga feel,  

I strike a balance between applying a 

flattened, cartoon-like colouration and 

giving depth to the painting. 

You should also bear in mind where the 

light source is coming from. Compose your 

image according to the light and shadow.

Artist’s advice
Serge says

Rotten flesh is a good excuse to work with very 

textured brushes. Indeed, instead of painting a 

precise and detailed picture, try to use different 

‘dirty’ brushes. I’m using a lot of Ditlev brushes and 

Photoshop for this one – you can easily find them online. Use 

your brush like a stamp: if you work with several layers, you can 

decrease the opacity of the layer for more precise results. 

Start with a basic greenish flesh tone and paint the texture 

with different tones and at a low Opacity. For a very 80s touch, 

apply warm and cold lights. It’s a good idea to add several light 

sources because these give volumes greater definition. For the 

background and the lights, I use the Soft Round brush on a very 

low Opacity. I only need an hour to finish my zombie. If you 

want to create something quickly, work at full size rather than 

zooming in and out all the time!

Observe real life and make life studies. I’m  

inspired by Baroque painting styles more  

than by the simplified colouration.

As you can see, my 

brush strokes are 

very rough and not 

very precise.

With watercolours I start with brighter colours, 

before moving on to darker ones.

An uncluttered background ensures the focus 

remains on your characters.

Textured brushes can 

easily emulate fine details.

An easy way to…
quickly paint a  

zombie for a comic

A good way to…
make manga characters look more 

realistic using watercolours

The best way to…
create a scene featuring  

multiple characters
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Artist’s secret

A rough outline

Choose the outlines carefully to emphasise the 

nature of your monster. Use round and fluffy 

forms for monsters that are supposed to engage 

the viewer’s sympathy, and hard edges for 

dangerous creatures. This trick is often used  

in animation and comics.

Step-by-step: Fill your environment with figures

1 I start laying out the background 

with strong lines on either side, as 

defined by the subway walls. There are a 

few verticals created by the poles, but the 

figures will be in front of them so as not  

to break up the horizontals that are made 

by the figures.

3 The characters are going to be 

colourful, so I stick to neutral/warm 

tones as much as I can for the background, 

to make sure they pop out. When you have 

a complex background it’s crucial to keep 

the colours simple so they don’t 

overwhelm the characters.

2 The next step is to make sure the 

viewer’s eye flows from one 

character to another. In this case all of the 

characters are equally important, so I 

make sure their heads are lined up on 

diagonals. This means the eye naturally 

follows from one to the other.

Artist’s advice
Saskia says

When looking through various 

manga titles I’ve noticed that 

you’ll often either find a 

cartoon-like monster, or more 

realistic creatures that could come straight 

out of a classic fantasy illustration. So when 

creating your monster you need to first 

think about your intention: is your monster 

supposed to gain sympathy, or do you want 

to set it up as a scary antagonist?

Generally, if you want to paint a monster 

that people can relate to it’s wise to make it 

appealing by adding soft forms. For 

example, Pokémon’s strongest monsters are 

still cute and cartoony looking. 

If you want to create a more humanoid 

creature, things can become a bit more 

tricky. Despite having a human-like 

appearance your monster has to be 

recognisable as a creature. The trick is to 

simplify and reduce your creature’s face to 

its key elements. For example, if you have a 

humanised wolf you could keep the long 

nose and the general skull structure, but 

work in human expressions.

It’s important to do your research first, 

especially if you go for a more realistic 

approach or if your creature is based on a 

real-world animal. Ensure you do a few 

studies to get a feeling for the animal’s 

prominent features. Once you have a bit  

of basic knowledge you can abstract as 

much as you like.

Here are some  

stylistic directions  

that you could use  

for your design. 

How to…
create a manga-style 
monster character
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Artist’s secret
pAint Authentic 

V-kei hAir

Look for styles used in the V-kei industry, such 

as backcombed and spiky, modern colours and 

edgy shapes. The hair colour I use is dyed on 

natural black, so the blond dye is darker and 

more saturated at the roots, as in real life.

Step-by-step: Paint a Visual-kei character

Discover the best way to…
add a Visual-kei aesthetic to your manga art

Artist’s advice
Kai says

To accompany my answer I’ve 

chosen to draw Kyouya, who is 

the original character of a 

Visual-kei music project I’m 

starting with a friend. We want to use a 

drawn manga character as an avatar and 

produce real music under Kyouya’s name.

V-kei includes very different styles, which 

are inspired by various fashion trends. But 

all of them have to be eye-catching! Out of 

personal preferences I love to draw a hard-

rock and host style-inspired fashion. This 

includes extensive use of leather materials, 

chains and silver accessories. People 

sometimes tend to overuse these elements, 

so you have to bear in mind what the final 

image will look like. Channel your inner 

fashion designer! Don’t just wildly throw 

different details together, though. Visual-

kei fashion has a very harmonic look, even 

if it doesn’t look like it at first.

For the past five years I’ve been working 

as a model for V-kei fashion in magazines 

and on events. Occasionally I’ve worked 

with my friend, who is the designer of a 

Japanese fashion brand, to create unique 

costumes. This experience has helped me 

understand the spirit and depths of this 

unusual fashion trend. For my painting I 

prefer to do it all traditionally, using the nib 

pen and ink to outline the drawing and 

watercolours for the colouring stage.

1 I’m aiming for Visual-kei, 

rather than a straight 

gothic look, so I choose a 

yellow-black colour palette 

instead of all black, with a 

couple of red highlights. The 

warm colours work well for 

blond hair. Note that the final 

image has to work with all the 

elements. I prefer to limit the 

colour palette to two or three 

colours. The hues are inspired 

by the leopard print pattern!

3 The golden pyramid 

studs are definitely ‘in’ at 

the moment and you can find 

them in many designs! After I 

finish the jacket I paint the 

shiny metal. During this stage 

you have to be very careful 

about the light direction and 

define every surface of the 

pyramids accordingly. Bear in 

mind that the shadow side is 

not just black, but also reflects 

the light. Patience is key!

2 I start painting the jacket 

with a bright base 

colour, which I will transform 

into leopard print. I use a 

muted yellow-brown colour 

and define the shadows and 

highlights before applying the 

pattern. For the black stains I 

use a wet-in-wet watercolour 

technique and let the colour 

bleed into the small circles. 

This keeps the pattern looking 

natural and every stain unique.

4 Finally, I render the silver 

jewellery and the leather 

wristband. There are no limits 

to your fantasy character and 

his costume! I like realistically 

painting the accessories and 

therefore I define every chain 

link. Visual-kei characters tend 

to use a lot of silver and black 

jewellery. I’ve found that it’s a 

good idea to make the 

accessories contrast with the 

rest of the image.
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Artist’s secret
Mix it up

Sometimes I play around and mix up shapes to create more interesting head shapes to 

fit the characters, such as using a triangle with a small sphere above it to create an 

orc-like creature with a small brain and big jaw. Mess around with funny skull shapes 

that you see in real life and use your imagination to create something fresh. Remember 

that using a unique skull creates contrast and helps the viewer recognise the character.

The wholesome girl stems 

from the common round 

shape, the muscular angry 

man has the cube shape 

as its base, and the sly 

villain is created using the 

long oval shape.

A round shape is used for most characters. A cube is used as a 

base for a bulky, chiselled character. A longer oval shape can be 

used for a character who is tall and skinny.

A good way to…
give your character an 

interesting, distinct look

How to…
design a Chibi  

manga character

An easy way to…
depict three dimensions in 

black and white manga

Artist’s advice
Chris says

When designing a 

character, the first thing 

that I think about is the 

overall silhouette of the 

figure, including its posture, which 

depicts attitude. The most important 

part is the head and the face, which 

give your character soul – it‘s where 

most people look first. 

To create an interesting character, 

you have to depict a suitable skull 

shape and facial expression. The 

silhouette of the head is fun to play 

with, and it can help tell a story or 

give the impression of a particular 

character to the viewer. Pay attention 

to your friends’ skulls: different head 

shapes in combination with their 

facial features build up the first 

impression of that person.

I experiment with three basic skull 

shapes, and create the second image 

from those shapes, applying specific 

expressions and lighting to further 

enhance the characteristics. Feel  

free to exaggerate the shape of the 

skull if you want to emphasise its 

characteristics. Use its expression to 

give a rough idea of what the 

character’s doing or what kind of 

posture they’ve assumed, so you can 

think more about their mindset.

Artist’s advice
Rob says

Chibi is the super-

deformed style of 

drawing characters with 

oversized heads or child 

versions of characters. Start out with 

a character who’s normally six or 

seven heads high and reduce them 

to somewhere between three and 

one-and-a-half heads high, with 

their head being the largest part of 

the character. The smaller the body, 

the cuter the Chibi. 

You can mix and match parts as 

well, including facial styles from big 

anime eyes to button-style faces, 

with either proportionate bodies or 

tiny lower halves. Don’t worry 

about intricate details, as they‘re 

usually too tiny to bother with. 

Chibis aren’t just for humans, 

either: the style can be used for 

animals, robots, vehicles and food 

as well. It’s a great way to liven up 

the mood and reveal emotions.

Artist’s advice
Christy says

Think of it as if you were 

working with three basic 

tones: highlight, (pure 

white), shadow (pure 

black) and midtone (grey tone/

crosshatching/greyscale). There can 

be several midtones, different tones, 

hatching or greyscale used to 

differentiate textures or colours, but 

if you’re using your white and black 

tones correctly then they’re not 

always necessary. 

Keep in mind where your light 

source is and paint in the solid 

blacks first. Spot blacks should be 

wherever light doesn’t hit. After that 

greyscale can be used to expand 

shadows, add lighter shadows or to 

create a different sort of shadowing, 

such as hair or clothing. White can 

either be created by using the blank 

canvas or by adding it back in later 

for highlights. Don’t be afraid to 

build and subtract as needed!

Focus on shape play and proportions 

when drawing Chibi characters.

Here the drop shadow on the fabric is a 

hatching, the leather has a shine and the 

heavy shadows are solid black.

The light source is overhead and 

behind, so the underside and frontside 

of things receive solid spot blacks. 

Adjust parts to change a figure from 

‘Cute’ to ‘Oh mah God!’ adorable.
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As long as you draw the 

key elements such as 

eyes, eyebrows and the 

mouth carefully, you 

can display complex 

emotions using a simple 

painting style.

Be careful when you’re drawing the eyebrows – they can make a crucial 

difference between several different expressions.

Artist’s advice
Saskia says

Most traditional manga works with a simple style 

that’s based on classical rules of art. In the end 

you’re always going to have more artistic freedom by 

having a strong knowledge of what you’re 

simplifying, so pay attention to those anatomy books.

Exaggeration is the key to getting the right expression. The 

stronger the emotion, the more you can exaggerate it. Look out 

for the key elements that make up the emotion. The most 

important things to emphasise are the eyebrows and eyes, 

because these are the first things your eyes are drawn towards, 

and they’re crucial for displaying any emotion. If you’re unsure, 

observe your own face in a mirror or take digital photos while 

you mimic some facial expressions, and use this for inspiration.

How to…
create manga-style 

expressions

Artist’s advice
Rob says

Gundam girls refer to drawing 

young girls or ladies in body 

armour that resembles Mobile 

Suits. Think of it like cosplay, 

but with mecha armour. 

Start with a basic female pose, working 

your construction and silhouette out 

normally, then add armour and accessories. 

Lots of reference will help out on the 

particulars, so refer to Google for research 

purposes. Keep your shapes as three-

dimensional as possible, and if you struggle 

with construction, try referencing real 

Gundam model kits instead of drawings.

Think of the mech heads as possible 

hats or headband accessories. Weapons 

could easily become purses or 

backpacks, and robotic legs large boots 

or shoes. Realistic or fun – the balance 

between sexy and deadly is the focus, 

with specific Gundam details 

accentuating the attitude of your design. 

Even though my version is very mecha, 

she easily could have just been wearing a 

dress that resembled aspects of the 

Gundam reference.

Learn the best way to…
design a Gundam  

girl character 
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Artist’s secret
pAinting skin texture

Add skin texture with a textured brush, such as the 

Drybrush in Photoshop. Apply freckles with a small 

Soft Round brush. Use a different layer to decrease the 

opacity of the layer for more efficient adjustments.

Discover an easy way to…
adopt manga-style elements into portrait art

Artist’s advice
Serge says

Painting a realistic manga 

character isn’t easy because the 

volumes aren’t logical. For 

example, the eyes are totally 

flat. The best approach is to cheat and use 

more human-like shapes. Try to find good 

references such as vinyl figures or dolls, but 

bear in mind that it doesn’t have to be 

exclusively plastic in nature. Think about 

your light sources first, which will help you 

find your palette and define your volumes. 

When you have to deal with realism, the 

most important problem to solve is the 

contrast. Try to avoid pure white and pure 

black – I usually spend a lot of time on  

this. To achieve a smooth result, I work 

with the Soft Round brush on a very low 

Opacity. Apply a lot of very light strokes, 

using a larger brush for bigger areas and a 

small one for detailing. I use a lot of layers: 

one for each element of the eyes, nose, 

month and eyebrows. 

For the flesh tones, your palette has to be 

more complex than a simple gradient. Add 

a little bit of red on the nose and the cheek 

bones, a little bit of green on the shadows, 

and a little bit of blue/cyan under the eyes. 

The hair is the boring part. Start with a flat 

very dark area and paint hair strands 

individually. It’ll take a few hours, but if 

you want to achieve convincing results, you 

need to invest the time!

Step-by-step: Bring a manga character to life

Here’s a very flat face 

with giant occular 

globes. It would be 

difficult to sculpt this 

in 3D, but manga is 

2D, so we can cheat!

My first attempt to 

paint a realistic manga 

head looks more like a 

vinyl figure. It’s 

impossible to paint 

logical volumes for  

the eyes!

1 Here’s my quick sketch. I don’t 

spend a lot of time on it because 

when you try to achieve realistic rendering, 

it’s often pointless. It’s all about volumes, 

not lines. Just define the composition and 

the proportions. 

Digital painting 

software gives you a 

lot of freedom – you 

can change 

everything in your 

picture very easily. 

Take advantage of it!

2 The face is the most time-

consuming part. I start with a flesh-

toned flat area on a layer, then define the 

volumes gradually with the Soft Round 

brush on other layers. I need to do a lot of 

strokes. My sketch is 

still on the top layer, 

and I increase or 

decrease its Opacity 

when necessary. By 

the time I’ve finished, 

the sketch will no 

longer be visible.

3 I use the same method for the hair. 

Straight and dark hair isn’t too 

difficult to paint. First I create a very  

dark-tinted area and then on another layer, 

I define the global volume. Then I paint in 

all the small hairs 

and I add the 

reflections using the 

background colour 

and white. Once 

again, I use the Soft 

Round brush on a 

very low Opacity.�
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on sale now! order your copy today at http://beta.imaginefx.com/shop

Learn to paint and sculpt traditional fantasy art using oils, watercolour, inks 
and more, in 14 new tutorials from the world’s best artists! 

  



Software guide

sketchbook pro
Our artist will guide you through this app’s functions so you can get more from this 

very effective software, including its brush libraries, workspaces and palettes.

Nick Harris
Gloucestershire-based Nick 

went digital in 2000 after 18 

years working with traditional 

methods. He works mainly  

on children’s illustrations.

www.nickillus.com

turN over to start learNiNg tHis app

| Contents |
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A
utodesk’s Sketchbook Pro 

doesn’t follow in the 

footsteps of Photoshop for 

workspace layout like some 

other software. So let’s go 

over how to access some of its core features. 

If you’re looking for a drawing focused 

software, without the bloat of the likes of 

One thing that can really help speed up 

your creative process is knowing a few 

shortcuts for transforming the canvas and 

grabbing your favourite brushes quickly.

So you have your blank canvas, you have 

the palettes you want open with all the 

tools to hand (you can toggle the screen 

clear with the tab button on your keyboard) 

and it’s time to start drawing. It’s easy to 

navigate your workspace with a Puck which 

appears under your cursor when you press 

the spacebar. Some slower machines may 

Some Selected Keyboard ShortcutS

hOw tO Set uP a wOrkSPace and uSe PaletteS

underStandIng ShOrtcutS

corNer 

laGooN

Note that useful tool tips 

appear to guide you.

You can change the selection 

to your most used.

You can change the selection 

of colours too.

The bottom two icons offer 

alternate access to various 

functions, including ‘save’. 

Spacebar – 
hold 
Opens Canvas 

Transform Puck.

V – hold
Opens Layer 

Transform Puck.

b – hold
Drag cursor to 

change brush size.

o – hold
Drag cursor  

to change  

brush opacity.

ctrl/cmd + ,
Opens the 

Preferences panel.

backSpace 
Clear selected  

layer content.

m
Opens marquee 

selection on layer – 

backspace to clear.

l
Opens Lasso 

selection.

ctrl+d/
cmd+d
Deselect.

double click 
on flood 
fill toolS
Opens ‘tolerance’ 

controls for them.

click on 
colour  
puck
Opens floating 

colour picker.

alt/opt – 
hold oVer 
colour
Colour picker.

r
Toggles ruler guide.

e
Toggles  

ellipse guide.

f
Toggles  

French Curves.

X and/or Y
Horizontal and/or 

vertical symmetry.

struggle with the option to have ‘rotate 

canvas’ active so it may need turning on in 

edit/Preferences if you want it.

there is a similar puck to transform layer 

content, which appears by your cursor 

when you press ‘V’ on the keyboard.

Photoshop and Painter then Sketchbook 

Pro (SkB) may be for you. It is still capable 

of fully rendered finishes, but it leans more 

towards reliance on old-fashioned drawing 

and painting skills. while that may sound 

intimidating, there are enough tools on 

offer to make its use a liberating experience. 

By keeping it simple autodesk delivers 

stylus response that’s almost unparalleled 

– where ‘lag’ is something you’re unlikely 

to encounter. 

until you turn them off SkB provides 

mini-guides to get you started with some 

of the palettes, but first you have to open 

them. there are various ways and we’ll 

cover some here.  
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1 On a Lagoon
Apart from the usual toolbar 

with ‘File’, ‘Edit’ etc along the top, you 

are presented with a quarter circle, 

corner ‘Lagoon’. Clicking each icon 

brings up eight further icons relating 

to tool, colour and other operations. 

Click on the icon and drag the cursor 

to the relevant icon to open it. Two 

icons (active brush and colour spot) 

inside the Lagoon toggle those 

palettes open and closed.

1 Canvas navigation
The Canvas Puck comprises an 

inner and out ring, whose markings 

indicate the function. Press spacebar to 

make it appear and then drag the cursor 

on the canvas to change of view. The 

rotate portion appears below the zoom 

portion when available. Hold spacebar, 

activate that portion and drag round as 

desired. The canvas snaps back 

perpendicular when you get close.

2 Layer transformation
Holding ‘V’ on the keyboard 

brings up a similar puck to transform 

layer contents. Move, rotate and scale 

are located identically to the Canvas 

Puck, but you are offered the additional 

option of irregular scaling using the 

small portion directly above the central 

scale portion. Dragging vertically or 

horizontally enables squashing and 

stretching in those directions.

3 Selection transformation
This is even more useful when 

you realise that these transformations 

can be applied to selected portions of a 

layer. Use any of the selection options 

offered to pick out part of a drawing 

and press ‘V’. The puck appears over 

the selection and you can transform it 

on the same layer, only committing to 

the change once you pick a brush or 

another command to continue.

2 Floating Toolbar
You can also access tools like 

symmetry, rulers and shapes through a 

Toolbar opened via Window/Toolbar or 

via the floating Puck at the bottom 

corner of the screen. All palettes can be 

toggled by their name under ‘Window’, 

including the brush and colour Pucks. 

These small floating controls for size/

transparency on brushes and saturation 

and/or luminance for colour, work by 

vertical or horizontal click dragging. 

3 Familiar functions?
SKB loads a canvas on launch, 

but to create a new one go to File/New. 

Change the dimensions using dialogues 

opened through Image/Image Size, 

Canvas Size or Crop. Save using File/

Save or File/Save as. ‘Save as’ initially 

requires you to supply a name and 

place to save, but subsequent ‘save as’ 

saves a file in numerical sequence. 

Remember to use a new name or SKB 

will continue the sequence.

Step-by-step: Accessing tools and creating a canvas

Step-by-step: Using the keyboard shortcuts

moVe

rotate Scale

moVe
Zoom

actIVate

bruSh 
PucK

colour 
PucK

Sketchbook Pro | Basic tools and using shortcuts
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while the brush palette offers plenty of 

default brushes for you to play with 

straightaway, with enough choice so there 

should be something there you like, this is 

only an introduction to what’s there. 

click on the small icon situated at the 

top right of the palette and a library opens 

up, with categorised groups of brushes 

including smeary, blender and textures. as 

you open each category, you should notice 

a small circle of dots in the top right-hand 

corner of it. clicking this opens up another 

set of controls, this time specific to 

managing and creating brushes. tool tips 

should pop up when you hover over them 

to tell you what each one is.

how good can a drawing software be for 

more technical creations if it doesn’t boast 

vector tools? well for those who just like 

drawing it can be very good.

the control Sketchbook Pro software 

offers you on ‘freehand’ brush strokes is 

extremely responsive and a renowned 

strength. however there will be times you 

may require straight lines and more regular 

shapes. the floating toolbar is the place to 

see these options displayed together. SkB 

implements shapes, guides and tool 

options in way that feels intuitive to use 

and retains that free flowing drawing 

experience. at least that’s how it feels to me 

compared to other software I’ve used. 

embrace all the toolS

create a cuStom teXture bruSh

uSIng ShaPeS and guIdeS

exPlOre the BruSh lIBrary

“While the brush palette offers 

plenty of default brushes for you to 

play with straightaway, this is only 

an introduction to what’s there”

a. draW

Make some marks 

on a clear area using 

an existing brush. 

These are just  

pencil marks.

rulerS

The Rotate/Pivot points found on the 

rulers are really useful when you are 

setting up perspective.

d. click

Double click the 

new icon that 

appears. To open 

‘Brush Properties’.

“Sketchbook Pro implements shapes, 

guides and tool options in a way 

that feels intuitive to use”

ShapeS 

Rigid shapes can still give interesting 

effects when used with different brushes. 

The new smeary brushes and blenders 

definitely have potential in that area.

b. Select

Open the library 

and choose a 

category. Click  

the little circle top 

right and click the 

‘New Brush’ option 

that pops up.

c. Select

Select the type of 

brush you want to 

create. If unsure 

click ‘Standard’. 

That’s what I  

did here.

a

b

c

d

e
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1 Management decisions
My first impression of the 

library was that it was rather large 

and unwieldy, but its ease of use to 

manage and add to the many 

brushes won me over. Moreover  

you can drag brushes from the 

library to replace anything in the 

brush palette. This makes good 

sense when you’ve tailored brushes, 

or copies of brushes to your own 

needs using ‘Brush Properties.’

2 Settings will set you free
Brush Properties panel offers 

size, opacity, loading, colour variation 

and spacing controls dependent on the 

particular type of brush. The basic range 

tends to have a smaller variety of 

controls, while more complex brushes 

have grouped controls with tabs that 

can be collapsed for convenience. Once 

you start adding your own ‘captured’ 

marks for custom brushes the 

possibilities increase dramatically.

3 Experiment and learn
Try varying the range between 

‘size with light pen pressure’ and ‘heavy 

pressure’ to see how it affects brush 

response. Do the same with other 

settings. Remember that the scale of 

the canvas you are working on affects 

the impact these settings have visually 

on the strokes. This is a key thing to 

remember when working digitally, here 

at least, size does matter. Keep 

experimenting and trying new settings.

Step-by-step: Understand the ruler, ellipse and curves tools

Step-by-step: Using the Brush Library and Brush Properties

e. adJuSt

Click the ‘Texture’ 

tab, select your 

settings and click 

‘Capture’. Adjust the 

circle size (‘B’+drag) 

to cover your mark 

area and click on it.

F. refine

Play with the brush 

property settings 

until you’re happy. 

1 Along different lines
Without drifting into vector 

tool territory, SKB has enough choice 

to make it a popular sketching choice 

for many designers. Ruler, Ellipse and 

Curves work with freehand drawing. 

Vertical and/or horizontal symmetry 

can be open with any of the other 

tools individually (bearing in mind 

that Ruler, Ellipse and Curves 

automatically use ‘freehand’). Marks 

made reflect the brush being used.

2 Simple but effective 
Each of the three ‘guides’, Ruler, 

Ellipse and Curves have control handles 

for scale and rotation, and constrain any 

marks made. You can’t make marks 

away from them while active. French 

Curves has an additional button to scroll 

through a variety of shapes. The Ruler’s 

rotation points act as pivots. You can 

use these guide tools in your art or as 

aids to it, experiment with them and see 

how they can affect your workflow. 

3 Shapely stuff 
The basic shapes are simple 

rectangle and oval, which can be 

constrained to square and circle by 

holding the shift key while dragging.  

The marks made reflect the brush 

selection. Apart from ‘freehand’ you 

have Steady Stroke, Straight Line and 

Polyline options to influence your 

strokes. (Straight lines can be 

constrained to horizontal or vertical 

using the shift key as well.) 

moVe moVeVertIcal Scale

cloSe

Scale cloSe

rotate

SYmmetrY 

While Symmetry is 

obviously useful for 

pattern and regular 

shape creation, it 

can be used as a 

time-saver on 

organic shapes too. 

Switch it on and 

only draw half  

an object.

F

Sketchbook Pro | Using shapes and guides and the Brush Library
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while the functionality of SkB is great 

already, you can tailor the experience to 

your own needs even more by making a few 

changes in Preferences.

as you discover your favourite tools and 

functions in a software you will want to 

have them more easily to hand. even if  

you don’t use the lagoon much at first, 

preferring the other palettes it’s worth 

diving into the lagoon tab of the 

Preferences panel to understand what you 

might be missing. It offers you the total 

control to place each tool exactly where you 

want it in that system. 

that power becomes even more potent 

when you learn that each icon/selection 

Some thINGS areN’t SoFtware SPecIFIc

MaSter layer FunctIOnS

adjuStIng and uSIng PreFerenceS

every decent software package that has 

layers delivers a dedicated palette with 

certain functionality. In this section I’m 

going to quickly go over where and what 

SkB has on offer.

layers add a whole world of potential to 

any drawing/painting software and SkB 

has enough options to make their use 

straightforward and powerful. this 

includes a way to identify layers that I’ve 

not seen in other software. we have to  

start somewhere so why not with that?  

It always pays to name layers for 

organisational purposes.

to get to the dialogue to accomplish  

that, first click on your chosen layer and 

drag the cursor right to the icon with an  

loW hue Variation

Using low values of around  

10 per cent or less on hue 

variation for brush settings  

will naturally tend to bring a 

degree of randomness into your 

colouring that will enliven things 

generally. Alternatively of 

course, try turning it up for 

wilder results!

SWatch pane

Organise your swatch pane in 

an order that works for you and/

or for the needs of the particular 

image you are working on. If 

you reset it regularly, consider 

taking screen-grabs to save 

favourite versions that you can 

load as an image to sample 

colours from.

paper teXtureS

Sketchbook Pro architecture doesn’t 

support ‘paper textures’ but you can still 

have a natural media look using texture 

brushes. Plus you can always paint your  

own textural layers to sit under and/or  

over anything you create. Start a 

dedicated folder to keep any 

‘papers’ that you create  

and collect.

No layer maSKS? No Problem

Step 1

Duplicate your layer.

Step 2

Now lock the copy layer and  

paint with your chosen  

‘shadow colour/s’.

Step 3

Leave the layer locked and paint 

lighter areas, or unlock the layer 

and erase what you don’t want. 

‘a’ on it. now you can click in the text box 

and replace what’s written there. 

at the same time the default setting is  

for the display to show what’s on the layer 

visually. however for times when that  

isn’t clear enough to see, you can un-tick 

the ‘show me what is on the layer’ box, 

press ‘clear image’ and write or draw 

whatever best suits you as a reminder  

to mark it.

“Layers add a whole world of 

potential to any painting software 

and Sketchbook Pro makes their use 

straightforward and powerful”

can be made to appear under your cursor 

on the canvas – by right clicking for the Pc, 

or stylus clicking on a tablet. 

nor are you limited by category. For 

example, you could have your favourite 

four brushes, symmetry, ruler, flip 

horizontal and save – or any other 

combination you choose.
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1 Layer palette icons
Four icons along the top of 

the layer palette access ‘Add new 

layer’, ‘Add New Text Layer’, ‘Add 

Image’ and ‘Clear Layer Content’ (or 

press backspace to clear a layer). 

Adding an image can be set to 

create a new layer with it on or to be 

added to the current layer. The small 

eye icon toggles layer visibility. You 

cannot work on a ‘hidden’ layer. The 

blue vertical strip is an opacity slider. 

1 Maximise the options
Having to move the cursor away 

from the canvas repeatedly to change 

tools is annoying and a waste of time. 

Save time by customising the first 

Lagoon icon settings to bring your 

favourite tools to your fingertips and 

using ‘swap between two brushes’. 

(Shortcut – S). Click it when changing to 

a different brush. Click it again and it 

reverts to the last one and so on. It can 

effectively add an extra brush to the 

eight tool options there already.

2 Preferences change
Remember that preference 

settings can be tweaked quickly at any 

time to suit your current needs. You can 

elect to have a transparent background 

instead of opaque white on all your 

images for example. Choose whether to 

save as tiff or PSD by default, 

dependent on what you plan for your 

images. Change whether images 

imported to a project are saved to the 

selected or its own layer. Everything can 

be reset in ‘Factory Defaults’. 

3 Customise the  
Brush Palette

If you prefer using the Brush Palette, 

move all your favourite brushes to the 

top. Open the library by clicking the 

small double bar icon at the top right of 

the Brush Palette, navigate to your 

favourites and drag them to the palette. 

Reduce the need to refer to the library 

by placing all your favourites near the 

top of the brush palette. Also remember 

you can have different versions of the 

same brush with a variety of settings.

2 Layer blend modes
Directly below the four icons sits 

a control for layer blending modes. 

Autodesk has avoided the temptation 

to load up a plethora of modes you’ll 

probably never use, going instead for 

four you almost certainly will: Normal, 

Add, Multiply and Screen. If you’re not 

already familiar with the effect these 

settings have, spend some time playing 

with swatches of colour on a few layers. 

You’ll soon get the idea.

3 More icons
To the right on each layer 

representation are two more icons. 

Press the upper one and drag to 

move layers up and down in the 

stack. Toggle the lower one to lock 

and unlock content transparency – 

useful in the absence of ‘layer masks’ 

for restricting paint areas. You’ll also 

find ‘Lock Layer’ within the pop-up 

that appears when you click and 

hold on a layer. 

Step-by-step: Understanding the layer palette

Step-by-step: Improve your workflow by tailoring the software to your needs

Sketchbook Pro | Using layers and customising settings
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artists
panel

Brynn Metheney
Raised in the High Desert of 

California, Brynn has a passion 

for creature and world design. 

Her clients include Dark Horse 

and Wizards of the Coast.

www.brynnart.com

Kinman Chan
Kinman studied at Gnomon 

School of Visual Effects, and 

has worked for Disney and 

Lucasfilm. He also owns 

Kincept Co.

www.sparetimer.blogspot.com

Lauren K Cannon
Lauren is a freelance artist 

who works digitally and 

traditionally. She creates art 

for book covers as well as 

personal clients.

www.navate.com

Jon Hodgson
An experienced artist who has 

over 50 book covers to his 

name, Jon has an enviable CV.  

He is currently the art director 

on the Dr Who card game.

www.jonhodgson.com

Paco Rico Torres
Paco is a freelance illustrator 

living in Spain who’s produced 

art for several card games, 

magazines, books and 

roleplaying games.

www.pacorico.blogspot.com

Francesco Lorenzetti
A freelance video game 

concept artist living in the 

North of England, Francesco 

loves painting creatures and 

emotive environments.

francescolorenzetti.blogspot.com

Charles Guan
A video game concept artist 

working in Canada, Charles 

has created characters for the 

most recent SSX game on 

PS3 and Xbox 360.

fantasticfunmachine.blogspot.com

Bill Corbett
Bill works as a freelance artist 

producing illustrations for 

media groups, public relations 

companies, small businesses 

bands and private clients.

www.billcorbett.co.uk

Cynthia Sheppard
A freelance fantasy artist with 

a background in traditional 

painting, Cynthia likes to bring 

classical techniques to her 

digital art.

www.sheppard-arts.com

Tony Foti
Tony is a US freelance 

illustrator who contributes to 

D&D, and Fantasy Flight 

Games’ Star Wars and The 

Lord of the Rings games.

www.tonyfotiart.com

Mark Facey
Mark is a freelance illustrator 

who loves creating creatures. 

Visit his blog and ask him any 

questions you like, so long as 

they’re about art!

www.creaturejournal.tumblr.com

Mark Molnar
Mark is a concept and visual 

development artist. He’s busy 

doing freelance work for 

international film, game and 

animation companies.

www.markmolnar.com

Nick Harris
Gloucestershire-based Nick 

went digital in 2000 after 18 

years working with traditional 

methods. He works mainly on 

children’s book illustrations.

www.nickillius.com

It’s the shadows that  

have the most dramatic 

impact on form. 

Tony foTI
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Core skills

how to paint 
environments
Master the art theory behind painting environments and put it into practice 

in these bite-sized but essential workshops.

TuRN oveR To diG iNTo eNviRoNMeNTS

Contents | Environments
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111 112

download

your fIles

Accessing your workshop files 

Click or copy and paste the above link into 

a browser to download the files to a 

desktop PC or Mac. Do the same 

to watch videos where you 

see the icon. 

link  
www.bit.ly/ifz12-enviro

  



Artist’s advice
Jon says

Painting complex and ‘deep’ 

landscapes such as mountains 

can seem like a tough challenge, 

but it can be surprisingly simple 

once you’ve learned the basics. 

The first step is to know your mountains. 

Get out into the wilderness with a camera, 

or do some searching in books and online. 

We never copy found images – it’s likely to 

be illegal and unethical – but we can use 

them to learn the visual vocabulary of 

rocks. Understanding what we’re looking at 

is the next thing. Drawing from life will be 

the biggest help, but some theory to back 

that up is important, too. 

Atmospheric perspective is very well 

explained online, but in short, as things get 

further away they become paler and bluer. 

Another important element in any 

mountain scene is overlapping. Our brains 

tell us that one thing is behind another 

because of overlapping. Get lots of that in 

there. Also, have some elements heading 

into the scene in perspective. A winding 

path, a rope bridge, a river – all of these 

things work well for the task. These also 

bring a narrative element. 

Narrative elements are crucial in 

illustration: they prompt us to imagine the 

moments before and after the moment 

depicted in the scene. As well as expanding 

the world beyond the edges of the canvas in 

physical terms, narrative elements bring the 

piece to life in terms of passing time. Lastly, 

add in something that gives the image a 

sense of human scale – such as a person!

The best way to…
paint a steep mountain pass, giving  

the impression of depth

Step-by-step:
Break a 
mountain scene 
down into steps

1  A mountain pass can be 

complex, so break it 

down into big shapes. Make 

showing depth a priority and 

use colour and overlaps without 

much detail to define the 

composition. Colours are less 

saturated and more blue the 

further away they are. Overlaps 

create depth by showing one 

object behind another.

2  This is the simplest step 

but crucially important 

for the final image: I take a scan 

from some real, highly textured 

paint and drop it on top of my 

simple image as a Multiply layer. 

This starts to break up the 

simple forms with some rough 

details. You could stop here! It’s 

a nice graphic image with 

everything we need in place.

3  The painting part is really 

about embellishing a 

strong foundation. Keeping the 

colour within the broad guide 

laid down by the initial blocky 

‘sketch’, add all that mountain 

goodness, using reference 

where needed. You can do as 

little or as much as you like. I 

took it quite far, and in the end 

had to force myself to put the 

stylus down.

Build in a human scale with some figures, and imply 

depth with the narrative device of a path wending its 

way deep into the image.

The final painting shows everything working 

together: atmospheric perspective; overlapping 

graphic and narrative elements; and human scale. 

While it looks complex, the foundations are 

extremely simple.

Artist’s 
secret
Painting 

by ErasEr

A new layer, some 

low Opacity spray 

from a Soft/Airbrush 

tool, and then a nice 

sharp eraser can 

create depth and 

distance easily and 

accurately. Use this 

secret to sharpen 

edges, and add a 

misty atmospheric 

perspective to soften 

distant areas.
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Artist’s secret
Painting lEavEs  

in thE sun

The brightest yellows in a forest canopy are 

usually seen on the undersides of leaves as 

the sun shines through them. Contrary to 

intuition, the tops of green leaves in bright 

sunlight have highlights which are closer to 

grey-green than yellow.

How to…
create a futuristic urban 

scene quickly 

An easy way to…
draw forest scenery with  

realistic lighting 

This is the base for all the detail. Paint distant buildings in lighter shades to 

create depth, and play with light shadows and perspective.

Artist’s advice
Paco says

Normally the more time you put into an illustration, 

the better it looks, and painting a city, even one with 

stylised details, can be time-consuming. But 

sometimes you don’t have much time, or you simply 

want to paint some background quickly so you can focus on the 

foreground. Then you can reduce the shape of the city to big 

blocks of colour and light. Simply do a line drawing of the city 

and, most importantly, plan the lighting of the scene. To make 

things even faster, you can create it using a 3D program like 3D 

Max or SketchUp and use it as a reference. 

Then, using the Lasso and Selection tools in Photoshop, create 

big blocks of colour matching the line work: just focus on the 

silhouettes of the buildings and the most intense shadows to 

begin building your cityscape. Once you have it, fill the blocks 

with ‘texture’ – for example create a square grid, and paste it on 

the buildings to make windows, then use Photoshop’s Transform 

command to adjust the perspective – and add all the details.

You should note that the leaves at the sunny edges 

have more contrast against the background.

blobs to more detailed leaves and twigs. 

Like each leaf, clusters of leaves have their 

own forms with a light side and dark side. 

Work from the general to the specific: from 

larger forms to smaller, more refined shapes. 

I’ve used short hatch marks and a square 

brush to suggest individual leaves, but you 

can get as detailed as you like. 

Even if you plan to draw every single leaf, 

it helps to get the suggestion of individual 

leaves down first so you don’t lose the forms 

you created in the last step. To make the 

outer edges of the sun-soaked leaves glow, 

paint over them with bright yellow-green on 

an Overlay layer.

Artist’s advice
Cynthia says

To achieve realistic golden 

lighting in a forest, break up 

your composition into 

foreground (1), middle 

ground (2) and background (3), using 

three distinct values. I’ve used abstract 

shapes to map out the strong light in the 

middle ground, and the almost entirely 

black silhouette in the foreground, to 

give the effect that we’re looking into a 

clearing from deeper woods. 

Once your composition is set up, start 

defining the general shapes of the leaf 

clusters and trunks with a large brush. 

Keep refining your shapes from coloured 

When painting a landscape scene, it 

helps to start out by using three distinct 

values and abstract shapes to separate 

the foreground, middle and background.
Using selections you can quickly create simple 

scenes. Try to use clean, geometric shapes.  

The Transform command and Selection tools  

are your best friends here.

Core skills | Environments
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Artist’s advice
Brynn says

Making an alien landscape 

feel real starts with 

landscapes here on Earth 

– we can use what we can 

see to inform our paintings. For my 

painting, I want to create a rocky, desert-

inspired landscape. Looking at deserts 

in Utah, Arizona and the Gobi Desert, I 

see how wind and rain affect rock and 

how they carve the stone and shape the 

sand. Using atmospheric perspective, I 

push the depth of the piece. 

It’s also important to consider 

lighting. The sun in my piece is bright, 

Artist’s advice
Charles says

To start, I create a master 

shot to rotate. I draw it in a 

top-down view to help 

visualise the space. I also 

create a perspective grid for measuring 

the relationships of objects. I measure 

distance in the painting by connecting 

the ground contact point of an object, 

and following the perspective grid to the 

next closest ground object. For height, I 

draw upwards to the top of an object 

and define relationships in the distance 

by drawing through in perspective from 

both the ground and top of the object.

To create the second shot, I focus on 

laying out the big objects in the scene 

but because of the dense atmosphere, it 

might not be a strong light source. Adding 

further elements such as bizarre-looking 

plants and a large planet in the distant sky 

helps make the landscape feel otherworldly. 

first, such as the walls and the ground.  

From there I start drawing one item at a 

time to use as an anchor for measuring 

distance from one to another. Most 

important is defining where objects are 

sitting on the ground plane. The more the 

objects in a scene relate to each other, the 

easier the process becomes.

Artist’s advice
Francesco says

Lighting a scene is like playing a game of chess: 

knowing in advance where to put your pieces will 

enable you to say checkmate before you know it! 

Lighting emphasises the aspects of a painting, such 

as composition, storytelling, impact and realism (including 

material, visual effects and atmosphere). The use of blocks of 

light can also help to affect the painting’s mood, making for a 

more dramatic composition.

In this image that I’ve created for a personal project you can 

see there are two masses of light, while everything else is 

immersed in shadow and penumbra (partial shadow). One of 

the blocks of light is ambient, and the source is so great that it 

sheds light on all sides (like the sun or a big explosion). The 

second is a block of artificial light: the light is directional  

and may be generated by luminescent panels, or a strong  

source of energy. 

It’s fun to play with artificial light, especially in a space 

painting. But you must place them in a strategic manner to 

create the most engaging and refined image. 

Using the master shot (below) I’m able to make 

judgements about the height of objects in relation to  

each other. The more objects you put in a scene, the 

easier it is to make these measurements.

The master shot: notice how the orange always 

follows the horizon line and vanishing points, and 

continues up to help define height relationships.

Use references to paint elements the viewer will 

be familiar with, but use unusual colours and 

compositions to create a familiar but alien world.

Learn to…
use blocks of light for an 

impressionistic scene 

Discover how to…
paint the same scene from a  

different perspective

A good way to…
create an alien landscape  

that feels real

I like lighting solutions that result in an 

impressionistic, dramatic-looking image.

I used dark silhouettes to create spaceships surrounded by light tones, which 

is an effective way to create contrast and depth between elements and the 

environment. Clean silhouettes and strong contrast give a realistic look.
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Artist’s secret
CrEatE a rEflECtion

The easiest way to create a reflection is to 

mirror everything above the surface of the 

water horizontally and blur it slightly. I use  

the Motion Blur filter at 90 degrees, which 

gives the natural feel of distorted reflections  

of still water.

Step-by-step: Paint a ‘known’ alien world

1  I start with a pretty basic  

landscape, only focusing on the 

rock and the atmospheric perspective. 

Using references from various deserts and 

rocky environments here on Earth, I begin 

to get a good feel for what a similar alien 

landscape would look like.

3  Finally, I focus on populating the 

world with odd-looking plants and 

tiny, drifting seed pods. This helps sell the 

planet’s history and develop a narrative for 

the view. Again, they’re elements known to 

the viewer, but placed in an unusual 

setting and with different colouring.

2  I add a large planet in the sky to 

ensure that the landscape feels less 

like Earth. The colour of the sky and rock 

are crucial elements in the image too. 

Playing with the viewer’s perceptions in 

this way can make an alien environment 

still feel familiar. 

Artist’s advice
Mark says

The key to painting realistic 

water in any type of 

environment is to generate 

believable reflections. In the 

case of a swamp or flooded wasteland it’s a 

little easier, because there are fewer 

elements that could disturb the surface of 

the water and create waves. There are no 

underwater currents, and there is little 

movement in the air above the water 

because of the dense undergrowth.  

The water will cover dead and rotting 

vegetation, so any areas underwater are 

always going to be much darker than the 

environment above the water. Because of 

these factors the reflection will be clean and 

only the colour of the water itself will 

darken it slightly.

I leave the reflections until the last step 

in my painting process. I’m only blocking 

in the rough shape of the water surface with 

a solid colour. After I finish painting most 

of the environment, I’ll copy out everything 

to a separate layer and mirror it at the 

meeting line of the main landmass and the 

water. I like to blur it slightly to give a more 

natural feel to the water.

After this I paint various parts of 

vegetation to break the smooth surface of 

the water – branches poking out, patches of 

plants, scattered duckweed and so on. It 

will also give more realism if you create 

small islands to suggest that the depth of 

the water is uneven. The only thing you 

have to watch out for here is making  

sure that you create similar reflections for 

these new details.

I use a limited palette for these types  

of paintings, because there isn’t a 

characteristic light source providing any 

direct light. I use a mixture of desaturated 

greens and browns to suggest the plants 

and vegetation, and choose a lighter  

bluish tone in the background to show  

the humid air.

I imagine a space 

explorer arriving on a 

swamp planet. He’s 

found the abandoned 

hives of the creatures 

who originally lived 

here. I want to create a 

mysterious image – 

something that brings 

up more questions  

than it answers.

Master the best way to…
paint realistic-looking water in an environment, 

such as a flooded wasteland
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link
www.bit.ly/ifz12-snow

Artist’s advice
Tony says

The trick to painting anything 

with form – be it snow, rocks or 

feet – is all in the lighting. If 

there’s a single light source, the 

shadow patterns that result will more 

clearly define the surfaces they’re moving 

across. Rembrandt was such a fan that a 

strong, single light source moving across a 

face from the side is now known as 

‘Rembrandt lighting’. Not only do the 

number of light sources have a big effect, 

but the hardness and direction of the light 

play a big role as well.

As a matter of fact, you can think of 

shadows as the glue that holds everything 

in place three-dimensionally. In the case of 

overcast weather, the clouds absorb and 

emit a lot of light down on to the ground, 

so cast shadows are faint. As a result, photos 

on a cloudy day rarely emphasise form in 

the way sunlight does.

Shape, value and edges all play 

important roles in describing the bumps 

and curves of an object. However it’s the 

shadows that have the most dramatic 

impact on form.

If there are too many 

tonal shifts in an area, 

unwanted focal points 

can spring up. So try 

drawing with hue and 

saturation while 

keeping the values 

close together. Detail 

can be added without 

sacrificing the design  

by controlling your 

lights and darks.

The best way to…
paint a snowy landscape that has form, using 

shadow and even colours in the snow 

Step-by-step:
Depict a snowy 
mountain scene

1  If we want to make the 

snow feel three-

dimensional, first focus on 

descriptive lighting. A quick 

sketch of the planes will help 

you understand where the light 

rays will hit. Placing the sun a 

bit low and to the right of our 

scene will create longer, more 

descriptive shadows.

2  With the sun placed for 

optimal cast shadows, it’s 

time to focus on the shapes. For 

cast shadows, think of light as 

water coming out of a tap. From 

a large source like the sun, it 

hits everything at a consistent 

angle. Be careful with your 

shadow shapes – they define 

form as much as the light side.

3 The colour of the sky is 

reflected in the shadows. 

Here the cool blues help our hill 

feel like frozen water. For soft, 

powdery snow, the transitions 

are more gradual (although 

avoid anything so soft it feels 

like mist). Icier snow has more 

highlights (reflections), so treat 

with harder edges.

Working out a lighting scheme 

– and the shadows that this 

creates – is the key to a 

successful painting.
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An easy way to…
maintain accurate perspective  

in a painting

How you should…
paint cloud cover over  

a bright moon

Discover how to…
achieve detail and realism  

in a night scene 

Artist’s advice
Bill says

The best way to maintain 

accurate perspective in 

your painting is to create 

your own perspective 

grid. The first line I draw is a straight 

horizontal line across the page, 

known as the horizon. It represents 

the eye-level of the viewer and it’s at 

this line that all objects in the 

distance disappear. 

The next thing I establish in the 

image is the vanishing point. This is 

the point where all linear lines from 

the foreground converge at the 

horizon at a single point (think of 

railway lines disappearing into the 

distance until they meet at one spot). 

With this in mind I draw a line at the 

bottom of the page and divide it into 

equal units. From each point I draw a 

line back to the vanishing point, 

until I have something that looks like 

a ploughed field disappearing into 

the distance. 

I now draw a line from the first 

unit (bottom left) at an angle so that 

it meets a point at the horizon at the 

far right (the measuring point). 

Finally, where the new line intersects 

the other lines I draw a straight line 

for each intersect to create the grid  

in perspective. 

Artist’s advice
lauren says

Clouds are always 

about how you handle 

the combination of 

softness and detail. 

The basic mistake with any kind of 

cloud is to make it too airbrushed 

and misty. In the case of a bright 

moon, where the clouds will be 

strongly backlit, it’s crucial to 

commit to edges, shapes, textures 

and colour shifts.  

Start by blocking in the sky and 

moon without the clouds, then 

add the clouds on a new layer with 

a good ‘cloud brush’ – a fluffy, 

textured brush that creates organic 

shapes. By varying the size of a 

brush like this, and switching up 

your colours, you can create a 

great base for your clouds in very 

little time. Then add in details and 

edges where necessary.  

Remember the moon’s light 

radiates outwards and will light 

the sky around it accordingly. Also 

remember that clouds are 

vaporous, not opaque. The light 

will shine through with different 

strengths all over the cloud’s form. 

Most importantly, use artistic 

licence to prevent the sky from 

looking too busy or crowded.

Artist’s advice
Mark says

The two easiest ways  

to add details and 

realism to a night 

illustration is by using 

natural and artificial light sources. 

The natural light source could be 

the moon, which has a cold, 

desaturated colour. Consider using 

warmer, more saturated colours 

for the artificial lights. This can 

create depth and you’ll also use 

these lights to reveal the original 

colours of objects in your image.

Using the moon as a light 

source enables me to introduce 

some aerial perspective and subtle 

value changes. For the main focal 

points I use the mech’s warm 

artificial lights. This helps me not 

just show the original greenish 

tone of the swamp, but with using 

a complementary colour pair 

(blue-orange) I can separate my 

main focus from the background.

Shape, texture and contrast are all 

important in painting clouds in a 

dramatic lighting situation, such as in 

a moonlit sky.

There’s nothing like a perspective grid 

to bring out the 70s 3D retro in an artist. 

It’s just one example for using a 

perspective grid.

In a night scene, 

focus on the 

silhouettes and 

slight value 

changes to create 

depth (Top left). 

The artificial light 

helps reveal the 

original colours  

of the objects 

(Bottom left).

Any line that crosses diagonally through a square creates a dividing line, which is perfect for 

extending the grid without having to draw off the page.
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Artist’s secret
at thE World’s End

If you want to further exaggerate the 

appearance of height from the top of a tall 

structure, curve the horizon line in the 

distance. Because the earth is spherical, the 

horizon appears more dramatically curved the 

further up you travel.

Add two points on the horizon line and one 

point below to employ three-point 

perspective. Then add Radial Blur with 

Zoom set to 10 per cent.

The template is the key to 

getting the staircase 

drawing accurate in 

perspective. In simple 

terms, it’s like looking down 

on a tube within a tube.

Here’s a creepy turret in an 

old castle. The work put 

into getting the perspective 

right will certainly pay for 

itself when you draw  

your staircase.

Artist’s advice
Bill says

The method that I’m explaining here can be used  

to draw a spiral staircase at any angle and at any 

size, and although not the simplest thing to draw, 

the only thing that’s really required is patience and a 

good knowledge of perspective.

The principle of drawing the staircase is based on a linear 

template; a circle drawn in a square with another smaller circle 

drawn within the larger circle. The outer circle is then divided 

into segments to create the steps of the staircase. 

With this template I can create a stack of layers to represent 

each step of the staircase. Imagine a stack of cakes where only 

one slice from each cake can be seen. Each slice is placed in 

sequence around the central axis (essentially a staircase).

It’s worth noting that a circle is traditionally drawn within a 

square, because a circle in perspective is actually an ellipse. The 

edges that touch the sides of the square will do so in the same 

places in the perspective view. 

A square is also useful for creating the guidelines for drawing 

each level of the staircase in perspective. As such, it’s a good idea 

to have a smaller square for the inner circle, too.

Another thing to note is that when using a perspective grid to 

create the first square it’s important to remember to divide the 

square horizontally, vertically and diagonally. This will create 

the first eight segments for the staircase for you and make it 

easier to divide the circle into additional segments. Time and 

care will certainly reward you here!

An easy way to…
draw a spiral staircase  

in perspective

Artist’s advice
Cynthia says

A painting featuring dizzying 

height requires exaggerating the 

distance between the viewer 

and the ground, putting the 

farthest-away element right next to the 

closest one. One of the best ways to achieve 

this effect is using three-point perspective. 

This is a technique often used in comics 

when the artist is rendering a city or  

group of objects from a very high, or 

very low, vantage point. 

In my example here, you see a pair of 

feet – the viewer’s – standing on an edge, 

which looks directly down over a tiny 

cross-section of traffic, from an almost 

straight up-and-down aerial view. I also 

use atmospheric perspective – the 

principle that things become cooler in 

hue and more muted as they recede 

further into the distance – to enhance 

the feeling of being up high. Being able 

to see where the sky meets the horizon 

helps us feel like we’re looking down on 

the landscape from a greater distance. 

Finally, the effect is completed by 

applying Radial Blur with the centre 

point aligned on the focal area at the 

street intersection, making it look like 

we’re almost falling over the edge and 

creating a sense of dizzy unease.

Looking straight down from an 

aerial perspective creates  

the feeling that the viewer could fall 

to their demise at any time.

A good way to…
depict a vertigo-inducing  

sky high scene
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unique textures and patterns different from 

their surroundings, and the camera lens 

may also distort those textures. A macro 

lens, for instance, shooting an ant on dirt 

will look completely different than a 50mm 

of the same subject.

Point of view or camera angle: being 

high above ground or low to it will affect 

how we treat our depth cues. A low camera 

angle means we have less canvas space to 

show depth, so each brush stroke should be 

carefully considered.

Here’s my Photoshop painting of an 

aerial landscape with a few buildings. Each 

area of space has a different treatment of 

texture. I don’t work methodically when I 

paint environments, so to demonstrate I 

share a few of the key thoughts below.

Discover how you can…
use texture to emphasise perspective 

Artist’s advice
kinman says

Texture plays an essential part 

in emphasising perspective –  

so much so in fact that I use it 

with almost every brush stroke 

that I put down. Texture solutions will 

differ for each piece, but here’s some 

general food for thought.

Large establishing shots: we want to be 

thinking about the agriculture, living 

spaces, districts or terrain over large areas. 

Having miniature stories to tell will make it 

easier to decide how to disperse textures 

throughout the piece. The ability to see 

buildings and structures as simple shapes of 

texture and pattern will also be of use.

Intimate shots: when showing space in 

close quarters, be sure to pay attention to 

the details of all elements. Every object has 

Step-by-step: Paint a visually interesting landscape

Think of agriculture, 

living spaces, districts 

and terrain to 

determine textural 

grouping and mapping 

on a larger scale.

The perspective grid 

can help with the 

separation of spatial 

textures, patterns, 

colours, values  

and edges.

1  Start by establishing a clear 

foreground, mid-ground and 

background (A, B, C). I think of these 

separations as card cutouts on a spatial 

grid, and it’s common to separate these 

‘cards’ via distinct 

values. Alternatively, 

we can separate by 

hue and saturation, 

as long as they’re 

defined clearly  

(not recommended 

for beginners).

2  The cards made in Step 1 will 

become the guides for the next 

steps. Here I divide each card into three 

separate levels, and we can begin to make 

decisions to separate (again) each level. 

Any of the technical 

approaches to do 

this (colour, pattern, 

texture, value and 

edge) apply, so long 

as they feel different 

from each of the 

other levels.

3  Once the first two passes are 

defined, fine-tuning begins. Each 

level we’ve separated can be divided again 

into smaller zones to make look different. 

These differences have a hierarchy: step 1 

having the largest 

set of differences, 

step 2 having  

slightly less, and so 

on. Continue 

dividing and refining 

as long as your 

patience allows!

Artist’s secret
graysCalE ChECk-in

Paintings should also read well in black and 

white. I find that having a Grayscale 

Adjustment layer helps keep my eye in check  

as I’m painting. Turn this layer on to ensure 

that the basic spatial relationships haven’t 

veered off course. 

Core skills | Environments
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This is an intermediate stage. I refine 

the composition and volcano shape, 

then add magma and atmospheric 

effects such as smoke and fog.

I decide to push the vertical shape 

of the volcano, avoiding the usual 

cone shape to make it more  

visually interesting.

A good way to…
paint a spewing volcano, without 

it looking like a runny egg

How to…
add more colours to 

something monochrome

How you should…
paint a convincing-looking 

nebula for a space scene

Artist’s advice
Francesco says

I’m using this question to 

try and explain the ideas 

– and my assumptions – 

that are involved when 

I’m painting an environment, in  

this case an interesting volcano. A 

volcano is a geological formation 

that changes shape over time 

primarily through the red hot 

magma coming out, which cools and 

becomes solid, forming new 

channels over time.

In this concept painting I imagine 

the volcano as a bubbling cauldron 

that’s full of magma, and when 

there’s a full moon the magma rises 

because of tidal pull. This astronomic 

phenomenon brings the magma to 

the top, where it escapes from the 

edges, leaking out so the volcano 

starts gradually raising.

It’s interesting to think about how 

the volcano could have become 

active in the past. In this case there 

were many earthquakes that have 

caused landslides, due to the 

movement of tectonic plates in  

the region.

The abundant spills of magma 

create large incandescent rivers that 

over time have formed valleys and 

canyons. These are considerations 

that may suggest ideas for your 

environment scenarios. In general 

when I want an element to stand  

out in a concept or illustration I try to 

put it in a context that contrasts with 

its surroundings.

Artist’s advice
Francesco says

A lawn, say, may seem 

like a solid shade of 

green, but it contains 

many other colours. 

Even a small patch of lawn reveals 

glimpses of soil, clumps of dried 

grass and other species of grass. 

Light also plays an important 

role. Painting light and shaded 

areas creates a lot of chromatic 

variations. In this image I use a 

Artist’s advice
Mark says

Nebulas are huge 

interstellar clouds 

made up of dust, 

hydrogen, helium and 

other gases. I always start a space 

scene with a black background and 

work with a really big sponge-like 

textured brush. Then I start on 

depicting the nebula. First I lay 

down the base colour of the gas 

cloud, that has a middle saturated 

red, and then try to come up with 

an interesting shape. 

On top of that I use other 

colours, on Overlay and Color 

Here’s a concept of  mine that has 

been reclaimed by nature.

Create depth by varying the softer, 

blurrier areas and harder areas

green/yellow in the light area, 

which shifts to a cold blue tone in 

the shadows. In some areas I use a 

warm tone to differentiate the type 

of vegetation, showing where the 

orange-brown shrubs are growing.

This is only a piece of concept 

art so I don’t detail the grass and 

flowers much. This approach helps 

you be more aware of colour 

choices when painting.

Dodge layers, to give the clouds 

more diversity. I create the three 

brighter spots in the middle. From 

this point I only focus on these 

areas of the image.

Create a feel of depth by varying 

the saturation and value of the 

clouds. Another trick is to create 

softer/blurrier and sharper areas.

Finally add the stars. I use a 

simple splatter brush and cover the 

whole image with small dots. Then 

I erase back the stars with the same 

textured brush that I used for 

painting the clouds.

Soft areas

Hard areas
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Artist’s advice
Paco says

Painting holograms, or any 

other kind of translucent, 

luminous effect, is easy using 

Photoshop. The method  

I use is simply painting the hologram in a 

layer, then setting the layer mode to Screen.

A Screen mode layer brightens 

everything on lower layers, based on its 

own luminance. That means if a Screen 

mode layer is completely white, you’ll see 

everything white; if it’s filled with black you 

won’t see any change because it’ll be like an 

invisible layer; and if it’s filled with grey, 

you’ll see the background but 50 per cent 

brighter. It acts as if you were painting with 

light instead of paint. So a Screen layer is 

perfect for painting something like a 

hologram, which is essentially light.

Remember that holograms are supposed 

to cast light. The light from the hologram 

should be visible on, and affect, the 

surrounding areas. 

There are no rules on what a holographic 

interface should look like, so let your 

imagination run free – and try to get some 

fresh ideas. In this case I made the edges of 

the holograms slightly blurry, and also 

made a copy of the hologram in the 

background and pasted it over the original 

one, a bit displaced, to make it look like a 

failing, damaged device. But those are just 

ideas. Enjoy trying different effects!

This is how the 

hologram looked before 

I set the Layer Blending 

mode to Screen and 

used the Transform tool 

to give it perspective.

An easy way to…
paint holographic interfaces  

without making them look solid

Step-by-step:
Light a scene  
using holograms

1 Even though I haven’t 

painted the holograms 

yet, I have them in mind for a 

light source and colouring. 

Make the light from the 

holograms affect the elements 

around them so they look 

natural. I paint the holograms 

– flat and not in perspective – 

on separate layers.

2  I flip the holograms 

horizontally, because the 

viewer will be viewing them 

from the rear. Then I adjust the 

perspective of the holograms 

using Transform in Photoshop 

(Edit>Transform). If you haven’t 

tried that before, practise with 

the Skew or Distort commands 

in the Transform sub-menu.

3  I adjust the Opacity of 

the holograms and give 

them extra light by adding two 

new layers over the top: one set 

to Soft Light with blurred light 

blue brush strokes on it; the 

other set to Overlay mode with 

lighter blue brush strokes. Both 

have Gaussian Blur applied and 

are at a low Opacity.

Using Screen, Soft 

Light and Overlay 

layer modes, and with 

the correct lighting of 

the surroundings,  

you can easily  

create non-solid 

looking holograms.

Core skills | Environments
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link
www.bit.ly/ifz12-sw

Artist’s advice
nick says

A simple way is to use swirling 

shapes. A swirl effect will focus 

the eye on what’s at the centre 

of the image, be it the cause or 

the target for its presence. They present a 

useful way of pulling in the viewer. 

An easy way to achieve this is to employ 

radial or zoom blur filters, offered in 

Photoshop and other software. But the 

downside is that they may jar in a more 

painterly piece. No problem. All we’re 

talking about really is controlling the 

direction and smudge/blur of brush strokes.

Using an oval/circle as a guide, follow its 

arc to lay down an appropriate array of 

marks using whatever brush you choose.  

If the guide is on a separate layer, just lose it 

later when finished – and make sure that 

Don’t be tempted to 

introduce too much 

detail. It will detract 

from the feeling  

of movement. 

The best way to…
draw the viewer’s eye around an  
image to focus on a final point

1  I sketch a rough idea using  

ArtRage oils. My swirl is based on a 

flock of birds but there’s no need to paint 

every feather. I pose the figure as though 

he’s being spun around by the force, to 

support the feeling of movement. I need to 

account for perspective for elements 

around the arc – flight direction and  

size, for example.

2 I place the idea into a composition, 

and then I start to block in some 

background shapes and colours. I choose 

darker tones for that, keeping the swirl 

light in contrast. I start to hint at shapes in 

the counter-clockwise movement. Using 

the multi-colour ‘grit’ glitter, I introduce 

texture that I then soften with the ‘wet’ 

palette knife.

3  I build up marks that follow the arc 

of the swirl and strengthen the 

feeling of movement. Notice the direction 

of the grass as the swirl passes near it. I 

then bring in another figure being swept 

off their feet to show the force of 

movement, and add elements dragged  

off the background to the cocktail to  

help integrate it.

Step-by-step: Put a new spin on your fantasy art

you cover it with paint strokes if it’s on  

the same layer. This works with Painter’s 

image hose and ArtRage’s sticker spray 

brushes, too. 

Remember to incorporate perspective in 

your arc and dab size if appropriate. Dabs 

closer to the viewer may seem more blurred 

than those further away, depending on the 

scene and the swirl, of course.
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Artist’s advice
Mark says

Painting wet stone can 

be tricky, with factors 

such as lighting, 

texture and colour 

having a huge effect on how the 

surfaces look. A smooth, round 

pebble appears almost glass-like, 

whereas a lot of the shine is dulled 

on a rough masonry wall.

When a stone gets wet it 

darkens. I paint this boulder as if it 

were dry and then go over it with 

light green and blue on a Multiply 

layer to darken it and give it a 

mossy-green hue that looks damp. 

Once you’re happy with the 

underlying colours, start adding 

areas that catch the light. Ensure 

the highlights reflect the colour of 

the surrounding light. Paint the 

brightest spots where the layer of 

water gathers the most, such as in 

small pools or where it’s present in 

cracks and along edges. 

Instead of painting the typical 

factory-like underwater base of the evil 

genius, I want to show a beautiful, 

slightly alien-looking scene.

In real life our eyes can’t focus 

underwater properly, but I’m keen to 

keep the focal points clean and  

sharp, so I try to emulate how  

underwater cameras work.

Learn to…
paint an underwater 

composition

Discover how to…
paint water meeting the land, 

such as a sandy beach

How to…
paint the effect of  

wet stone

Artist’s advice
Mark says

Water is a much denser 

element than air and 

filters out the light – the 

deeper we go, the darker 

it gets. That’s why we have to change 

the rules of atmospheric perspective 

in this case. Our horizon line will be 

the darkest part of our imagined 

skyline, and things become lighter 

and more saturated the closer we 

move to the water’s surface.

Distant objects will look blurry 

because the constantly moving water 

spreads the light in every direction. 

This helps to create more depth and 

reduced background detail. I give  

the light sources extra glow because 

of the same reason.

I’d recommend not basing your 

colour palette on a simple blue, but 

to make use of a range of blues and 

greens. Life depends on the amount 

of phytoplanktons in the oceans, 

because these creatures form the base 

of the foodchain. This affects the 

colour of the water: the more 

plankton that’s present, the  

greener the water.

As a finishing touch I add shoals of 

fishes swimming around and air 

bubbles above the habitats to 

indicate life and movement.

Artist’s advice
Mark says

Painting water is 

actually rendering 

the light that’s being 

reflected back from 

above and below its surface. With 

a sandy beach scene you will want 

a smooth gradient for the sand 

as it gently slopes down beneath 

the surf. The colour of the water 

gradually becomes darker because 

less light reaches the bottom. 

Also, with details such as froth 

and ripples defining the general 

shape and form of the water’s 

surface, the colours and smooth 

gradients beneath will give it a 

deep and translucent visual effect. 

Remember, as waves spread further 

up an inclined sandy beach, they 

gradually become smaller. 

You can also add a tide line. The 

shallower parts of water that reach 

the line are like thin sheets of glass 

with only a sharp line of white 

froth giving them form.

The smooth gradient moving from a 

sandy yellow to a dark blue implies 

depth, while the waves and froth define 

the surface of the water.

Wet stone will often give off subtle 

reflections of objects that are nearby, 

and depending on the surface texture, 

they’re likely to appear distorted.

The light, reflecting from water pooling 

in the indentations and reflections on 

the surface of the stone, helps sell the  

wet appearance.

Core skills | Environments
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Your CD has been thoroughly scanned and 

tested at all stages of its production, but we 

still recommend you run a virus checker and 

have an up-to-date backup of your hard disk. 

Future Publishing does not accept 

responsibility for any disruption, damage and/

or loss to your data or computer system that 

may occur while using this disc or the 

programs and data on it. In the unlikely event 

of your disc being defective, please email our 

support team at support@futurenet.com for 

further assistance. If you would prefer to talk 

to a member of our reader support team in 

person you are invited to call +44 (0) 1225 

822743. If you have any comments about the 

software we include, or you have suggestions 

for software you would like to see in the 

future, please email Scott Ewart at scott.

ewart@futurenet.com.
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“I’m contrasting the part of the face I 

want the viewer drawn to, and leaving 

the rest in full light.”

Mélanie delon | page 27

  



master art 
theory

Learn new 
techniques

Explore core art ideas, including 
using perspective and colour rules!

Master simple art skills to paint wet 
figures, armour, poses and more! 

We see robots as 
machines – but 
giving them a 

human shape is 
the key to making 

them attractive 
Mélanie delon

characters  creatures  environments & vehicles

easy to foLLow art advice: ConCept an alien spaCeship | define a monster’s muscles | use 
silhouettes to Create Creatures | paint dynamic shadows | use perspeCtive in a vehiCle 

design | paint a snarling expression | draw animals running | paint a dragon’s fiery 

breath | Create a Chibi manga CharaCter | compose a crashing spaceship

30pages
of

software 
tips & advice
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